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Chapter 1: Introduction

Working with the JavaScript API

As a user of Adobe® Flash® Professional CC, you may be familiar with Adobe® ActionScript®, which lets you create
scripts that execute at run time in Adobe® Flash® Player. The Flash JavaScript application programming interface
(JavaScript API or JSAPI) described in this document is a complementary programming tool that lets you create scripts
that run in the Flash authoring environment.

This document describes the objects, methods, and properties available in the JavaScript API. It assumes that you
know how to use the documented commands when working in the authoring environment. If you have a question
about what a particular command does, use other documents in Flash Help, such as Using Flash, to find that
information.

This document also assumes that you are familiar with JavaScript or ActionScript syntax and with basic programming
concepts such as functions, parameters, and data types.

The Flash JavaScript API lets you write scripts to perform several actions in the Flash authoring environment (that is,
while a user has the Flash program open). This functionality is different from the ActionScript language, which lets
you write scripts to perform actions in the Flash Player environment (that is, while a SWF file is playing). This
functionality is also different from JavaScript commands that you might use in pages displayed in a web browser.

Using the JavaScript API, you can write Flash application scripts to help streamline the authoring process. For
example, you can write scripts to automate repetitive tasks or add custom tools to the Tools panel.

The Flash JavaScript API is designed to resemble the Adobe® Dreamweaver® and Adobe® Fireworks® JavaScript API
(which were designed based on the Netscape JavaScript API). The Flash JavaScript API is based on a Document Object
Model (DOM), which allows Flash documents to be accessed using JavaScript objects. The Flash JavaScript API
includes all elements of the Netscape JavaScript API, plus the Flash DOM. These added objects and their methods and
properties are described in this document. You can use any of the elements of the native JavaScript language in a Flash
script, but only elements that make sense in the context of a Flash document have an effect.

The JavaScript API also contains methods that let you implement extensibility using a combination of JavaScript and
custom C code. For more information, see “C-Level Extensibility” on page 591.

The JavaScript interpreter in Flash is the Mozilla SpiderMonkey engine, version 1.8, which is available on the web at
www.mozilla.org/js/spidermonkey/. SpiderMonkey is one of the two reference implementations of the JavaScript
language developed by Mozilla.org. It is the same engine that is embedded in the Mozilla browser.

SpiderMonkey implements the core JavaScript language as defined in the ECMAScript (ECMA-262) edition 3
language specification and it is fully compliant with the specification. Only the browser-specific host objects, which
are not part of the ECMA-262 specification, are not supported. Similarly, many JavaScript reference guides distinguish
between core JavaScript and client-side (browser-related) JavaScript. Only core JavaScript applies to the Flash
JavaScript interpreter.

Creating JSFL files

You can use Adobe Flash Professional or your preferred text editor to write and edit Flash JavaScript (JSFL) files. If
you use Flash, these files have a .jsfl extension by default. To write a script, select File > New > Flash JavaScript File.
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You can also create a JSFL file by selecting commands in the History panel. Then click the Save button in the History
panel or select Save As Command from the panel menu. The command (JSFL) file is saved in the Commands folder
(see “Saving JSFL files” on page 2). You can then open the file and edit it the same as any other script file.

The History panel provides some other useful options as well. You can copy selected commands to the Clipboard, and
you can view JavaScript commands that are generated while you are working in Flash.

To copy commands from the History panel to the clipboard:
1 Select one or more commands in the History panel.

2 Do one of the following:
+ Click the Copy button.

« Select Copy Steps from the panel menu.

To view JavaScript commands in the History panel:
+ Select View > JavaScript in Panel from the panel menu.

Saving JSFL files

You can have JSFL scripts available within the Flash authoring environment by storing them in one of several folders
within the Configuration folder. By default, the Configuration folder is in the following location:

+ Windows® 7™
boot drive\Users\username\AppData\Local\Adobe\Flash CC\language\Configuration\
+ Windows® Vista™
boot drive\Users\username\Local Settings\Application Data\Adobe\Flash CC\language\Configuration\
* MacOS*X:
Macintosh HD/Users/username/Library/Application Support/Adobe/Flash CC/language/Configuration/

To determine the location of the Configuration folder, use £1.configbirectory or £1.configURI, as shown in the
following example:

// store directory to a variable

var configbhir = fl.configDirectory;

// display directory in the Output panel
fl.trace(fl.configDirectory) ;

Within the Configuration folder, the following folders can contain scripts that you can access in the authoring
environment: Behaviors (to support the user interface for behaviors); Commands (for scripts that appear on the
Commands menuy); JavaScript (for scripts used by Script Assist to populate the user interface controls); Tools (for
extensible tools in the Tools panel); and WindowSWFE (for panels that appear in the Windows menu). This document
focuses on scripts used for commands and tools.

If you edit a script in the Commands folder, the new script is immediately available in Flash. If you edit a script for an
extensible tool, close and restart Flash, or else use the £1 . reloadTools () command. However, if you used a script to
add an extensible tool to the Tools panel and you then edit the script, either remove and then add the tool to the Tools
panel again, or else close and restart Flash for the revised tool to be available.
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There are two locations where you can store command and tool files so they can be accessed in the authoring
environment.

« For scripts that appear as items in the Commands menu, save the JSFL file in the Commands folder in the following
location:

Operating system Location
Windows 7 boot drive\Users\username\AppData\Local\Adobe\Flash CC\language\Configuration\Commands
Windows Vista boot drive\Users\username\Local Settings\Application Data\Adobe\Flash

CC\language\Configuration\Commands

Mac OS X Macintosh HD/Users/userName/Library/Application Support/Adobe/Flash
CC/language/Configuration/Commands

« For scripts that appear as extensible tools in the Tools panel, save the JSFL file in the Tools folder in the following

location:
Operating system Location
Windows 7 boot drive\Users\username\AppData\Local\Adobe\Flash CC\language\Configuration\Tools
Windows Vista boot drive\Users\username\Local Settings\Application Data\Adobe\Flash
CC\language\Configuration\Tools
Mac OS X Macintosh HD/Users/userName/Library/Application Support/Adobe/Flash
CC/language/Configuration/Tools

If a JSEL file has other files that go with it, such as XML files, store them in the same directory as the JSFL file.

Running scripts

There are several ways to run scripts. The most common ways are explained in this section.

To run a script that you are currently viewing or editing:
« Right-click (Command-click on the Macintosh) and choose Run Script.

« Click the Run Script icon on the Script window toolbar.

This option lets you run a script before you have saved it. This option also lets you run a script even if no FLA files are open.

To run a script that is in the Commands folder, do one of the following:
+ From the authoring environment, select Commands > Script Name.

+ Use a keyboard shortcut that you have assigned to the script. To assign a keyboard shortcut, use Edit > Keyboard
Shortcuts and select Drawing Menu Commands from the Commands pop-up menu. Expand the Commands node
in the menu tree to view a list of available scripts.

To run a command script that is not in the Commands folder, do one of the following:
+ From the authoring environment, select Commands > Run Command, and then select the script to run.

+ From within a script, use the £1.runScript () command.

+ From the file system, double-click the script file.

To add a tool implemented in a JSFL file to the Tools panel:
1 Copy the JSFL file for the tool and any other associated files to the Tools folder (see “Saving JSFL files” on page 2).
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2 Select Edit > Customize Tools Panel (Windows) or Flash > Customize Tools Panel (Macintosh).
3 Add the tool to the list of available tools.
4 Click OK.

You can add individual JavaScript API commands to ActionScript files by using the MMExecute () function, which is
documented in the ActionScript 3.0 Language and Components Reference. However, the MMExecute () function has an
effect only when it is used in the context of a custom user interface element, such as a component Property inspector,
or a SWF panel within the authoring environment. Even if called from ActionScript, JavaScript API commands have
no effect in Flash Player or outside the authoring environment.

To issue a command from an ActionScript script:

+ Use the following syntax (you can concatenate several commands into one string):

MMExecute (Javascript command string) ;

You can also run a script from the command line.

To run a script from the command line on Windows:

+ Use the following syntax (add path information as required):

"flash.exe" myTestFile.jsfl [-AlwaysRunJSFL]

Use the -AlwaysRunJSFL option to bypass the dialog box that prompts you to confirm script execution.

To run a script from the “Terminal” application on the Macintosh, use either of the following:
+ Use the following osacript syntax (add path information as required):

osascript -e 'tell application "flash" to open alias "Mac OS X:Users:user:myTestFile.jsfl"

The osascript command can also run AppleScript in a file. For example, you could include the following text in
a file named myScript:

tell application "flash"
open alias "Mac OS X:Users:user:myTestFile.jsfl"
end tell

Then, to run the script, you would use this command:
osascript myScript

« Use the flashpro command:

/Applications/Adobe\ Flash\ CC/flashpro.app/Contents/MacOS/flashpro <path of the jsfl filex>

What's new in the JavaScript API

The following section lists new objects, methods, and properties in Flash CC. It also lists changes in Flash CS5, CS5.5,
and CS6.

If you have not used the JavaScript API before, you might want to skip this section and go directly to “JavaScript API
objects” on page 10).
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New methods and properties in Flash CC

The following methods and properties for existing objects are new in Flash Profesional CC:

« Tween Object

+ Tween.getColorTransform( )

« Tween.getFilters( )

+ Tween.getGeometricTransform()

« Tween.getShape( )
« Tween.duration
« Tween.startFrame

« Tween.tweenType

« CompiledClipInstance object

¢ CompiledClipInstance

¢ CompiledClipInstance

¢ CompiledClipInstance.
¢ CompiledClipInstance.
e CompiledClipInstance.
¢ CompiledClipInstance.
¢ CompiledClipInstance.
¢ CompiledClipInstance.
¢ CompiledClipInstance.
¢ CompiledClipInstance.
e CompiledClipInstance.
¢ CompiledClipInstance.
¢ CompiledClipInstance.
¢ CompiledClipInstance.
¢ CompiledClipInstance.
¢ CompiledClipInstance.
e CompiledClipInstance.

¢ CompiledClipInstance.

« Document object
¢ Document
¢ Document
¢ Document.exportVideo

¢ Document

¢ Document.

¢ Document

¢ Document.

.backgroundColor
.blendMode
brightness
cacheAsBitmap
colorAlphaAmount
colorAlphaPercent
colorBlueAmount
colorBluePercent
colorGreenAmount
colorGreenPercent
colorMode
colorRedAmount
colorRedPercent
filters

tintColor
tintPercent
useBackgroundColor

visible

.convertSelectionToBitmap ()

.distributeToKeyframes ()

0

.getPublishDocumentData ()
getTelemetryForSwet ()
.importFile () showDialogandshowImporterUIprOpﬂikS

setPublishDocumenData ()
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+ Element object
¢ Element.getPublishPersistentData()
* Element.setPublishPersistentData ()
« flash object (f])
+ Flash.addEventListener ()prePublish, postPublish, selectionChanged, and dpiChanged events
e fl.getThemeColor ()
e fl.getThemeColorParameters ()
e fl.getThemeFontInfo ()
e fl.setPrefBoolean()
¢ fl.toggleBreakPoint ()
¢ fl.xmlPanel ()
¢ fl.xmlPanelFromString()
« Frame object
¢ Frame.convertToFrameByFrameAnimation ()
¢ Frame.getSoundEnvelope ()
¢ Frame.getSoundEnvelopeLimits ()
¢ Frame.setSoundEnvelope ()
¢ Frame.setSoundEnvelopeLimits ()
e Frame.isEmpty ()
« Item object
¢ item.getPublishData ()
e item.setPublishData ()
« library object
¢ library.unusedItems
+ swiPanel object
¢ swfPanel.dpiScaleFactorX
¢ swfPanel.dpiScaleFactorY
¢ swfPanel.reload()
« Symbollnstance object
¢ SymbolInstance.brightness
¢ SymbolInstance.tintColor
¢ SymbolInstance.tintPercent
« Timeline object

¢ getBounds ()
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Dropped methods and properties in Flash CC
The following methods and properties for existing objects are dropped in Flash Professional CC:
* ActionsPanel.getClassForObject ()

e ActionsPanel.getScriptAssistMode ()

e ActionsPanel.setScriptAssistMode ()

¢ CompiledClipInstance.actionscript

e fl.reloadEffects()

* fl.resetPackagePaths ()

e document.activeEffect

e document.allowScreens ()

¢ document.drawingLayer

¢ document.importSWF ()

¢ document.loadCuePointXML ()

¢ document.packagePaths

* document.saveAndCompact ()

e document.screenType

e library.importEmbeddedSWF ()

¢ SymbolInstance.actionscript

New objects in Flash CS6
The following object is new in Flash CSé6:

« SpriteSheetExporter object

New methods and properties in Flash CS6
The following methods and properties for existing objects are new in Flash Pro CSé:
+ BitmapItem object

* bitmapItem.exportToFile ()quality parameter

¢ bitmapItem.hasValidAlphalayer

* bitmapItem.lastModifiedDate
+ Document object

* document.exportInstanceToLibrary ()

¢ document .exportInstanceToPNGSequence ()

e document .getSWFPathFromProfile ()

¢ document.saveAsCopy ()

¢ document.swfJPEGQuality
« flash object (fl)

» fl.spriteSheetExporter
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+ Layer object
e layer.animationType
« Math object
¢ Math.transformPoint ()
+ Shape object
¢ shape.isFloating
+ SoundItem object
e soundItem.lastModifiedDate
« Symbollnstance object
¢ symbolInstance.is3D
+ Symbolltem object
¢ symbolItem.exportToLibrary ()
e gymbolItem.exportToPNGSequence ()
e gymbolItem.lastModifiedDate
« Text object
e text.filters
+ Videoltem object

e videoItem.lastModifiedDate

New methods and properties in Flash CS5 and CS5.5
The following methods and properties for existing objects are new in Flash Pro CS5:
+ Document object

¢ document .debugMovie ()

¢ document.loadCuepointXML ()
« flash object (fl)

« fl.languageCode

¢ fl.toggleBreakpoint
+ Frame object

e frame.convertMotionObjectTo2D ()

e frame.convertMotionObjectTo3D ()

e frame.getMotionObjectXML ()

e frame.hasMotionPath ()

¢ frame.isMotionObject ()

e frame.is3DMotionObject ()

e frame.selectMotionPath ()

e frame.setMotionObjectDuration ()

e frame.setMotionObjectXML ()
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» frame.tweenInstanceName
+ Timeline object
¢ timeline.createMotionObject ()
¢ timeline.libraryItem
¢ timeline.removeMotionObject ()
¢ timeline.startPlayback
e timeline.stopPlayback
The following methods and properties for existing objects are new in Flash Pro CS5.5:
+ SymbolInstance object
¢ symbolInstance.bitmapRenderMode
¢ symbolInstance.backgroundColor
¢ symbolInstance.usesBackgroundColor
¢ symbolInstance.visible
+ Timeline object
e timeline.copyLayers ()
¢ timeline.cutlayers ()
¢ timeline.duplicatelayers ()
¢ timeline.pastelLayers ()
« flash object (fl)
¢ fl.getSwfPanel()
e fl.installedPlayers/()
e fl.publishCacheEnabled
¢ fl.publishCacheDiskSizeMax
¢ fl.publishCacheMemorySizeMax
e fl.publishCacheMemoryEntrySizeLimit
e fl.clearPublishCache ()
« swfPanel object

¢ swfPanel.setFocus ()

Other changes in Flash CS5 and CS5.5
The following methods and properties are updated in Flash CS5:

 fl.openScript ()

¢ fl.publishDocument ()

¢ fontItem.embedRanges

* fontItem.embeddedCharacters

¢ fontItem.embedVariantGlyphs
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The following objects and method are no longer available in Flash CS5:

e Screen object

e ScreenOutline object

e document.canSaveAVersion ()

¢ document.revertToLastVersion ()

¢ document.saveAVersion/()

¢ document.synchronizeWithHeadVersion ()

e fl.downloadLatestVersion ()

e fl.revertDocumentToLastVersion ()

e fl.saveAVersionOfDocument ()

¢ fl.synchronizeDocumentWithHeadVersion ()

JavaScript APl objects

This section provides a summary of the objects available in the Flash JavaScript API and how to begin working with
them. All standard JavaScript commands are also available when working with the JavaScript APL

The following table briefly describes each of the objects in the JavaScript APIL. The objects are listed in alphabetical

order.

Object

Description

actionsPanel object

The actionsPanel object represents the currently displayed Actions panel.

Bitmaplnstance object

The BitmaplInstance object is a subclass of the Instance object and represents a bitmap in a
frame.

Bitmapltem object

A Bitmapltem object refers to a bitmap in the library of a document. The Bitmapltem object is
a subclass of the Item object.

CompiledCliplnstance object

The CompiledClipInstance object is a subclass of the Instance object.

compilerErrors object

The compilerErrors object represents the Compiler Errors panel. It is a property of the flash
object (fl.compilerErrors).

Componentinstance object

The Componentinstance object is a subclass of the Symbolinstance object and represents a
component in a frame.

componentsPanel object

The componentsPanel object, which represents the Components panel, is a property of the
flash object (£1 . componentsPanel).

Contour object

A Contour object represents a closed path of half edges on the boundary of a shape.

Document object

The Document object represents the Stage.

drawingLayer object

The drawingLayer object is accessible from JavaScript as a child of the flash object.

Edge object

The Edge object represents an edge of a shape on the Stage.

Element object

Everything that appears on the Stage is of the type Element.

Fill object

The Fill object contains all the properties of the Fill color setting of the Tools panel or of a
selected shape.
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Object

Description

Filter object

The Filter object contains all the properties for all filters.

flash object (fl)

The flash object represents the Flash application.

FLfile object

The FLfile object lets you write Flash extensions that can access, modify, and remove files and
folders on the local file system.

folderltem object

The folderltem object is a subclass of the Item object.

fontitem object

The fontltem object is a subclass of the Item object.

Frame object

The Frame object represents frames in the layer.

HalfEdge object

Directed side of the edge of a Shape object.

Instance object

The Instance object is a subclass of the Element object.

Item object The Item object is an abstract base class.

Layer object The Layer object represents a layer in the timeline.

library object The library object represents the Library panel.

Math object The Math object is available as a read-only property of the flash object (£1.Math).
Matrix object The Matrix object represents a transformation matrix.

outputPanel object

The outputPanel object represents the Output panel, which displays troubleshooting
information such as syntax errors. It is a property of the flash object (£1 . outputPanel).

Oval object

The Oval object is a shape that is drawn using the Oval tool. To determine if an item is an Oval
object, use shape . isOvalObject.

Parameter object

The Parameter object type is accessed from the screen.parameters array (which
corresponds to the screen Property inspector in the Flash authoring tool) or by the
componentInstance.parameters array (which corresponds to the component Property
inspector in the authoring tool).

Path object

The Path object defines a sequence of line segments (straight, curved, or both), which you
typically use when creating extensible tools.

presetltem object

The presetltem object represents an item (preset or folder) in the Motion Presets panel.

presetPanel object

The presetPanel object represents the Motion Presets panel (Window > Motion Presets). Itis a
property of the flash object (£1 . presetPanel).

Rectangle object

The Rectangle object is a shape that is drawn using the Rectangle tool. To determine if an item
is a Rectangle object, use shape . isRectangleObject.

Screen object

The Screen object represents a single screen in a slide or form document.

ScreenOutline object

The ScreenOutline object represents the group of screens in a slide or form document.

Shape object

The Shape object is a subclass of the Element object. The Shape object provides more precise
control than the drawing APIs for manipulating or creating geometry on the Stage.

Soundltem object

The SoundItem object is a subclass of the Item object. It represents a library item used to create
asound.

Stroke object

The Stroke object contains all the settings for a stroke, including the custom settings.

swfPanel object

The swfPanel object represents a Windows SWF panel. Windows SWF panels are SWF files that
implement applications you can run from the Flash authoring environment. The array of
swfPanel objects is a property of the flash object (f1 . swfPanels).

Symbollnstance object

The Symbolinstance object is a subclass of the Instance object and represents a symbol in a
frame.
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Object

Description

Symbolltem object

The Symbolltem object is a subclass of the Item object.

Text object

The Text object represents a single text item in a document.

TextAttrs object

The TextAttrs object contains all the properties of text that can be applied to a subselection.
This object is a subclass of the Text object.

TextRun object

The TextRun object represents a run of characters that have attributes that match all of the
properties in the TextAttrs object.

Timeline object

The Timeline object represents the Flash timeline, which can be accessed for the current
document by £1.getDocumentDOM () .getTimeline () .

ToolObj object

A ToolObj object represents an individual tool in the Tools panel.

Tools object

The Tools object is accessible from the Flash object (£1. tools).

Vertex object

The Vertex object is the part of the shape data structure that holds the coordinate data.

Videoltem object

The Videoltem object is a subclass of the Item object.

XMLUI object

The XMLUI object provides the ability to get and set properties of an XMLUI dialog box, and
accept or cancel out of one.

The Flash Document Object Model
The Flash Document Object Model (DOM) for the Flash JavaScript API consists of a set of top-level functions (see

12

“Top-Level Functions and Methods” on page 18) and two top-level objects—the FLfile object and the flash object (fl).
Each object is guaranteed to be available to a script because it always exists when the Flash authoring environment is
open. For more information, see FLfile object and flash object (fl).

When referring to the flash object, you can use £1ash or £1. For example, to close all open FLA files, you can use either

of the following statements:

flash.closeAll() ;
fl.closeAll() ;

The flash object contains the following child objects:

Object

How to access

actionsPanel object

Use £1.actionsPanel to access the actionsPanel object. This object corresponds to the Actions
panel in the Flash authoring environment.

compilerErrors object

Use £1.compilerErrors to access the compilerErrors object. This object corresponds to the
Compiler Errors panel in the Flash authoring environment.

componentsPanel object

Use £1. componentsPanel to access the componentsPanel object. This object corresponds to the
Components panel in the Flash authoring environment.

Document object

Use £1.documents to retrieve an array of all the open documents; use £1 . documents [index] to
access a particular document; use £1.getDocumentDOM () to access the current document (the one
with focus).

drawingLayer object

Use £1.drawingLayer to access the drawinglLayer object.

Math object

Use £1.Math to access the Math object.

outputPanel object

Use £1.outputPanel to access the outputPanel object. This object corresponds to the Output panel
in the Flash authoring environment.
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Object How to access

presetPanel object Use £1.presetPanel to access the presetPanel object. This object corresponds to the Motion Presets
panel (Window > Motion Presets).

swfPanel object Use £1.swfPanels to access an array of swfPanel objects. These objects correspond to Window SWF
panels.

Tools object Use £1. tools to access an array of Tools objects.

XMLUI object Use £1.xmlui to access an XML User Interface (XMLUI) object. The XMLUI object provides the ability

to get and set properties of an XMLUI dialog box.

The Document object

An important property of the top-level flash object is the £1.documents property. This property contains an array of
Document objects, each of which represents one of the FLA files currently open in the authoring environment. The
properties of each Document object represent most of the elements that a FLA file can contain. Therefore, a large
portion of the DOM is composed of child objects and properties of the Document object. For more information, see
Document object.

To refer to the first open document, for example, use the statement £1lash.documents [0] or £1.documents [0]. The
first document is the first Flash document that was opened during the current session in the authoring environment.
When the first opened document is closed, the indexes of the other open documents are decremented.

To find a particular document’s index, use £lash. findDocument Index (nameOfDocument) or
£1.findDocument Index (nameOfDocument). See £1 . f indDocument Index ().

To access the document that is currently focused, use the statement flash.getDocumentDOM () or
f1.getDocumentDOM (). See £1.getDocumentDOM (). The latter is the syntax used in most of the examples in this
document.

To find a particular document in the £1.documents array, iterate through the array and test each document for its
document . name property. See £1.documents and document . name.

All the objects in the DOM that aren’t listed in the previous table (see “The Flash Document Object Model” on page 12)
are accessed from the Document object. For example, to access the library of a document, you use the
document . library property, which retrieves a library object:

f1l.getDocumentDOM () .library

To access the array of items in the library, you use the 1ibrary.items property; each element in the array is an Item
object:

fl.getDocumentDOM () .library.items
To access a particular item in the library, you specify a member of the 1ibrary.items array:
fl.getDocumentDOM () .library.items [0]

In other words, the library object is a child of the Document object, and the Item object is a child of the library object.
For more information, see document . library, library object, library.itemslibrary.items, and Item object.

Specifying the target of an action

Unless otherwise specified, methods affect the current focus or selection. For example, the following script doubles the
size of the current selection because no particular object is specified:

fl.getDocumentDOM () .scaleSelection (2, 2);

Last updated 12/6/2013
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In some cases, you might want an action to specifically target the currently selected item in the Flash document. To do
this, use the array that the document . selection property contains (see document . selection). The first element in
the array represents the currently selected item, as shown in the following example:

var accDescription = fl.getDocumentDOM() .selection[0] .description;

The following script doubles the size of the first element on the Stage that is stored in the element array, instead of the
current selection:

var element = fl.getDocumentDOM().getTimeline () .layers[0].frames[0].elements[0];
if (element) ({

element .width = element.width*2;

element .height = element.height*2;

}

You can also do something such as loop through all the elements on the Stage and increase the width and height by a
specified amount, as shown in the following example:

var elementArray =
f1l.getDocumentDOM () .getTimeline () .layers[0] .frames[0] .elements;
for (var i=0; 1 < elementArray.length; i++) {
var offset = 10;
elementArray[i] .width += offset;
elementArray[i] .height += offset;

Summary of the DOM structure

The following list displays the DOM structure in outline format. Numbers at the beginning of each line represent the
level of an object. For example, an object preceded by “03” is a child of next highest “02” object, which, in turn, is a
child of the next highest “01” object.

In some cases, an object is available by specifying a property of its parent object. For example, the
document . timelines property contains an array of Timeline objects. These properties are noted in the following
outline.

Some objects are subclasses of other objects, rather than being children of other objects. An object that is a subclass of
another object has methods and/or properties of its own in addition to the methods and properties of the parent object
(the superclass). Subclasses share the same level in the hierarchy as their superclass. For example, the Item object is a
superclass of the BitmapItem object. These relationships are illustrated in the following outline:
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01 Top-Level Functions and Methods
01 FLfile object
01 flash object (£fl)
02 compilerErrors object
02 componentsPanel object
02 Document object (fl.documents array)
03 Filter object
03 Matrix object
03 Fill object
03 Stroke object
03 library object
04 Item object (library.items array)
04 BitmapItem object (subclass of Item object)
04 folderItem object (subclass of Item object)
04 fontItem object (subclass of Item object)
04 SoundItem object (subclass of Item object)
04 SymbolItem object (subclass of Item object)
04 VideoItem object (subclass of Item object)
03 Timeline object (document.timelines array)
04 Layer object (timeline.layers array)
05 Frame object (layer.frames array)
06 Element object (frame.elements array)
07 Matrix object (element.matrix)

06 Instance object (abstract class, subclass of Element object)

06 BitmapInstance object (subclass of Instance object)

06 CompiledClipInstance object (subclass of Instance object)
06 ComponentInstance object (subclass of SymbolInstance object)
07 Parameter object (componentInstance.parameters array)

06 SymbolInstance object (subclass of Instance object)
06 Text object (subclass of Element object)
07 TextRun object (text.textRuns array)
08 TextAttrs object (textRun.textAttrs array)
06 Shape object (subclass of Element object)
07 Oval object
07 Rectangle object
07 Contour object (shape.contours array)
08 HalfEdge object
09 Vertex object
09 Edge object

Last updated 12/6/2013
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07 Edge object (shape.edges array)
08 HalfEdge object
09 Vertex object
09 Edge object
07 Vertex object (shape.vertices array)
08 HalfEdge object
09 Vertex object
09 Edge object
05 Parameter object (screen.parameters array)
02 drawingLayer object
03 Path object
04 Contour object
02 Math object
02 outputPanel object
02 presetPanel object
03 presetItem object (presetPanel.items array)
02 swfPanel object
02 Tools object (fl.tools array)
03 ToolObj object (tools.toolObjs array)
02 XMLUI object

Sample implementations

Several sample JSFL implementations are available for Adobe Flash Professional CS5 and CS5.5. You can review and
install these files to familiarize yourself with the JavaScript API. The samples are in a folder named
Samples/ExtendingFlash within the Samples.zip file located at www.adobe.com/go/learn_fl_samples.

Sample Shape command

A sample JavaScript API script named Shape.jsfl is located in the ExtendingFlash/Shape folder (see “Sample
implementations” above). This script displays information about the contours of the shape in the Output panel.

To install and run the Shape script:
1 Copy the Shape.jsfl file to the Configuration/Commands folder (see “Saving JSFL files” on page 2).

2 Ina Flash document (FLA file), select a shape object.

3 Select Commands > Shape to run the script.

Sample get and set filters command

A sample JavaScript API script named filtersGetSet.jsfl is located in the ExtendingFlash/filtersGetSet folder (see
“Sample implementations” above). This script adds filters to a selected object and displays information about the filters
being added in the Output panel.

To install and run the filtersGetSet script:
1 Copy the filtersGetSet.jsfl file to the Configuration/Commands folder (see “Saving JSFL files” on page 2).

2 In a Flash document (FLA file), select a text, movie clip, or button object.

3 Select Commands > filtersGetSet to run the script.

Last updated 12/6/2013
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Sample PolyStar tool
A sample JavaScript API script named PolyStar.jsfl is located in the ExtendingFlash/PolyStar folder (see “Sample

implementations” above).

The PolyStar.jsfl replicates the PolyStar tool that can be found in the Flash Tools panel. The script demonstrates how
to build the PolyStar tool using the JavaScript API and includes detailed comments describing what the code is doing.
Read this file to gain a better understanding of how the JavaScript API can be used. You should also read the
PolyStar.xml file in the Tools directory to learn more about how to build your own tool.

Sample Trace Bitmap panel
A set of files named TraceBitmap.fla and TraceBitmap.swf are located in the ExtendingFlash/TraceBitmapPanel folder

(see “Sample implementations” above). These files illustrate how to design and build a panel to control the functions
of Flash. They also show the use of the MMExecute () function to call JavaScript commands from an ActionScript

script.

To run the TraceBitmap sample:

1
2

If Flash is running, exit from Flash.

Copy the TraceBitmap.swf file to the WindowSWF folder, which is a subdirectory of the Configuration folder (see
“Saving JSFL files” on page 2). For example, on Windows XP, the folder is in boot drive\Documents and
Settings\user\Local Settings\Application Data\Adobe\Flash CS5\language\Configuration\WindowSWEF.

Start Flash.

Create or open a Flash document (FLA file), and import a bitmap or JPEG image into the file.

You can use the flower.jpg file provided in the TraceBitmapPanel folder or another image of your choice.
With the imported image selected, select Window > Other Panels > TraceBitmap.

Click Submit.

The image is converted into a group of shapes.

Sample DLL

A sample DLL implementation is located in the ExtendingFlash/dllSampleComputeSum folder (see “Sample

implementations” above). For more information about building DLLs, see “C-Level Extensibility” on page 591.

Last updated 12/6/2013
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Chapter 2: Top-Level Functions and
Methods

Top-level summary

About this section

This section describes the top-level functions and methods that are available when you use the Adobe Flash JavaScript
application programming interface (JavaScript API). For information about where to store JavaScript API files, see
“Saving JSFL files” on page 2.

Global methods
The following methods can be called from any JavaScript API script:

alert ()
confirm()
prompt ()

Extensible tools

The following functions are available in scripts that create extensible tools:

activate()
configureTool ()
deactivate ()
keyDown ()

keyUp ()
mouseDoubleClick ()
mouseDown ()
mouseMove ()
mouseUp ()
notifySettingsChanged ()
setCursor ()

activate()

Availability
Flash MX 2004.

Usage
function activate() {
// statements

}

Parameters
None.
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Returns
Nothing.

Description
Function; called when the extensible tool becomes active (that is, when the tool is selected in the Tools panel). Use this
function to perform any initialization tasks the tool requires.

Example
The following example sets the value of tools.activeTool when the extensible tool is selected in the Tools panel:

function activate() ({
var theTool = fl.tools.activeTool

}

See also

tools.activeTool

alert()

Availability
Flash MX 2004.

Usage
alert ( alertText )

Parameters
alertText A string that specifies the message you want to display in the Alert dialog box.

Returns
Nothing.

Description
Method; displays a string in a modal Alert dialog box, along with an OK button.

Example

The following example displays the message “Process Complete” in an Alert dialog box:

alert ("Process Complete") ;

See also

confirm(), prompt ()

configureTool()

Availability
Flash MX 2004.
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Usage
function configureTool() {
// statements

Parameters
None.

Returns
Nothing.

Description
Function; called when Flash opens and the extensible tool is loaded into the Tools panel. Use this function to set any
information Flash needs to know about the tool.

Example
The following examples show two possible implementations of this function:

function configureTool() {
theTool = fl.tools.activeTool;
theTool.setToolName ("myTool") ;
theTool.setIcon ("myTool.png") ;
theTool.setMenuString ("My Tool's menu string") ;
theTool.setToolTip ("my tool's tool tip");
theTool.setOptionsFile( "mtTool.xml" );

function configureTool () {
theTool = fl.tools.activeTool;
theTool.setToolName ("ellipse") ;
theTool.setIcon("Ellipse.png") ;
theTool.setMenuString ("Ellipse") ;
theTool.setToolTip ("Ellipse") ;
theTool .showTransformHandles ( true ) ;

confirm()

Availability
Flash 8.

Usage

confirm ( strAlert )

Parameters
stralert A string that specifies the message you want to display in the Alert dialog box.

Returns
A Boolean value: true if the user clicks OK; false if the user clicks Cancel.
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Description
Method; displays a string in a modal Alert dialog box, along with OK and Cancel buttons.

Note: If there are no documents (FLA files) open, this method fails with an error condition.

Example
The following example displays the message “Sort data?” in an Alert dialog box:

confirm("Sort data?") ;

See also

alert (), prompt ()

deactivate()

Availability
Flash MX 2004.

Usage
function deactivate() {
// statements

}

Parameters
None.

Returns
Nothing.

Description
Function; called when the extensible tool becomes inactive (that is, when the active tool changes from this tool to
another one). Use this function to perform any cleanup the tool needs.

Example
The following example displays a message in the Output panel when the tool becomes inactive:

function deactivate() {
fl.trace( "Tool is no longer active" );

}

keyDown()

Availability
Flash MX 2004.

Last updated 12/6/2013
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Usage
function keyDown () {
// statements

}

Parameters
None.

Returns
Nothing.

Description
Function; called when the extensible tool is active and the user presses a key. The script should call
tools.getKeyDown () to determine which key was pressed.

Example
The following example displays information about which key was pressed when the extensible tool is active and the
user presses a key.

function keyDown () {
fl.trace("key " + fl.tools.getKeyDown() + " was pressed");

}

See also
keyUp (), tools.getKeyDown ()

keyUp()

Availability
Flash MX 2004.

Usage
function keyUp () {
// statements

}

Parameters
None.

Returns
Nothing.

Description
Function; called when the extensible tool is active and a key is released.

Example
The following example displays a message in the Output panel when the extensible tool is active and a key is released.
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function keyUp () {
fl.trace("Key is released") ;

}

See also

keyDown ()

mouseDoubleClick()

Availability
Flash MX 2004.

Usage
function mouseDoubleClick() {
// statements

}

Parameters
None.

Returns
Nothing.

Description
Function; called when the extensible tool is active and the mouse button is double-clicked on the Stage.

Example

The following example displays a message in the Output panel when the extensible tool is active and the mouse button
is double-clicked.

function mouseDoubleClick () {
fl.trace ("Mouse was double-clicked") ;

}

mouseDown()
Availability

Flash MX 2004.

Usage

function mouseDown( [ pt ] ) {

// statements

}

Last updated 12/6/2013
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Parameters
pt A point that specifies the location of the mouse when the button is pressed. It is passed to the function when the
mouse button is pressed. This parameter is optional.

Returns
Nothing.

Description

Function; called when the extensible tool is active and the mouse button is pressed while the pointer is over the Stage.

Example

The following examples show how this function can be used when the extensible tool is active. The first example
displays a message in the Output panel that the mouse button was pressed. The second example displays the x and y
coordinates of the mouse’s location when the button was pressed.

function mouseDown () {
fl.trace("Mouse button has been pressed");

}
function mouseDown (pt) {
fl.trace("x = "+ pt.x+" :: y = "+pt.y);

mouseMove()

Availability
Flash MX 2004.

Usage
function mouseMove( [ pt ] ) {
// statements

Parameters

pt A point that specifies the current location of the mouse. It is passed to the function whenever the mouse moves,
which tracks the mouse location. If the Stage is in edit or edit-in-place mode, the point coordinates are relative to the
object being edited. Otherwise, the point coordinates are relative to the Stage. This parameter is optional.

Returns
Nothing.

Description

Function; called whenever the extensible tool is active and the mouse moves over a specified point on the Stage. The
mouse button can be down or up.

Example

The following examples show how this function can be used. The first example displays a message in the Output panel
that the mouse is being moved. The second example displays the x and y coordinates of the mouse’s location as it
moves.
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function mouseMove () {
fl.trace ("moving") ;

}

function mouseMove (pt) {

fl.trace("x = "+ pt.x + " :: y = " + pt.y);
}
mouseUp()
Availability
Flash MX 2004.
Usage
function mouseUp () {

// statements

}

Parameters
None.

Returns
Nothing.

Description
Function; called whenever the extensible tool is active and the mouse button is released after being pressed on the
Stage.

Example
The following example displays a message in the Output panel when the extensible tool is active and the mouse button
is released.

function mouseUp () ({
fl.trace("mouse is up");

}

notifySettingsChanged()

Availability
Flash MX 2004.

Usage
function notifySettingsChanged() ({
// statements

}

Last updated 12/6/2013
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Parameters
None.

Returns
Nothing.

Description
Function; called when the extensible tool is active and the user changes its options in the Property inspector. You can
use the tools.activeTool property to query the current values of the options (see tools.activeTool).

Example
The following example displays a message in the Output panel when the extensible tool is active and the user changes
its options in the Property inspector.

function notifySettingsChanged() ({
var theTool = fl.tools.activeTool;
var newValue = theTool.myProp;

prompt()

Availability
Flash MX 2004.

Usage
prompt (promptMsg [,text])

Parameters
promptMsg A string to display in the Prompt dialog box (limited to 256 characters in Mac OS X).

text An optional string to display as a default value for the text field.

Returns
The string the user typed if the user clicks OK; nul1 if the user clicks Cancel.

Description

Method; displays a prompt and optional text in a modal Alert dialog box, along with OK and Cancel buttons.

Example

The following example prompts the user to enter a user name. If the user types a name and clicks OK, the name appears
in the Output panel.

var userName = prompt ("Enter user name", "Type user name here");
fl.trace (userName) ;

See also

alert (), confirm()

Last updated 12/6/2013
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setCursor()

Availability
Flash MX 2004.

Usage
function setCursor() ({
// statements

Parameters

None.

Returns
Nothing.

Description

Function; called when the extensible tool is active and the mouse moves, to allow the script to set custom pointers. The
script should call tools.setcursor () to specify the pointer to use. For a list that shows which pointers correspond
to which integer values, see tools.setCursor ().

Example

function setCursor()
fl.tools.setCursor( 1 );

Last updated 12/6/2013



Chapter 3: actionsPanel object

actionsPanel summary

Availability
Flash CS3 Professional.

Description
The actionsPanel object, which represents the currently displayed Actions panel, is a property of the flash object (see
fl.actionsPanel).

Method summary
The following methods can be used with the actionsPanel object:

Method Description

actionsPanel .getClassForObject () - Dropped in Flash Professional CC.

dropped

actionsPanel.getScriptAssistMode () - Dropped in Flash Professional CC.

dropped

actionsPanel .getSelectedText () Returns the text that is currently selected in the Actions panel.
actionsPanel .getText () Returns the text in the Actions panel.
actionsPanel.hasSelection () Specifies whether any text is currently selected in the Actions panel.
actionsPanel .replaceSelectedText () Replaces the currently selected text with specified text.
actionsPanel .setScriptAssistMode () - Dropped in Flash Professional CC.

dropped

actionsPanel.setSelection () Selects a specified set of characters in the Actions panel.
actionsPanel.setText () Clears any text in the Actions panel and then adds specified text.

actionsPanel.getClassForObject() - dropped

Availability
Flash CS3 Professional. Dropped in Flash Professional CC.

Usage

actionsPanel.getClassForObject (ASvariableName)

Parameters
ASvariableName A string that represents the name of an ActionScript variable.

Returns
A string that represents the class of which ASvariableName is a member.

Last updated 12/6/2013
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Description
Dropped in Flash Professional CC.

Method; returns the class of the specified variable, which must be defined in the currently displayed Actions panel. In
addition, the cursor or selected text in the Actions panel must be positioned after the variable definition.

Example

The following example displays the class assigned to the variable myVar, if the cursor is positioned after the statement
var myVar:ActivityEvent; in the Actions panel.

// Place the following code in the Actions panel,

// and position the cursor somewhere after the end of the line
var myVar:ActivityEvent;

// Place the following code in the JSFL file

var theClass = fl.actionsPanel.getClassForObject ("myVar") ;
fl.trace(theClass); // traces: "ActivityEvent"

actionsPanel.getScriptAssistMode() - dropped

Availability
Flash CS3 Professional. Dropped in Flash Professional CC.

Usage

actionsPanel.getScriptAssistMode ()

Parameters
None.

Returns

A Boolean value that specifies whether Script Assist mode is enabled (true) or not (false).

Description
Dropped in Flash Professional CC.

Method; specifies whether Script Assist mode is enabled.

Example

The following example displays a message if Script Assist mode is not enabled.

mAssist = fl.actionsPanel.getScriptAssistMode () ;
if (!mAssist)
alert ("For more guidance when writing ActionScript code, try Script Assist mode") ;

See also

actionsPanel.setScriptAssistMode () - dropped
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actionsPanel.getSelectedText()

Availability
Flash CS3 Professional.

Usage

actionsPanel.getSelectedText ()

Parameters
None.

Returns

A string that contains the text that is currently selected in the Actions panel.

Description
Method; returns the text that is currently selected in the Actions panel.

Example
The following example displays the text that is currently selected in the Actions panel.

var apText = fl.actionsPanel.getSelectedText () ;
fl.trace (apText) ;

See also

actionsPanel.getText (), actionsPanel .hasSelection (), actionsPanel.replaceSelectedText (),

actionsPanel.setSelection()

actionsPanel.getText()

Availability
Flash CS3 Professional.

Usage

actionsPanel.getText ()

Parameters
None.

Returns

A string that contains all the text in the Actions panel.

Description
Method; returns the text in the Actions panel.

Example
The following example displays the text that is in the Actions panel.

Last updated 12/6/2013

30



EXTENDING FLASH PROFESSIONAL
actionsPanel object

var apText = fl.actionsPanel.getText () ;
fl.trace (apText) ;

See also

actionsPanel.getSelectedText (), actionsPanel.setText ()

actionsPanel.hasSelection()

Availability
Flash CS3 Professional.

Usage

actionsPanel.hasSelection ()

Parameters
None.

Returns

A Boolean value that specifies whether any text is selected in the Actions panel (true) or not (false).

Description
Method; specifies whether any text is currently selected in the Actions panel.

Example
The following example displays text that is currently selected in the Actions panel. If no text is selected, it displays all
the text in the Actions panel.

if (fl.actionsPanel.hasSelection()) {

var apText = fl.actionsPanel.getSelectedText () ;
}
else {

var apText = fl.actionsPanel.getText () ;

}

fl.trace (apText) ;
See also

actionsPanel.getSelectedText (), actionsPanel.getText (), actionsPanel.replaceSelectedText (),

actionsPanel.setSelection()

actionsPanel.replaceSelectedText()

Availability
Flash CS3 Professional.

Usage

actionsPanel.replaceSelectedText (replacementText)

Last updated 12/6/2013
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Parameters
replacementText A string that represents text to replace selected text in the Actions panel.

Returns
A Boolean value of true if the Actions panel is found; false otherwise.

Description

Method; replaces the currently selected text with the text specified in replacementText. If replacementText contains
more characters than the selected text, any characters following the selected text now follow replacementText; that is,
they are not overwritten.

Example
The following example replaces currently selected text in the Actions panel.

if (fl.actionsPanel.hasSelection()) {
fl.actionsPanel.replaceSelectedText ("// © 2006 Adobe Inc.");

See also
actionsPanel.getSelectedText (), actionsPanel.hasSelection(), actionsPanel.setSelection(),

actionsPanel.setText ()

actionsPanel.setScriptAssistMode() - dropped

Availability
Flash CS3 Professional. Dropped in Flash Professional CC.

Usage

actionsPanel.setScriptAssistMode (bScriptAssist)

Parameters
bsScriptaAssist A Boolean value that specifies whether to enable or disable Script Assist mode.

Returns
A Boolean value that specifies whether Script Assist mode was enabled or disabled successfully.

Description
Dropped in Flash Professional CC.

Method; enables or disables Script Assist mode.

Example
The following example toggles the state of Script Assist mode.
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fl.trace(fl.actionsPanel.getScriptAssistMode()) ;
if (fl.actionsPanel.getScriptAssistMode ()) {
fl.actionsPanel.setScriptAssistMode (false) ;

}

else {
fl.actionsPanel.setScriptAssistMode (true) ;

}

fl.trace(fl.actionsPanel.getScriptAssistMode()) ;

See also

actionsPanel.getScriptAssistMode () - dropped

actionsPanel.setSelection()

Availability
Flash CS3 Professional.

Usage

actionsPanel.setSelection (startIndex, numberOfChars)

Parameters
startIndex A zero-based integer that specifies the first character to be selected.

numberOofChars An integer that specifies how many characters to select.

Returns

A Boolean value that specifies whether the requested characters can be selected (true) or not (false).

Description

Method; selects a specified set of characters in the Actions panel.

Example

The following example replaces the characters “2006” in the Actions panel with the specified text.
// Type the following as the first line in the Actions panel

// 2006 - Addresses user request 40196

// Type the following in the JSFL file

fl.actionsPanel.setSelection(3,4) ;
fl.actionsPanel.replaceSelectedText ("// Last updated: 2007");

See also

actionsPanel.getSelectedText (), actionsPanel.hasSelection(),

actionsPanel.replaceSelectedText ()

Last updated 12/6/2013
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actionsPanel.setText()

Availability
Flash CS3 Professional.

Usage

actionsPanel.setText (replacementText)

Parameters
replacementText A string that represents text to place in the Actions panel.

Returns
A Boolean value of true if the specified text was placed in the Actions panel; false otherwise.

Description
Method; clears any text in the Actions panel and then adds the text specified in replacementText.

Example
The following example replaces any text currently in the Actions panel with the specified text.

fl.actionsPanel.setText ("// Deleted this code - no longer needed") ;

See also

actionsPanel.getText (), actionsPanel.replaceSelectedText ()
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bitmaplnstance summary

Inheritance  Element object > Instance object > BitmapInstance object

Availability
Flash MX 2004.

Description
The BitmaplInstance object is a subclass of the Instance object and represents a bitmap in a frame (see Instance object).

Method summary
In addition to the Instance object methods, you can use the following methods with the BitmapInstance object:

Method Description

bitmapInstance.getBits () Lets you create bitmap effects by getting the bits out of the bitmap,
manipulating them, and then returning them to Flash.

bitmapInstance.setBits () Sets the bits of an existing bitmap element.

Property summary
In addition to the Instance object properties, you can use the following properties with the BitmapInstance object:

Property Description
bitmapInstance.hPixels Read-only; an integer that represents the width of the bitmap, in pixels.
bitmapInstance.vPixels Read-only; an integer that represents the height of the bitmap, in pixels.

bitmaplInstance.getBits()

Availability
Flash MX 2004.

Usage
bitmapInstance.getBits ()

Parameters

None.

Returns

An object that contains width, height, depth, bits, and, if the bitmap has a color table, cTab properties. The bits
element is an array of bytes. The cTab element is an array of color values of the form "#RrRrRGGBB". The length of the
array is the length of the color table.
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The byte array is meaningful only when referenced by a DLL or shared library. You typically use it only when creating
an extensible tool or effect. For information on creating DLLs for use with Flash JavaScript, see “C-Level Extensibility”
on page 591

Description
Method; lets you create bitmap effects by getting the bits out of the bitmap, manipulating them, and then returning
them to Flash.

Example
The following code creates a reference to the currently selected object; tests whether the object is a bitmap; and traces
the height, width, and bit depth of the bitmap:

var isBitmap = fl.getDocumentDOM() .selection[0] .instanceType;
if (isBitmap == "bitmap") {
var bits = fl.getDocumentDOM() .selection[0] .getBits() ;
fl.trace("height = " + bits.height);
fl.trace("width = " + bits.width) ;
fl.trace("depth = " + bits.depth);
}
See also

bitmapInstance.setBits()

bitmaplinstance.hPixels

Availability
Flash MX 2004.

Usage

bitmapInstance.hPixels

Description
Read-only property; an integer that represents the width of the bitmap—that is, the number of pixels in the horizontal
dimension.

Example
The following code retrieves the width of the bitmap in pixels:
// Get the number of pixels in the horizontal dimension.
var bmObj = fl.getDocumentDOM() .selection[0];
var isBitmap = bmObj.instanceType;
if (isBitmap == "bitmap") {
var numHorizontalPixels = bmObj.hPixels;

See also

bitmapInstance.vPixels
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bitmaplinstance.setBits()

Availability
Flash MX 2004.

Usage

bitmapInstance.setBits (bitmap)

Parameters

bitmap An object that contains height, width, depth, bits, and cTab properties. The height, width, and depth
propertiesare integers. The bits property is a byte array. The cTab property is required only for bitmaps with a bit
depth of 8 or less and is a string that represents a color value in the form "#RRGGBB".

Note: The byte array is meaningful only when referenced by an external library. You typically use it only when creating
an extensible tool or effect.

Returns
Nothing.

Description
Method; sets the bits of an existing bitmap element. This lets you create bitmap effects by getting the bits out of the
bitmap, manipulating them, and then returning the bitmap to Flash.

Example
The following code tests whether the current selection is a bitmap and then sets the height of the bitmap to 150 pixels:
var isBitmap = fl.getDocumentDOM() .selection[0].instanceType;
if (isBitmap == "bitmap") {
var bits = fl.getDocumentDOM () .selection[0] .getBits() ;
bits.height = 150;
fl.getDocumentDOM () .selection[0] .setBits (bits) ;

See also

bitmapInstance.getBits ()

bitmaplinstance.vPixels

Availability
Flash MX 2004.

Usage

bitmapInstance.vPixels
Description

Read-only property; an integer that represents the height of the bitmap—that is, the number of pixels in the vertical
dimension.
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Example

The following code gets the height of the bitmap in pixels:

// Get the number of pixels in the vertical dimension.
var bmObj = fl.getDocumentDOM() .selection[0];

var isBitmap = bmObj.instanceType;

if (isBitmap == "bitmap") {

var numVerticalPixels = bmObj.vPixels;

See also

bitmapInstance.hPixels

Last updated 12/6/2013
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bitmapltem summary

Inheritance  Item object > BitmapItem object

Availability
Flash MX 2004.

Description

A BitmaplItem object refers to a bitmap in the library of a document. The BitmapItem object is a subclass of the Item

object (see Item object).

Property summary

In addition to the Item object properties, the BitmapItem object has following properties:

Property

Description

bitmapItem.allowSmoothing

A Boolean value that specifies whether to allow smoothing
of a bitmap.

bitmapItem.compressionType

A string that determines the type of image compression
applied to the bitmap.

bitmapItem.fileLastModifiedDate

The number of seconds that have elapsed between
January 1, 1970 and the modification date of the original
file.

bitmapItem.hasValidAlphalayer

A Boolean value indicating whether the bitmap has an
alpha channel.

bitmapItem.hPixels

Specifies the width of the bitmap, in pixels.

bitmapItem.lastModifiedDate

The modification date of the bitmap item in the Library.

bitmapItem.originalCompressionType

Specifies whether the item was imported as an jped file.

bitmapItem.sourceFileExists

Specifies whether the file that was imported to the Library
still exists in the location from where it was imported.

bitmapItem.sourceFileIsCurrent

Specifies whether the file modification date of the Library
item is the same as the modification date on disk of the file
that was imported.

bitmapItem.sourceFilePath

The path and name of the file that was imported into the
Library.

bitmapItem.useDeblocking

Specifies whether deblocking is enabled.

bitmapItem.useImportedJPEGQuality

A Boolean value that specifies whether to use the default
imported JPEG quality.

bitmapItem.vPixels

Specifies the height of the bitmap, in pixels.

Method summary

In addition to the Item object properties, the BitmapItem object has following methods:
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Method Description

bitmapItem.exportToFile () Exports the specified item to a PNG or JPG file.

bitmapltem.allowSmoothing

Availability
Flash MX 2004.

Usage
bitmapItem.allowSmoothing

Description
Property; a Boolean value that specifies whether to allow smoothing of a bitmap (true) or not (false).

Example

The following code sets the allowSmoothing property of the first item in the library of the current document to true:

f1l.getDocumentDOM () .library.items [0] .allowSmoothing = true;
alert (f1.getDocumentDOM () .library.items [0] .allowSmoothing) ;

bitmapltem.compressionType

Availability
Flash MX 2004.

Usage

bitmapItem.compressionType

Description

Property; a string that determines the type of image compression applied to the bitmap. Acceptable values are "photo"
or "lossless". Ifthe value of bitmapItem.useImportedJPEGQuality is false, "photo" corresponds to JPEG with
a quality from 0 to 100; if bitmapItem.useImportedJPEGQuality is true, "photo" corresponds to JPEG using the
default document quality value. The value "lossless" corresponds to GIF or PNG format (see
bitmapItem.useImportedJPEGQuality).

Example

The following code sets the compressionType property of the first item in the library of the current document to
"photo":

fl.getDocumentDOM () .library.items [0] .compressionType = "photo";

alert (fl.getDocumentDOM () .library.items [0] .compressionType) ;

Last updated 12/6/2013
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bitmapltem.exportToFile()

Availability
Flash CS4 Professional.

Usage
bitmapItem.exportToFile (fileURI, quality)

Parameters
fileURI A string, expressed as a file:/// URI, that specifies the path and name of the exported file.

quality A number, from 1-100, that determines the quality of the exported image file. A higher number indicates
higher quality. The default is 80. New in Flash CS6 Professional.

Returns
A Boolean value of true if the file was exported successfully; false otherwise.

Description
Method; exports the specified item to a PNG or JPG file.

Example
Assuming the first item in the Library is a bitmap item, the following code exports it as a JPG file:
var imageFileURL = "file:///C|/exportTest/out.jpg";

var libItem = fl.getDocumentDOM () .library.items[0];
libItem.exportToFile (imageFileURL) ;

bitmapltem.fileLastModifiedDate

Availability
Flash CS4 Professional.

Usage
bitmapItem.fileLastModifiedDate

Description

Read-only property; a string containing a hexadecimal number that represents the number of seconds that have
elapsed between January 1, 1970 and the modification date of the original file at the time the file was imported to the
library. If the file no longer exists, this value is "00000000".

Example
Assuming the first item in the Library is a bitmap item, the following code displays a hex number as described above.

var libItem = fl.getDocumentDOM () .library.items[0];
fl.trace("Mod date when imported = " + libItem.fileLastModifiedDate) ;
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See also
bitmapItem.sourceFileExists, bitmapItem.sourceFileIsCurrent, bitmapItem.sourceFilePath,
FLfile.getModificationDate ()

bitmapltem.hasValidAlphaLayer

Availability
Flash CS6 Professional.

Usage
bitmapItem.hasValidAlphalLayer

Description
Read-only property; a boolean indicating if a bitmap in the library has a valid/useful alpha channel. This flag will help
you decide if you should export the bitmap item as a PNG instead of a JPEG using the bitmapItem.exportToFile ()

function.
Example
The following code exports a library item with the proper file name extension depending on whether it has a valid
alpha layer.
var bitmapItem = fl.getDocumentDOM() .library.items[0];
var uri = fl.browseForFileURI ("open") ;
if (bitmapItem.hasValidAlphalayer) uri += ".png";
else uri += ".jpg";

bitmapItem.exportToFile (uri) ;
See also

bitmapItem.sourceFileExists,bitmapItem.sourceFileIsCurrent, bitmapItem.sourceFilePath,

FLfile.getModificationDate ()

bitmapltem.hPixels

Availability
Flash CS6 Professional.

Usage
bitmapItem.hPixels

Description
Read-only property; an int that specifies the width of the bitmap, in pixels.

Example
The following code illustrates use of this property.
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// get the number of pixels in the horizontal dimension.
var bmItemObj = fl.getDocumentDOM() .library.items[0];
var numHorizontalPixels = bmItemObj.hPixels;

See also

bitmapItem.vPixels

bitmapltem.lastModifiedDate

Availability
Flash Pro CSé6.

Usage
bitmapItem.lastModifiedDate

Description

Read-only property; a hexadecimal value indicating the modification date and time of the bitmap item. This value is
incremented every time the bitmap item is imported. For example, selecting the Update button from the Bitmap
Properties dialog will trigger an import.

Example

Assuming the first item in the Library is a bitmap item, the following code displays a hex number as described above.

var libItem = fl.getDocumentDOM() .library.items[0];
fl.trace("Mod date when imported = " + libItem.lastModifiedDate) ;

See also
bitmapItem.sourceFileExists,bitmapItem.sourceFileIsCurrent, bitmapItem.sourceFilePath,

FLfile.getModificationDate ()

bitmapltem.originalCompressionType

Availability
Flash CS4 Professional.

Usage

bitmapItem.originalCompressionType

Description
Read-only property; a string that specifies whether the specified item was imported as an jpeg file. Possible values for
this property are “photo” (for jpeg files) and “lossless” (for uncompressed file types such as GIF and PNG).

Example

Assuming that the first item in the Library is a bitmap item, the following code displays "photo" if the file was imported
into the Library as a jpeg file, or "lossless" if is was not:

Last updated 12/6/2013
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var libItem = fl.getDocumentDOM() .library.items[0];
fl.trace("Imported compression type = "+ libItem.originalCompressionType) ;

See also

bitmapItem.compressionType

bitmapltem.quality

Availability
Flash MX 2004.

Usage
bitmapItem.quality

Description
Property; an integer that specifies the quality of the bitmap. To use the default document quality, specify -1; otherwise,
specify an integer from 0 to 100. Available only for JPEG compression.

Example
The following code sets the quality property of the first item in the library of the current document to 65:

fl.getDocumentDOM () .library.items [0] .quality = 65;
alert (f1l.getDocumentDOM () .library.items [0] .quality) ;

bitmapltem.sourceFileExists

Availability
Flash CS4 Professional.

Usage

bitmapItem.sourceFileExists

Description
Read-only property; a Boolean value of t rue if the file that was imported to the Library still exists in the location from
where it was imported; false otherwise.

Example
Assuming the first item in the Library is a bitmap item, the following code displays "true" if the file that was imported
into the Library still exists.

var libItem = fl.getDocumentDOM() .library.items[0];

fl.trace("sourceFileExists = "+ libItem.sourceFileExists) ;

See also

bitmapItem.sourceFileIsCurrent

bitmapItem.sourceFilePath
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bitmapltem.sourceFilelsCurrent

Availability
Flash CS4 Professional.

Usage

bitmapItem.sourceFileIsCurrent

Description
Read-only property; a Boolean value of true if the file modification date of the Library item is the same as the
modification date on disk of the file that was imported ;£alse otherwise.

Example
Assuming the first item in the Library is a bitmap item, the following code displays "true" if the file that was imported
has not been modified on disk since it was imported:

var libItem = fl.getDocumentDOM() .library.items[0];

fl.trace("fileIsCurrent = "+ libItem.sourceFileIsCurrent) ;

See also

bitmapItem.filelLastModifiedDate, bitmapItem.sourceFilePath

bitmapltem.sourceFilePath

Availability
Flash CS4 Professional.

Usage

bitmapItem.sourceFilePath

Description
Read-only property; a string, expressed as a file:/// URI, that represents the path and name of the file that was imported
into the Library.

Example
The following example displays the name and source file path of any items in the library that are of type "bitmap":

for (idx in fl.getDocumentDOM() .library.items) ({

if (fl.getDocumentDOM() .library.items[idx].itemType == "bitmap") {
var myItem = fl.getDocumentDOM() .library.items [idx];
fl.trace(myItem.name + " source is " + myItem.sourceFilePath) ;
}

}

See also

bitmapItem.sourceFileExists
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bitmapltem.useDeblocking

Availability
Flash CS4 Professional.

Usage
bitmapItem.useDeblocking

Description
Property; a Boolean value that specifies whether deblocking is enabled (true) or not (false).

Example

Assuming the first item in the Library is a bitmap item, the following code enables deblocking for the item:

var libItem = fl.getDocumentDOM() .library.items[0];
libItem.useDeblocking = true;

bitmapltem.uselmportedJPEGQuality

Availability
Flash MX 2004.

Usage
bitmapItem.useImportedJPEGQuality

Description
Property; a Boolean value that specifies whether to use the default imported JPEG quality (true) or not (false).
Available only for JPEG compression.

Example
The following code sets the useImportedJPEGQuality property of the first item in the library of the current
document to true:

fl.getDocumentDOM () .library.items [0] .useImporteddJPEGQuality = true;
alert (f1.getDocumentDOM () .library.items [0] .useImportedJPEGQuality) ;

bitmapltem.vPixels

Availability
Flash CS6 Professional.

Usage

bitmapItem.vPixels
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Description
Read-only property; an int that specifies the height of the bitmap, in pixels.

Example
The following code illustrates use of this property.

// get the number of pixels in the vertical dimension
var bmitemObj = fl.getDocumentDOM() .library.items[0];
var numHorizontalPixels = bmitemObj.vPixels;

See also

bitmapItem.hPixels

Last updated 12/6/2013
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compiledCliplnstance summary

Inheritance

Availability
Flash MX 2004.

Description

The CompiledClipInstance object is a subclass of the Instance object. It is essentially an instance of a movie clip that

Element object > Instance object > CompiledClipInstance object

has been converted to a compiled clip library item (see Instance object).

Property summary

In addition to the properties of the Instance object, the CompiledClipInstance object has the following properties:

Property Description

compiledClipInstance.accName A string that is equivalent to the Name field in the Accessibility panel.

compiledClipInstance.actionScript - Dropped in Flash Professional CC.

dropped

compiledClipInstance.backgroundColor [ A string that specifies the matte color when Opaque is selected.

compiledClipInstance.description A string that is equivalent to the Description field in the Accessibility panel.

compiledClipInstance.blendMode A string that specifies the blend mode.

compiledClipInstance.brightness An int that contains the value set in the Color Effect Property Inspector for
brightness.

compiledClipInstance.cacheAsBitmap A boolean that indicates whether to cache bitmaps.

compiledClipInstance.colorAlphaAmoun [ Anintthatreduces orincreases the tint and alpha values by a constant

t amount.

compiledClipInstance.colorAlphaPerce [ An intthatreduces the tintand alpha values by a specified percentage.

nt

compiledClipInstance.colorBlueAmount | An intthat reduces orincreases the blue tint value by a constant amount.

compiledClipInstance.colorBluePercen [ Anintthatreduces the blue tintvalue by a specified percentage.

t

compiledClipInstance.colorGreenAmoun | An intthat reduces orincreases the green tint value by a constant amount.

t

compiledClipInstance.colorGreenPerce [ An intthatreducesthe green tintvalue by a specified percentage.

nt

compiledClipInstance.colorMode A string that specifies the color mode, as identified in the Symbol Properties
dialog.

compiledClipInstance.colorRedAmount An int that reduces or increases the red tint value by a constant amount.

compiledClipInstance.colorRedPercent [ An intthatreducesthe green tintvalue by a specified percentage.
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Property Description

compiledClipInstance.description A string that is equivalent to the Description field in the Accessibility panel.

compiledClipInstance.filters An array of Filter objects.

compiledClipInstance.forceSimple A Boolean value that enables and disables the children of the object to be
accessible.

compiledClipInstance.shortcut A string that is equivalent to the Shortcut field in the Accessibility panel.

compiledClipInstance.silent A Boolean value that enables or disables the accessibility of the object;

equivalent to the inverse logic of the Make Object Accessible setting in the
Accessibility panel.

compiledClipInstance.tabIndex An integer that is equivalent to the Tab Index field in the Accessibility panel.

compiledClipInstance.tintColor Aa Color object that, when the Color Effect Property Inspector is using style
tint, returns the color applied to the tint.

compiledClipInstance.tintPercent A string that, when the Color Effect Property Inspector is using style tint,
returns the tint percentage.

compiledClipInstance.useBackgroundCo [ A boolean that sets the background color.
lor

compiledClipInstance.visible A boolean that sets visibility.

compiledClipinstance.accName

Availability
Flash MX 2004.

Usage

compiledClipInstance.accName

Description
Property; a string that is equivalent to the Name field in the Accessibility panel. Screen readers identify objects by
reading the name aloud.

Example
The following example gets and sets the accessibility name of the first selected object:

// Get the name of the object.

var theName = fl.getDocumentDOM() .selection[0] .accName;
// Set the name of the object.
f1l.getDocumentDOM () .selection[0] .accName = 'Home Button';

compiledCliplnstance.actionScript - dropped

Availability
Flash MX 2004. Dropped in Flash Professional CC.
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49



EXTENDING FLASH PROFESSIONAL
CompiledClipInstance object

Usage

compiledClipInstance.actionScript

Description
Dropped in Flash Professional CC.

Property; a string that represents the ActionScript for this instance; equivalent to symbolInstance.actionScript -
dropped.

Example
The following code assigns ActionScript to specified elements:
// Assign some ActionScript to a specified Button compiled clip instance.
f1l.getDocumentDOM () .getTimeline () .layers[0] .frames [0] .elements [0]
.actionScript = "on(click) {trace('button is clicked');}";
// Assign some ActionScript to the currently selected Button compiled clip instance.

fl.getDocumentDOM () .selection[0] .actionScript =
"on(click) {trace('button is clicked');}";

compiledClipinstance.backgroundColor

Availability
Flash Professional CC.

Usage

compiledClipInstance.backgroundColor

Description
Property; a string that specifies the matte color when Opaque is selected. This is a string in hexadecimal #rrggbb format
or an integer containg the value.

Example
The following example illustrates getting the backgroundColor property:

var bitmapInstance = fl.getDocumentDOM() .getTimeline () .layers[0].frames[0].elements[0];
bitmapInstance.backgroundColor = "#000000";

compiledClipinstance.blendMode

Availability
Flash Professional CC.

Usage
compiledClipInstance.blendMode
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Description
Property; a string that specifies the blend mode. Valid blend modes are: normal, layer, darken, multiply, lighten,
screen, overlay, hardlight, add, subtract, difference, invert, alpha, and erase.

Example

The following example illustrates getting and setting the blendMode property:

//1if the blend mode is 'add',6 change it to 'subtract'

var blend = fl.getDocumentDOM() .getTimeline () .layers[0].frames[0].elements[0] .blendMode;
fl.trace(blend) ;
if (blend == 'add'){

fl.getDocumentDOM () .getTimeline () .layers[0] .frames [0] .elements[0] .blendMode = 'subtract';

}

compiledClipinstance.brightness

Availability
Flash Professional CC.

Usage

compiledClipInstance.brightness

Description

Read-only property; an int that contains the value set in the Color Effect Property Inspector for brightness when
colorMode == 'brightness'. Specify a percentage between -100 and 100. Returns an error if colorMode is a different
setting.

Example

The following example illustrates use of this property:

var elem = fl.getDocumentDOM() .getTimeline () .layers[0].frames[0] .elements[0];
if (elem.colorMode == 'brightness') {
fl.trace(elem.brightness) ;

compiledClipinstance.cacheAsBitmap

Availability
Flash Professional CC.

Usage

compiledClipInstance.cacheAsBitmap
Description

Property; a boolean that indicates whether to cache bitmaps. (Equivalent to Use runtime bitmap caching in the
Property Inspector). The default is false.
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Example
The following example illustrates use of this property:

fl.getDocumentDOM () .getTimeline () .layers[0] .frames [0] .elements[0] .cacheAsBitmap = true;

compiledClipinstance.colorAlphaAmount

Availability
Flash Professional CC.

Usage

compiledClipInstance.colorAlphaAmount

Description
Property; an int that reduces or increases the tint and alpha values by a constant amount. This value is added to the
current value. This setting is most useful if used in conjunction with colorAlphaPercent. Valid values are -255 to 255.

This setting is the same as selecting Color > Advanced in the Instance Property Inspector and adjusting the controls
on the right of the dialog.

Example

The following example illustrates use of this property:

//change the colorAlphaZAmount of the first element in the first frame, top layer
f1l.getDocumentDOM () .getTimeline () .layers[0] .frames [0] .elements[0] .colorAlphaAmount = 100;

//change the colorAlphaAmount of the selected symbol instance
f1l.getDocumentDOM () .selection[0] .colorAlphaAmount = -100;

compiledClipinstance.colorAlphaPercent

Availability
Flash Professional CC.

Usage

compiledClipInstance.colorAlphaPercent

Description
Property; an int that reduces or increases the tint and alpha values by a specified percentage. The current values are
multiplied by this percentage. Valid values are -100 to 100.

This setting is the same as selecting Color > Advanced in the Instance Property Inspector and adjusting the controls
on the left of the dialog

Example
The following example illustrates use of this property:

Last updated 12/6/2013



EXTENDING FLASH PROFESSIONAL
CompiledClipInstance object

//change the colorAlphaPercent of the first element in the first frame, top layer
fl.getDocumentDOM () .getTimeline () .layers[0] .frames[0] .elements [0] .colorAlphaPercent = -100;
//change the colorAlphaPercent of the selected symbol instance
f1l.getDocumentDOM () .selection[0] .colorAlphaPercent = 90;

compiledClipinstance.colorBlueAmount

Availability
Flash Professional CC.

Usage

compiledClipInstance.colorBlueAmount

Description

Property; an int that either reduces or increases the blue tint by a constant amount. This value is added to the current
value. Valid values are -255 to 255.

This setting is the same as selecting Color > Advanced in the Instance Property Inspector.

Example

The following example illustrates use of this property:

// Change the colorBlueAmount of the first element in the first frame, top layer
fl.getDocumentDOM () .getTimeline () .layers[0] .frames [0] .elements [0] .colorBlueAmount = 100;

//change the colorBlueAmount of the selected symbol instance
f1l.getDocumentDOM () .selection[0] .colorBlueAmount = 255;

compiledClipinstance.colorBluePercent

Availability
Flash Professional CC.

Usage

compiledClipInstance.colorBluePercent

Description

Property; an int that reduces or increases the blue tint values by a specified percentage. The current values are
multiplied by this percentage. Valid values are -100 to 100.

This setting is the same as selecting Color > Advanced in the Instance Property Inspector.

Example

The following example illustrates use of this property:

/ /change the colorBluePercent of the first element in the first frame, top layer
f1l.getDocumentDOM () .getTimeline () .layers[0] .frames [0] .elements [0] .colorBluePercent = 100;

//change the colorBluePercent of the selected symbol instance
fl.getDocumentDOM () .selection[0] .colorBluePercent = 80;
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compiledClipinstance.colorGreenAmount

Availability
Flash Professional CC.

Usage

compiledClipInstance.colorGreenAmount

Description

Property; an int that either reduces or increases the green tint by a constant amount. This value is added to the current
value. Valid values are -255 to 255.

This setting is the same as selecting Color > Advanced in the Instance Property Inspector.

Example

The following example illustrates use of this property:

// change the colorGreenAmount of the first element in the first frame, top layer
fl.getDocumentDOM () .getTimeline () .layers[0] .frames [0] .elements[0] .colorGreenAmount = 100;

//change the colorGreenAmount of the selected symbol instance
fl.getDocumentDOM () .selection[0] .colorGreenAmount = 255;

compiledCliplnstance.colorGreenPercent

Availability
Flash Professional CC.

Usage

compiledClipInstance.colorGreenPercent

Description
Property; an int that reduces or increases the green tint values by a specified percentage. The current values are
multiplied by this percentage. Valid values are -100 to 100.

This setting is the same as selecting Color > Advanced in the Instance Property Inspector.

Example

The following example illustrates use of this property:

/change the colorGreenPercent of the first element in the first frame, top layer
f1l.getDocumentDOM () .getTimeline () .layers[0] .frames[0] .elements [0] .colorGreenPercent = 100;

//change the colorGreenPercent of the selected symbol instance
fl.getDocumentDOM () .selection[0] .colorGreenPercent = 80;
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compiledClipinstance.colorMode

Availability
Flash Professional CC.

Usage

compiledClipInstance.colorMode

Description
Property; a string that specifies the color mode, as identified in the Symbol Properties dialog. Valid values are “none”,
alpha”, and “advanced”.

» « » «

“brightness”, “tint”,

Example

The following example illustrates use of this property:

//change the colorMode of the first element in the first frame, top layer
fl.getDocumentDOM () .getTimeline () .layers[0] .frames [0] .elements[0] .colorMode = 'advanced';

compiledClipinstance.colorRedAmount

Availability
Flash Professional CC.

Usage

compiledClipInstance.colorRedAmount

Description
Property; an int that either reduces or increases the red tint by a constant amount. This value is added to the current
value. Valid values are -255 to 255.

This setting is the same as selecting Color > Advanced in the Instance Property Inspector.

Example

The following example illustrates use of this property:

// change the colorRedAmount of the first element in the first frame, top layer
fl.getDocumentDOM () .getTimeline () .layers[0] .frames[0] .elements [0] .colorRedAmount = 100;
//change the colorRedAmount of the selected symbol instance
f1l.getDocumentDOM () .selection[0] .colorRedAmount = 255;

compiledCliplnstance.colorRedPercent

Availability
Flash Professional CC.
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Usage

compiledClipInstance.colorRedPercent

Description
Property; an int that reduces or increases the red tint values by a specified percentage. The current values are multiplied
by this percentage. Valid values are -100 to 100.

This setting is the same as selecting Color > Advanced in the Instance Property Inspector.

Example

The following example illustrates use of this property:

//change the colorRedPercent of the first element in the first frame, top layer
f1l.getDocumentDOM () .getTimeline () .layers[0] .frames [0] .elements [0] .colorRedPercent = 100;

//change the colorRedPercent of the selected symbol instance
f1l.getDocumentDOM () .selection[0] .colorRedPercent = 80;

compiledCliplnstance.description

Availability
Flash MX 2004.

Usage

compiledClipInstance.description

Description
Property; a string that is equivalent to the Description field in the Accessibility panel. The description is read by the
screen reader.

Example

The following example illustrates getting and setting the description property:
// Get the description of the current selection.

var theDescription = fl.getDocumentDOM() .selection[0] .description;
// Set the description of the current selection.

fl.getDocumentDOM () .selection[0] .description =
"This is compiled clip number 1";

compiledClipinstance.filters

Availability
Flash Professional CC.

Usage

compiledClipInstance.filters
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Description

Property; an array of Filter objects. The properties of Filter object in the filters array can be read but cannot be written
directly by accessing the filters array. To set the properties of the filter objects in the filters array, first retrieve the array,
set the properties, set it back to the filters array.

Example
The following example illustrates use of this property:
//trace the name of the filter at index 0, if == glow filter, set its blurX to 100
var filterName =
fl.getDocumentDOM () .getTimeline () .layers[0] .frames[0] .elements[0] .filters[0] .name;
fl.trace(filterName) ;
var filterArray = fl.getDocumentDOM() .getTimeline () .layers[0].frames[0] .elements[0].filters;
if (filterName == 'glowFilter') {
filterArray[0] .blurX = 100;

}

fl.getDocumentDOM () .getTimeline () .layers[0] .frames[0] .elements[0] .filters = filterArray;

compiledClipinstance.forceSimple

Availability
Flash MX 2004.

Usage

compiledClipInstance.forceSimple

Description

Property; a Boolean value that enables and disables the children of the object to be accessible. This is equivalent to the
inverse logic of the Make Child Objects Accessible setting in the Accessibility panel. If forcesimple is true, it is the
same as the Make Child Objects Accessible option being unchecked. If forcesimple is false, it is the same as the
Make Child Object Accessible option being checked.

Example

The following example illustrates getting and setting the forcesimple property:

// Query if the children of the object are accessible.
var areChildrenAccessible = fl.getDocumentDOM () .selection[0].forceSimple;
// Allow the children of the object to be accessible.
fl.getDocumentDOM () .selection[0] . forceSimple = false;

compiledClipinstance.shortcut

Availability
Flash MX 2004.

Usage

compiledClipInstance.shortcut
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Description
Property; a string that is equivalent to the Shortcut field in the Accessibility panel. The shortcut is read by the screen
reader. This property is not available for dynamic text fields.

Example
The following example illustrates getting and setting the shortcut property:

// Get the shortcut key of the object.

var theShortcut = fl.getDocumentDOM() .selection[0] .shortcut;
// Set the shortcut key of the object.
fl.getDocumentDOM () .selection[0] .shortcut = "Ctrl+I";

compiledCliplnstance.silent

Availability
Flash MX 2004.

Usage

compiledClipInstance.silent

Description

Property; a Boolean value that enables or disables the accessibility of the object; equivalent to the inverse logic of Make
Object Accessible setting in the Accessibility panel. That is, if silent is true, then Make Object Accessible is
unchecked. If silent is false, then Make Object Accessible is checked.

Example

The following example illustrates getting and setting the silent property:
// Query if the object is accessible.

var isSilent = fl.getDocumentDOM() .selection[0] .silent;

// Set the object to be accessible.
fl.getDocumentDOM () .selection[0] .silent = false;

compiledClipinstance.tabindex

Availability
Flash MX 2004.

Usage

compiledClipInstance.tabIndex
Description
Property; an integer that is equivalent to the Tab Index field in the Accessibility panel. Creates a tab order in which

objects are accessed when the user presses the Tab key.

Example
The following example illustrates getting and setting the tabIndex property:
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// Get the tabIndex of the object.

var theTabIndex = fl.getDocumentDOM() .selection[0] .tabIndex;
// Set the tabIndex of the object.
f1l.getDocumentDOM () .selection[0] .tabIndex = 1;

compiledClipinstance.tintColor

Availability
Flash Professional CC.

Usage

compiledClipInstance.tintColor

Description
Read-only property; a Color object that, when the Color Effect Property Inspector is using style tint (colorMode ==
'tint'), returns the color applied to the tint. Otherwise, using this property results in an error.

Example

The following example illustrates use of this property:

var elem = fl.getDocumentDOM() .getTimeline () .layers[0].frames[0] .elements[0];
if (elem.colorMode = 'tint') {

fl.trace(elem.tintColor) ;
fl.trace(elem.tintPercent) ;

compiledClipInstance.tintPercent

Availability
Flash Professional CC.

Usage

compiledClipInstance.tintPercent

Description
Read-only property; a string that, when the Color Effect Property Inspector is using style tint (colorMode == "tint'),
returns the tint percentage from -100 to 100. Otherwise, using this property results in an error.

Example

The following example illustrates use of this property:

var elem = fl.getDocumentDOM() .getTimeline () .layers[0] .frames[0].elements[0];
if (elem.colorMode = 'tint') {

fl.trace(elem.tintColor) ;
fl.trace(elem.tintPercent) ;
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compiledClipinstance.useBackgroundColor

Availability
Flash Professional CC.

Usage

compiledClipInstance.useBackgroundColor

Description
Property; a boolean that sets the background color:

+ true - Use 32-bit with alpha.

« false - Use the background color.

Example
The following example illustrates use of this property:

f1l.getDocumentDOM () .getTimeline () .layers[0] .frames [0] .elements [0] .useBackgroundColor = true;

compiledClipinstance.visible

Availability
Flash Professional CC.

Usage

compiledClipInstance.visible

Description
Property; a boolean that sets visibility. Equivalent to the visible checkbox in the Display section of the Property
Inspector for symbols.

Example

The following example illustrates use of this property:

// change visible to false on currently selected symbol instance
fl.getDocumentDOM () .selection[0] .visible = false;
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compilerErrors summary

Availability
Flash CS3 Professional.

Description
The compilerErrors object, which represents the Compiler Errors panel, is a property of the flash object (fl) and can
be accessed by £1.compilerErrors (see flash object (fl)).

Method summary
The following methods can be used with the compilerErrors object:

Method Description
compilerErrors.clear () Clears the contents of the Compiler Errors panel.
compilerErrors.save () Saves the contents of the Compiler Errors panel to a local text file.

compilerErrors.clear()

Availability
Flash CS3 Professional.

Usage

compilerErrors.clear ()

Parameters
None.

Returns
Nothing.

Description
Method; clears the contents of the Compiler Errors panel.

Example
The following example clears the contents of the Compiler Errors panel:

fl.compilerErrors.clear () ;

See also

compilerErrors.save ()
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compilerErrors.save()

Availability
Flash CS3 Professional.

Usage
compilerErrors.save (£i1leURI [, bAppendToFile [, bUseSystemEncoding]])

Parameters
£ileURI A string, expressed as a file:/// URI, that specifies the filename for the saved file. If fileURI already exists, and
you haven’t specified a value of t rue for bAppendToFile, fileURI is overwritten without warning.

bAppendToFile An optional Boolean value that specifies whether the contents of the Compiler Errors panel should
be appended to fileURI (true) or not (false). The default value is false.

bUseSystemEncoding An optional Boolean value that specifies whether to save the Compiler Errors panel text using
the system encoding. If this value is false (the default), the Compiler Errors panel text is saved using UTF-8 encoding,
with Byte Order Mark characters at the beginning of the text. The default value is false.

Returns
Nothing.

Description
Method; saves the contents of the Compiler Errors panel to a local text file.

Example
The following example saves the contents of the Compiler Errors panel to a file named errors.log in the C:\tests folder:

fl.compilerErrors.save("file:///c|/tests/errors.log") ;

See also

compilerErrors.clear ()
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componentlnstance summary

Inheritance  Element object > Instance object > SymbolInstance object > ComponentInstance object

Availability
Flash MX 2004.

Description
TheComponentInstance object is a subclass of the SymbolInstance object and represents a component in a frame (see
SymbolInstance object).

Property summary
In addition to all the properties of the SymbolInstance object, the ComponentInstance object has the following
property:

Property Description

componentInstance.parameters Read-only; an array of ActionScript 2.0 properties that are accessible from the
component Property inspector.

componentlnstance.parameters

Availability
Flash MX 2004.

Usage

componentInstance.parameters

Description
Read-only property; an array of ActionScript 2.0 properties that are accessible from the component Property
inspector. See Parameter object.

Example
The following example illustrates getting and setting the parameters property:

var parms = fl.getDocumentDOM() .selection[0] .parameters;
parms [0] .value = "some value";
See also

Parameter object
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componentsPanel summary

Availability
Flash MX 2004.

Description
The componentsPanel object, which represents the Components panel, is a property of the flash object () and can be
accessed by £1. componentsPanel (see flash object (fl)).

Method summary
You can use the following methods with the componentsPanel object:
Method Description
componentsPanel .addItemToDocument () Adds the specified component to the document at the specified
position.
componentsPanel .reload () Refreshes the Components panel's list of components.

componentsPanel.additemToDocument()

Availability
Flash MX 2004.

Usage

componentsPanel .addItemToDocument (position, categoryName, componentName)

Parameters

position A point (for example, {x:0, y:100}) that specifies the location at which to add the component. Specify
position relative to the center point of the component—not the component’s registration point (also origin point or
zero point).

categoryName A string that specifies the name of the component category (for example, "Data"). The valid category
names are listed in the Components panel.

componentName A string that specifies the name of the component in the specified category (for example,
"WebServiceConnector"). The valid component names are listed in the Components panel.

Returns
Nothing.

Description
Adds the specified component to the document at the specified position.
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Example
The following examples illustrate some ways to use this method:

fl.componentsPanel .addItemToDocument ({x:0, y:0}, "User Interface", "CheckBox");
fl.componentsPanel.addItemToDocument({X:O, y:lOO}, "Data", "WebServiceConnector") ;
fl.componentsPanel.addItemToDocument({X:O, y:200}, "User Interface", "Button");

componentsPanel.reload()

Availability
Flash 8.

Usage

componentsPanel.reload ()

Parameters
None.

Returns

A Boolean value of true if the Component panel list is refreshed, false otherwise.

Description

Method; refreshes the Components panel’s list of components.

Example
The following example refreshes the Components panel:

f1l.componentsPanel.reload() ;
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contour summary

Availability
Flash MX 2004.

Description
A Contour object represents a closed path of half edges on the boundary of a shape.

Method summary
You can use the following method with the Contour object:

Method Description

contour.getHalfEdge () Returns a HalfEdge object on the contour of the selection.
Property summary

You can use the following properties with the Contour object:

Property Description

contour.fill A Fill object.

contour.interior Read-only; the value is t rue if the contour encloses an area; false otherwise.
contour.orientation Read-only; an integer indicating the orientation of the contour.

contour.fill

Availability
Flash CS4 Professional.

Usage

contour.fill

Description
Property; a Fill object.

Example
Assuming that you have a contour with a fill selected, the following example displays the contour’s fill color in the
Output panel:

var insideContour = fl.getDocumentDOM () .selection[0].contours[1];
var insideFill = insideContour.fill;
fl.trace(insideFill.color) ;
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contour.getHalfEdge()

Availability
Flash MX 2004.

Usage
contour.getHalfEdge ()

Parameters
None.

Returns
A HalfEdge object.

Description

Method; returns a HalfEdge object on the contour of the selection.

Example

This example traverses all the contours of the selected shape and shows the coordinates of the vertices in the Output
panel:

// with a shape selected

var elt = fl.getDocumentDOM () .selection[0];
elt.beginEdit () ;

var contourArray = elt.contours;
var contourCount = 0;

for (i=0;i<contourArray.length;i++)

var contour = contourArray[il];
contourCount++;
var he = contour.getHalfEdge () ;

var iStart = he.id;

var id = 0;

while (id != iStart)

{
// Get the next vertex.
var vrt = he.getVertex();

var x = vrt.x;
var y = vrt.y;
fl.trace("vrt: " + x + ", " + y);

he
id

he.getNext () ;
he.id;

}

elt.endEdit () ;
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contour.interior

Availability
Flash MX 2004.

Usage

contour.interior

Description
Read-only property; the value is true if the contour encloses an area; false otherwise.

Example
This example traverses all the contours of the selected shape and shows the value of the interior property for each
contour in the Output panel:

var elt = fl.getDocumentDOM () .selection[0];
elt.beginEdit () ;

var contourArray = elt.contours;

var contourCount = 0;

for (i=0;i<contourArray.length;i++) {
var contour = contourArrayl[i];
fl.trace ("Next Contour, interior:" + contour.interior );
contourCount++;

elt.endEdit () ;

contour.orientation

Availability
Flash MX 2004.

Usage

contour.orientation

Description
Read-only property; an integer indicating the orientation of the contour. The value of the integer is -1 if the orientation
is counterclockwise, 1 if it is clockwise, and 0 if it is a contour with no area.

Example

The following example traverses all the contours of the selected shape and shows the value of the orientation
property of each contour in the Output panel:
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var elt = fl.getDocumentDOM () .selection[0];
elt.beginEdit () ;

var contourArray = elt.contours;
var contourCount = 0;
for (i=0;i<contourArray.length;i++) {
var contour = contourArray[il];
fl.trace ("Next Contour, orientation:" + contour.orientation) ;

contourCount++;

elt.endEdit () ;

Last updated 12/6/2013



Chapter 11: Document object

document summary

Availability
Flash MX 2004.

Description

The Document object represents the Stage. That is, only FLA files are considered documents. To return the Document

object for the current document, use £1.getDocumentDOM ().

Method summary

You can use the following methods with the Document object:

Method Description

document . addDataToDocument () Stores specified data with a document.

document .addDataToSelection () Stores specified data with the selected objects.

document .addFilter () Applies a filter to the selected objects.

document .addItem() Adds an item from any open document or library to the
specified Document object.

document .addNewLine () Adds a new path between two points.

document . addNewOval () Adds a new Oval object in the specified bounding rectangle.

document .addNewPrimitiveOval () Adds a new oval primitive fitting into the specified bounds.

document .addNewPrimitiveRectangle () Adds a new rectangle primitive fitting into the specified
bounds.

document . addNewPublishProfile () Adds a new publish profile and makes it the current one.

document . addNewRectangle () Adds a new rectangle or rounded rectangle, fitting it into the
specified bounds.

document . addNewScene () Adds a new scene (Timeline object) as the next scene after the
currently selected scene and makes the new scene the
currently selected scene.

document . addNewText () Inserts a new empty text field.

document .align () Aligns the selection.

document .allowScreens () - dropped Dropped in Flash Professional CC.

document .arrange () Arranges the selection on the Stage.

document .breakApart () Performs a break-apart operation on the current selection.

document . canEditSymbol () Indicates whether the Edit Symbols menu and functionality are
enabled.

document . canRevert () Determines whetheryou can use the document . revert () or

f1.revertDocument () method successfully.
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Method Description
document . canTestMovie () Determines whether you can use the
document . testMovie () method successfully.
document .canTestScene () Determines whether you can use the
document . testScene () method successfully.
document . changeFilterOrder () Changes the index of the filter in the Filters list.
document .clipCopy () Copies the current selection from the document to the
Clipboard.
document .clipCut () Cuts the current selection from the document and writes it to
the Clipboard.
document .clipPaste () Pastes the contents of the Clipboard into the document.
document .close () Closes the specified document.
document .convertLinesToFills () Converts lines to fills on the selected objects.

document .

convertSelectionToBitmap ()

Converts selected objects in the current frame to a bitmap and
inserts the bitmap into the library.

document . convertToSymbol () Converts the selected Stage items to a new symbol.

document . crop () Uses the top selected drawing object to crop all selected
drawing objects underneath it.

document . debugMovie () Initiates a debug session with the document.

document .deleteEnvelope () Deletes the envelope (bounding box that contains one or
more objects) from the selected object.

document .deletePublishProfile () Deletes the currently active profile, if there is more than one.

document .deleteScene () Deletes the current scene (Timeline object), and if the deleted
scene was not the last one, sets the next scene as the current
Timeline object.

document .deleteSelection () Deletes the current selection on the Stage.

document .disableAllFilters () Disables all filters on the selected objects.

document .disableFilter () Disables the specified filter in the Filters list.

document .disableOtherFilters () Disables all filters except the one at the specified position in
the Filters list.

document .distribute () Distributes the selection.

document .distributeToKeyframes () Performs a distribute-to-keyframes operation on the current

selection; equivalent to selecting Distriute to Keyframes.

document

.distributeToLayers ()

Performs a distribute-to-layers operation on the current
selection; equivalent to selecting Distribute to Layers.

document . documentHasData () Checks the document for persistent data with the specified
name.
document .duplicatePublishProfile () Duplicates the currently active profile and gives the duplicate

version focus.

document .duplicateScene () Makes a copy of the currently selected scene, giving the new
scene a unique name and making it the current scene.
document .duplicateSelection () Duplicates the selection on the Stage.
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Method Description

document .editScene () Makes the specified scene the currently selected scene for
editing.

document .enableAllFilters () Enables all the filters on the Filters list for the selected objects.

document .enableFilter () Enables the specified filter for the selected objects.

document . enterEditMode () Switches the authoring tool into the editing mode specified by
the parameter.

document . exitEditMode () Exits from symbol-editing mode and returns focus to the next
level up from the editing mode.

document . exportInstanceToLibrary () Export a selected movie clip, graphic, or button instance on the

Stage to a new bitmap in the Library.

document

)

.exportInstanceToPNGSequence (

Export a selected movie clip, graphic, or button instance on the
Stage to a series of PNG files on disk.

document .

exportPNG ()

Exports the document as one or more PNG files.

document .

exportPublishProfile ()

Exports the currently active profile to an XML file.

document .

exportPublishProfileString ()

Returns a string that specifies, in XML format, the specified
profile.

document . exportSWF () Exports the document in the Flash SWF format.

document . exportVideo () Exports a video from the document and optionally sends it to
Adobe Media Encoder to convert the video.

document .getAlignToDocument () Identical to retrieving the value of the To Stage button in the
Align panel.

document .getBlendMode () Returns a string that specifies the blending mode for the
selected objects.

document .getCustomFill () Retrieves the fill object of the selected shape, or the Tools
panel and Property inspector if specified.

document .getCustomStroke () Returns the stroke object of the selected shape, or the Tools
panel and Property inspector if specified.

document .getDataFromDocument () Retrieves the value of the specified data.

document .getElementProperty () Gets the specified Element property for the current selection.

document .getElementTextAttr () Gets a specified TextAttrs property of the selected Text
objects.

document .getFilters () Returns an array that contains the list of filters applied to the
currently selected objects.

document .getMetadata () Returns a string containing the XML metadata associated with
the document.

document .getMobileSettings () Returns the string passed to
document . setMobileSettings ().

document .getPlayerVersion () Returns a string that represents the targeted player version for
the specified document.

document .getPublishDocumentData () Indicates whether publishing of the specified persistent data is

enabled for the specified format in the document.

document

.getSelectionRect ()

Gets the bounding rectangle of the current selection.
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Method Description
document .getSWFPathFromProfile () Gets the full path to the SWF file that is set in the current

Publish profile.

document .getTelemetryForsSwf () Indicates whether the “Enable detailed telemetry” checkbox is
selected in the Publish Settings dialog.

document .getTextString () Gets the currently selected text.

document .getTimeline () Retrieves the current Timeline object in the document.

document .getTransformationPoint () Gets the location of the transformation point of the current

selection.

document . group () Converts the current selection to a group.
document . importFile () Imports a file into the document.
document . importPublishProfile () Imports a profile from a file.

document .

importPublishProfileString ()

Imports an XML string that represents a publish profile and sets
it as the current profile.

document . importSWF () - dropped Dropped in Flash Profesional CC.

document . intersect () Creates an intersection drawing object from all selected
drawing objects.

document . loadCuepointXML () - dropped Dropped in Flash Professional CC.

document .match () Makes the size of the selected objects the same.

document .mouseClick () Performs a mouse click from the Selection tool.

document .mouseDb1Clk () Performs a double mouse click from the Selection tool.

document .moveSelectedBezierPointsBy () | Ifthe selection contains at least one path with at least one

Bézier point selected, this method moves all selected Bézier
points on all selected paths by the specified amount.

document .moveSelectionBy () Moves selected objects by a specified distance.

document .optimizeCurves () Optimizes smoothing for the current selection, allowing
multiple passes, if specified, for optimal smoothing; equivalent
to selecting Modify > Shape > Optimize.

document .publish () Publishes the document according to the active publish
settings (File > Publish Settings); equivalent to selecting File >
Publish.

document . punch () Uses the top selected drawing object to punch through all
selected drawing objects underneath it.

document . removeAllFilters () Removes all filters from the selected objects.

document . removeDataFromDocument () Removes persistent data with the specified name that has

been attached to the document.

document .

removeDataFromSelection ()

Removes persistent data with the specified name that has
been attached to the selection.

document . removeFilter () Removes the specified filter from the Filters list of the selected
objects.

document . renamePublishProfile () Renames the current profile.

document . renameScene () Renames the currently selected scene in the Scenes panel.
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Method Description
document . reorderScene () Moves the specified scene before another specified scene.
document . resetOvalObject () Sets all values in the Property inspector to default Oval object

settings.

document .

resetRectangleObject ()

Sets all values in the Property inspector to default Rectangle
object settings.

document .

resetTransformation ()

Resets the transformation matrix; equivalent to selecting
Modify > Transform > Remove Transform.

document . revert () Reverts the specified document to its previously saved version;
equivalent to selecting File > Revert.
document . rotate3DSelection () Applies a 3D rotation to the selection.

document .rotateSelection () Rotates the selection by a specified number of degrees.

document . save () Saves the document in its default location; equivalent to
selecting File > Save.

document . saveAsCopy () Saves a copy of the document to a specified location.

document . saveAndCompact () - dropped Dropped in Flash Professional CS6.

document .scaleSelection () Scales the selection by a specified amount; equivalent to using
the Free Transform tool to scale the object.

document .selectAll () Selects all items on the Stage; equivalent to pressing
Control+A (Windows) or Command+A (Macintosh) or
selecting Edit > Select All.

document . selectNone () Deselects any selected items.

document . setAlignToDocument () Sets the preferences for document .align (),

document .distribute (), document .match (), and
document . space () to act on the document; equivalent to
enabling the To Stage button in the Align panel.

document . setBlendMode () Sets the blending mode for the selected objects.

document . setCustomFill () Sets the fill settings for the Tools panel, Property inspector, and
any selected shapes.

document . setCustomStroke () Sets the stroke settings for the Tools panel, Property inspector,
and any selected shapes.

document . setElementProperty () Sets the specified Element property on selected objects in the

document.

document . setElementTextAttr () Sets the specified TextAttrs property of the selected text
items to the specified value.

document .setFillColor () Changes the selection and the tools panel to the specified
color.

document . setFilterProperty () Sets a specified filter property for the currently selected
objects.

document .setFilters () Applies filters to the selected objects.

document . setInstanceAlpha () Sets the opacity of the instance.

document . setInstanceBrightness () Sets the brightness for the instance.

document . setInstanceTint () Sets the tint for the instance.
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Method Description

document . setMetadata () Sets the XML metadata for the specified document,
overwriting any existing metadata.

document . setMobileSettings () Sets the value of an XML settings string in a mobile FLA file.

document . setOvalObjectProperty () Specifies a value for a specified property of primitive Oval
objects.

document .setPlayerVersion () Sets the version of the Flash Player targeted by the specified
document.

document . setRectangleObjectProperty () | Specifies avalue fora specified property of primitive Rectangle
objects.

document . setSelectionBounds () Moves and resizes the selection in a single operation.

document . setSelectionRect () Draws a rectangular selection marquee relative to the Stage,
using the specified coordinates.

document . setStageVanishingPoint () Specifies the vanishing point for viewing 3D objects.

document . setStageViewAngle () Specifies the perspective angle for viewing 3D objects.

document . setStroke () Sets the color, width, and style of the selected strokes.

document . setStrokeColor () Changes the stroke color of the selection to the specified color.

document . setStrokeSize () Changes the stroke size of the selection to the specified size.

document . setStrokeStyle () Changes the stroke style of the selection to the specified style.

document . setTextRectangle () Changes the bounding rectangle for the selected text item to
the specified size.

document . setTextSelection () Sets the text selection of the currently selected text field to the
values specified by the startIndex and endIndex values.

document . setTextString () Inserts a string of text.

document . setTransformationPoint () Moves the transformation point of the current selection.

document . skewSelection () Skews the selection by a specified amount.

document . smoothSelection () Smooths the curve of each selected fill outline or curved line.

document . space () Spaces the objects in the selection evenly.

document . straightenSelection () Straightens the currently selected strokes; equivalent to using
the Straighten button in the Tools panel.

document . swapElement () Swaps the current selection with the specified one.

document . swapStrokeAndFill () Swaps the Stroke and Fill colors.

document . testMovie () Executes a Test Movie operation on the document.

document . testScene () Executes a Test Scene operation on the current scene of the
document.

document . traceBitmap () Performs a trace bitmap on the current selection; equivalent to
selecting Modify > Bitmap > Trace Bitmap.

document . transformSelection () Performs a general transformation on the current selection by
applying the matrix specified in the arguments.

document . translate3DCenter () Sets the XYZ position around which the selection is translated

or rotated.
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Method Description
document . translate3DSelection () Applies a 3D translation to the selection.
document . unGroup () Ungroups the current selection.
document .union () Combines all selected shapes into a drawing object.
document .unlockAllElements () Unlocks all locked elements on the currently selected frame.
document .xmlPanel () Posts a XMLUI dialog box.

Property summary

You can use the following properties with the Document object.

Property Description

document . accName A string that is equivalent to the Name field in the Accessibility panel.

document .as3AutoDeclare A Boolean value that describes whether the instances placed on the Stage
are automatically added to user-defined timeline classes.

document .as3Dialect A string that describes the ActionScript 3.0 “dialect” being used in the
specified document.

document . as3ExportFrame An integer that specifies in which frame to export ActionScript 3.0 classes.

document .as3StrictMode A Boolean value that specifies whether the ActionScript 3.0 compiler
should compile with the Strict Mode option turned on or off.

document . as3WarningsMode A Boolean value that specifies whether the ActionScript 3.0 compiler
should compile with the Warnings Mode option turned on or off.

document .asVersion An integer that specifies which version of ActionScript is being used in the
specified file.

document .autoLabel A Boolean value that is equivalent to the Auto Label check box in the
Accessibility panel.

document . backgroundColor A string, hexadecimal value, or integer that represents the background
color.

document . currentPublishProfile A string that specifies the name of the active publish profile for the

specified document.

document .currentTimeline An integer that specifies the index of the active timeline.

document .description A string that is equivalent to the Description field in the Accessibility
panel.

document .docClass Specifies the top-level ActionScript 3.0 class associated with the
document.

document .externalLibraryPath A string that contains a list of items in the document’s ActionScript 3.0

External library path, which specifies the location of SWC files used as
runtime shared libraries.

document . forceSimple A Boolean value that specifies whether the children of the specified object
are accessible.

document . frameRate A float value that specifies the number of frames displayed per second
when the SWF file plays; the default is 12.

document . height An integer that specifies the height of the document (Stage) in pixels.
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Property Description

document . id A unique integer (assigned automatically) that identifies a document
during a Flash session.

document . library Read-only; the library object for a document.

document . libraryPath A string that contains a list of items in the document’s ActionScript 3.0
Library path, which specifies the location of SWC files or folders containing
SWC files.

document .livePreview A Boolean value that specifies whether Live Preview is enabled.

document . name Read-only; a string that represents the name of a document (FLA file).

document .path Read-only; a string that represents the path of the document, in a
platform-specific format.

document . pathURI Read-only; a string that represents the path of the document, expressed as
afile:/// URI.

document .publishProfiles Read-only; an array of the publish profile names for the document.

document . screenOutline - dropped Dropped in Flash Professional CC.

document . selection An array of the selected objects in the document.

document .silent A Boolean value that specifies whether the object is accessible.

document . sourcePath A string that contains a list of items in the document’s ActionScript 3.0
Source path, which specifies the location of ActionScript class files.

document . swEJPEGQuality An integer that returns the JPEG Quality setting from the current Publish
Profile in the document.

document . timelines Read-only; an array of Timeline objects (see Timeline object).

document .viewMatrix Read-only; a Matrix object.

document .width An integer that specifies the width of the document (Stage) in pixels.

document . zoomFactor Specifies the zoom percent of the Stage at authoring time.

document.accName

Availability
Flash MX 2004.

Usage

document . accName

Description
Property; a string that is equivalent to the Name field in the Accessibility panel. Screen readers identify objects by
reading the name aloud.

Example
The following example sets the accessibility name of the document to "Main Movie":

fl.getDocumentDOM () .accName = "Main Movie";
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The following example gets the accessibility name of the document:

fl.trace(fl.getDocumentDOM () .accName) ;

document.addDataToDocument()

Availability
Flash MX 2004.

Usage

document .addDataToDocument (name, type, data)

Parameters
name A string that specifies the name of the data to add.

type A string that defines the type of data to add. Acceptable values are "integer", "integerarray", "double",
"doubleArray", "string", and "byteArray".

data The value to add. Valid types depend on the type parameter.

Returns
Nothing.

Description
Method; stores specified data with a document. Data is written to the FLA file and is available to JavaScript when the
file reopens.

Example
The following example adds an integer value of 12 to the current document:

f1l.getDocumentDOM () .addDataToDocument ("myData", "integer", 12);
The following example returns the value of the data named "myData" and displays the result in the Output panel:

fl.trace(fl.getDocumentDOM () .getDataFromDocument ("myData")) ;

See also

document .getDataFromDocument (), document . removeDataFromDocument ()

document.addDataToSelection()

Availability
Flash MX 2004.

Usage

document .addDataToSelection (name, type, data)
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Parameters
name A string that specifies the name of the persistent data.

type Deﬁnesthetypeofdma.Accepnﬁﬂevahwsare"integer","integerArray","double","doubleArray%
"string", and "byteArray".

data The value to add. Valid types depend on the type parameter.

Returns
Nothing.

Description
Method; stores specified data with the selected objects. Data is written to the FLA file and is available to JavaScript

when the file reopens. Only symbols and bitmaps support persistent data.

Example
The following example adds an integer value of 12 to the selected object:

f1l.getDocumentDOM () .addDataToSelection ("myData", "integer", 12);

See also

document . removeDataFromSelection ()

document.addFilter()

Availability
Flash 8.

Usage

document .addFilter (filterName)

Parameters

filterName A string specifying the filter to be added to the Filters list and enabled for the selected objects. Acceptable

Vduesare"adjustColorFilter", "bevelFilter", "blurFilter", "dropShadowFilter", "glowFilter",
"gradientBevelFilter", and "gradientGlowFilter".

Returns
Nothing.

Description
Method; applies a filter to the selected objects and places the filter at the end of the Filters list.

Example
The following example applies a glow filter to the selected objects:

fl.getDocumentDOM () .addFilter ("glowFilter") ;
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See also
document .changeFilterOrder (), document .disableFilter (), document.enableFilter (),
document .getFilters (), document .removeFilter (), document .setBlendMode (),

document .setFilterProperty ()

document.additem()

Availability
Flash MX 2004.

Usage

document .addItem(position, item)

Parameters
position A point that specifies the x and y coordinates of the location at which to add the item. It uses the center of
a symbol or the upper left corner of a bitmap or video.

item An Item object that specifies the item to add and the library from which to add it (see Item object).

Returns
A Boolean value: true if successful; false otherwise.

Description
Method; adds an item from any open document or library to the specified Document object.

Example
The following example adds the first item from the library to the first document at the specified location for the
selected symbol, bitmap, or video:

var item = fl.documents[0].library.items[0];
fl.documents[0] .addItem({x:0,y:0}, item);

The following example adds the symbol myMovieclip from the current document’s library to the current document:

var itemIndex = fl.getDocumentDOM() .library.findItemIndex ("myMovieClip") ;
var theItem = fl.getDocumentDOM () .library.items [itemIndex] ;
fl.getDocumentDOM () .addItem({x:0,y:0}, theItem);

The following example adds the symbol myMovieclip from the second document in the documents array to the third
document in the documents array:

var itemIndex = fl.documents[1l].library.findItemIndex ("myMovieClip") ;
var theItem = fl.documents[1l].library.items [itemIndex] ;
fl.documents[2] .addItem({x:0,y:0}, theltem);

document.addNewLine()

Availability
Flash MX 2004.
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Usage

document .addNewLine (startPoint, endpoint)

Parameters
startpoint A pair of floating-point numbers that specify the x and y coordinates where the line starts.

endpoint A pair of floating-point numbers that specify the x and y coordinates where the line ends.

Returns
Nothing.

Description

Method; adds a new path between two points. The method uses the document’s current stroke attributes and adds the
path on the current frame and current layer. This method works in the same way as clicking on the line tool and
drawing a line.

Example
The following example adds a line between the specified starting point and ending point:

f1l.getDocumentDOM () .addNewLine ({x:216.7, y:122.3}, {x:366.8, y:165.8});

document.addNewOval()

Availability
Flash MX 2004.

Usage
document .addNewOval (boundingRectangle [, bSuppressFill [, bSuppressStroke ]1)

Parameters
boundingRectangle A rectangle that specifies the bounds of the oval to be added. For information on the format of
boundﬂ@RedanﬂaSeedocument.addNewRectangle(L

bSuppressFill A Boolean value that, if set to true, causes the method to create the shape without a fill. The default
value is false. This parameter is optional.

bSuppressStroke A Boolean value that, if set to true, causes the method to create the shape without a stroke. The
default value is false. This parameter is optional.

Returns
Nothing.

Description

Method; adds a new Oval object in the specified bounding rectangle. This method performs the same operation as the
Oval tool. The method uses the document’s current default stroke and fill attributes and adds the oval on the current
frame and layer. If both bSuppressFill and bSuppressStroke are set to true, the method has no effect.
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Example

The following example adds a new oval within the specified coordinates; it is 164 pixels in width and 178 pixels in
height:

f1l.getDocumentDOM () .addNewOval ({left:72,top:50,right:236,bottom:228}) ;

The following example draws the oval without a fill:

f1l.getDocumentDOM () .addNewOval ({left:72,top:50,right:236,bottom:228}, true);

The following example draws the oval without a stroke:

f1l.getDocumentDOM () .addNewOval ({left:72,top:50,right:236,bottom:228}, false, true);

See also

document .addNewPrimitiveOval ()

document.addNewPrimitiveOval()

Availability
Flash CS4 Professional.

Usage
document .addNewPrimitiveOval ( boundingRectangle [, bSpupressFill [, bSuppressStroke 1] ))

Parameters
boundingRectangle A rectangle that specifies the bounds within which the new oval primitive is added. For
information on the format of boundingRectangle, see document.addNewRectangle().

bSuppressFill A Boolean value that, if set to true, causes the method to create the oval without a fill. The default
value is false. This parameter is optional.

bSuppressStroke A Boolean value that, if set to true, causes the method to create the oval without a stroke. The
default value is false. This parameter is optional.

Returns
Nothing.

Description

Method; adds a new oval primitive fitting into the specified bounds. This method performs the same operation as the
Oval Primitive tool. The oval primitive uses the document's current default stroke and fill attributes and is added on
the current frame and layer. If both bSuppressFill and bSuppressStroke are set to true, the method has no effect.

Example

The following example adds oval primitives within the specified coordinates, with and without fill and stroke:

// Add an oval primitive with f£ill and stroke

f1.getDocumentDOM () .addNewPrimitiveOval ({left:0,top:0,right:100,bottom:100}) ;

// Add an oval primitive without a £ill
fl.getDocumentDOM().addNewPrimitiveOval({left:100,top:100,right:ZOO,bottom:ZOO}, true) ;

// AAd an oval primitive without a stroke
fl.getDocumentDOM().addNewPrimitiveOval({left:200,top:200,right:300,bottom:300},false,true);
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See also

document .addNewOval ()

document.addNewPrimitiveRectangle()

Availability
Flash CS4 Professional.

Usage
document .addNewPrimitiveRectangle ( boundingRectangle, roundness, [, bSuppressFill [,
bSuppressStroke ]1 ))

Parameters
rect A rectangle that specifies the bounds within which the new rectangle primitive is added. For information on the
format of boundingRectangle, see document.addNewRectangle().

roundness An integer between 0 and 999 that represents the number of points used to specify how much the corners
should be rounded.

bsuppressFill A Boolean value that, if set to true, causes the method to create the rectangle without a fill. The
default value is false. This parameter is optional.

bSuppressstroke A Boolean value that, if set to true, causes the method to create the rectangle without a stroke.
The default value is £alse. This parameter is optional.

Returns
Nothing.

Description

Method; adds a new rectangle primitive fitting into the specified bounds. This method performs the same operation
as the Rectangle Primitive tool. The rectangle primitive uses the document's current default stroke and fill attributes
and is added on the current frame and layer. If both bSuppressFill and bSuppressStroke are set to true, the method has
no effect.

Example
The following example adds rectangle primitives within the specified coordinates, with and without fill and stroke, and
with different amounts of roundness:

// Add a rectangle primitive with £ill and stroke

f1l.getDocumentDOM () .addNewPrimitiveRectangle ({left:0,top:0,right:100,bottom:100}, 0);

// Add a rectangle primitive without a f£ill
fl.getDocumentDOM().addNewPrimitiveRectangle({left:100,top:100,right:ZOO,bottom:ZOO}, 20,
true) ;

// Add a rectangle primitive without a stroke

f1l.getDocumentDOM () .addNewPrimitiveRectangle ({left:200,top:200,right:300,bottom:300},

50, false, true) ;

See also

document . addNewRectangle ()
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document.addNewPublishProfile()

Availability
Flash MX 2004.

Usage
document .addNewPublishProfile ( [profileName])

Parameters
profileName The unique name of the new profile. If you do not specify a name, a default name is provided. This
parameter is optional.

Returns

An integer that is the index of the new profile in the profiles list. Returns -1 if a new profile cannot be created.

Description

Method; adds a new publish profile and makes it the current one.

Example
The following example adds a new publish profile with a default name and then displays the name of the profile in the
Output panel:

f1l.getDocumentDOM () .addNewPublishProfile() ;
fl.outputPanel.trace (fl.getDocumentDOM () .currentPublishProfile) ;

The following example adds a new publish profile with the name "my profile™:

f1l.getDocumentDOM () .addNewPublishProfile ("my profile");

See also
document .deletePublishProfile ()

document.addNewRectangle()

Availability

Flash MX 2004.

Usage

document .addNewRectangle (boundingRectangle, roundness
[, bSuppressFill [, bSuppressStrokel])

Parameters

boundingRectangle A rectangle that specifies the bounds within which the new rectangle is added, in the format
{left:valuel, top:value2, right:value3,bottom:value4}. The left and top values specify the location of the
upper left corner (e.g., Left : 0, top: 0 represents the upper left corner of the Stage) and the right and bot tom values
specify the location of the lower-right corner. Therefore, the width of the rectangle is the difference in value between
left and right, and the height of the rectangle is the difference in value between top and bottom.
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In other words, the rectangle bounds do not all correspond to the values shown in the Property inspector. The 1eft
and top values correspond to the X and Y values in the Property inspector, respectively. However, the right and
bottom values don’t correspond to the W and H values in the Property inspector. For example, consider a rectangle
with the following bounds:

{left:10,top:10,right:50,bottom:100}
This rectangle would display the following values in the Property inspector:
X =10, Y = 10, W = 40, H = 90

roundness An integer value from 0 to 999 that specifies the roundness to use for the corners. The value is specified
as number of points. The greater the value, the greater the roundness.

bSuppressFill A Boolean value that, if set to true, causes the method to create the shape without a fill. The default
value is false. This parameter is optional.

bSuppressStroke A Boolean value that, if set to true, causes the method to create the rectangle without a stroke.
The default value is £alse. This parameter is optional.

Returns
Nothing.

Description

Method; adds a new rectangle or rounded rectangle, fitting it into the specified bounds. This method performs the
same operation as the Rectangle tool. The method uses the document’s current default stroke and fill attributes and
adds the rectangle on the current frame and layer. If both bSuppressFill and bSuppressStroke are set to t rue, the method
has no effect.

Example
The following example adds a new rectangle with no rounding on the corners within the specified coordinates; it is 100
pixels in width and in height:

f1.getDocumentDOM () .addNewRectangle ({left:0,top:0,right:100,bottom:100},0) ;

The following example adds a new rectangle with no rounding on the corners and without a fill; it is 100 pixels in width
and 200 in height:

f1.getDocumentDOM () .addNewRectangle ({left:10,top:10,right:110,bottom:210},0, true);

The following example adds a new rectangle with no rounding on the corners and without a stroke; it is 200 pixels in
width and 100 in height:

f1.getDocumentDOM () .addNewRectangle ({left:20,top:20,right:220,bottom:120},0, false, true);

See also

document .addNewPrimitiveRectangle ()

document.addNewScene()

Availability
Flash MX 2004.
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Usage

document . addNewScene ( [name] )

Parameters
name Specifies the name of the scene. If you do not specify a name, a new scene name is generated.

Returns

A Boolean value: true if the scene is added successfully; false otherwise.

Description

Method; adds a new scene (Timeline object) as the next scene after the currently selected scene and makes the new
scene the currently selected scene. If the specified scene name already exists, the scene is not added and the method
returns an error.

Example
The following example adds a new scene named myScene after the current scene in the current document. The variable
success will be true when the new scene is created; false otherwise.

var success = fl.getDocumentDOM () .addNewScene ("myScene") ;

The following example adds a new scene using the default naming convention. If only one scene exists, the newly
created scene is named "Scene 2".

f1l.getDocumentDOM () .addNewScene () ;

document.addNewText()

Availability
Flash MX 2004; optional text parameter added in Flash CS3 Professional.

Usage
document .addNewText (boundingRectangle [, text 1)

Parameters
boundingRectangle Specifies the size and location of the text field. For information on the format of
houndingRectangle, see document . addNewRectangle ().

text An optional string that specifies the text to place in the field. If you omit this parameter, the selection in the Tools
panel switches to the Text tool. Therefore, if you don’t want the selected tool to change, pass a value for text.

Returns
Nothing.

Description

Method; inserts a new text field and optionally places text into the field. If you omit the text parameter, you can call
document . setTextString () to populate the text field.
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Example
The following example creates a new text field in the upper left corner of the Stage and sets the text string to "Hello
World":

fl.getDocumentDOM().addNewText({left:O, top:0, right:100, bottom:lOO} , "Hello World!" );

f1l.getDocumentDOM () .setTextString ('Hello World!');

See also

document .setTextString ()

document.align()

Availability
Flash MX 2004.

Usage

document .align(alignmode [, bUseDocumentBounds])

Parameters
alignmode A string that specifies how to align the selection. Acceptable values are "left", "right", "top",

"bottom", "vertical center",and "horizontal center"

bUseDocumentBounds A Boolean value that, if set to true, causes the method to align to the bounds of the document.
Otherwise, the method uses the bounds of the selected objects. The default is false. This parameter is optional.

Returns
Nothing.

Description
Method; aligns the selection.

Example

The following example aligns objects to the left and to the Stage. This is equivalent to turning on the To Stage setting
in the Align panel and clicking the Align to Left button:

fl.getDocumentDOM () .align("left", true);

See also

document .distribute (), document .getAlignToDocument (), document .setAlignToDocument ()

document.allowScreens() - dropped

Availability
Flash MX 2004. Dropped in Flash Professional CC.
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Usage

document .allowScreens ()

Parameters

None.

Returns
A Boolean value: true if document . screenoutline can be used safely; false otherwise.

Description
Dropped in Flash Professional CC.

Example
The following example determines whether screens methods can be used in the current document:

if (f1.getDocumentDOM () .allowScreens ()) {
fl.trace("screen outline is available.");

}

else {
fl.trace ("whoops, no screens.");

}

See also

document .screenOutline - dropped

document.arrange()

Availability
Flash MX 2004.

Usage

document . arrange (arrangeMode)

Parameters
arrangeMode Specifies the direction in which to move the selection. Acceptable values are "back", "backward",

"forward", and "front". It provides the same capabilities as these options provide on the Modify > Arrange menu.

Returns
Nothing.

Description
Method; arranges the selection on the Stage. This method applies only to non-shape objects.

Example
The following example moves the current selection to the front:

f1l.getDocumentDOM () .arrange ("front") ;
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document.as3AutoDeclare

Availability
Flash CS3 Professional.

Usage

document .as3AutoDeclare

Description
Property; a Boolean value that describes whether the instances placed on the Stage are automatically added to user-
defined timeline classes. The default value is true.

Example
The following example specifies that instances placed on the Stage in the current document must be manually added
to user-defined timeline classes.

fl.getDocumentDOM () .as3AutoDeclare=false;

document.as3Dialect

Availability
Flash CS3 Professional.

Usage

document.as3Dialect
Description
Property; a string that describes the ActionScript 3.0 “dialect” being used in the specified document. The default value

is "as3 . If you wish to allow prototype classes, as permitted in earlier ECMAScript specifications, set this value to "ES™.

Example
The following example specifies that the dialect being used in the current document is ECMAScript:

fl.getDocumentDOM () .as3Dialect="ES";

See also

document .asVersion

document.as3ExportFrame

Availability
Flash CS3 Professional.

Usage

document . as3ExportFrame
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Description
Property; an integer that specifies in which frame to export ActionScript 3.0 classes. By default, classes are exported in
Frame 1.

Example

The following example changes the frame in which classes are exported from 1 (the default) to 5.

var myDocument = fl.getDocumentDOM () ;

fl.outputPanel.trace (" 'Export classes in frame:' value before modification is " +
myDocument . as3ExportFrame) ;

myDocument .as3ExportFrame = 5;

fl.outputPanel.trace (" 'Export classes in frame:' value after modification is " +
myDocument .as3ExportFrame) ;

document.as3StrictMode

Availability
Flash CS3 Professional.

Usage

document .as3StrictMode

Description

Property; a Boolean value that specifies whether the ActionScript 3.0 compiler should compile with the Strict Mode
option turned on (true) or off (false). Strict Mode causes warnings to be reported as errors, which means that
compilation will not succeed if those errors exist. The default value is true.

Example
The following example turns off the Strict Mode compiler option.

var myDocument = fl.getDocumentDOM () ;

fl.outputPanel.trace("Strict Mode value before modification is " + myDocument.as3StrictMode) ;
myDocument .as3StrictMode = false;

fl.outputPanel.trace ("Strict Mode value after modification is " + myDocument.as3StrictMode) ;

See also

document . as3WarningsMode

document.as3WarningsMode

Availability
Flash CS3 Professional.

Usage

document .as3WarningsMode
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Description

Property; a Boolean value that specifies whether the ActionScript 3.0 compiler should compile with the Warnings
Mode option turned on (true) or off (false). Warnings Mode causes extra warnings to be reported that are useful for
discovering incompatibilities when updating ActionScript 2.0 code to ActionScript 3.0. The default value is true.

Example

The following example turns off the Warnings Mode compiler option.

var myDocument = fl.getDocumentDOM () ;

fl.outputPanel.trace ("Warnings Mode value before modification is " +
myDocument . as3WarningsMode) ;

myDocument .as3WarningsMode = false;

fl.outputPanel.trace ("Warnings Mode value after modification is " +
myDocument . as3WarningsMode) ;

See also

document .as3StrictMode

document.asVersion

Availability
Flash CS3 Professional.

Usage

document .asVersion

Description
Property; an integer that specifies which version of ActionScript is being used in the specified document. Acceptable
values are 1, 2, and 3.

To determine the targeted player version for the specified document, use document . getPlayerVersion (); this
method returns a string, so it can be used by Flash® Lite™ players.

Example
The following example sets the version of ActionScript in the current document to ActionScript 2.0 if it is currently
set as ActionScript 1.0.

if (f1.getDocumentDOM () .asVersion ==

I

1
f1l.getDocumentDOM () .asVersion = 2;

See also

document .as3Dialect, document .getPlayerVersion ()
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document.autolLabel

Availability
Flash MX 2004.

Usage

document .autoLabel

Description
Property; a Boolean value that is equivalent to the Auto Label check box in the Accessibility panel. You can use this
property to tell Flash to automatically label objects on the Stage with the text associated with them.

Example
The following example gets the value of the autoLabel property and displays the result in the Output panel:

var isAutoLabel = fl.getDocumentDOM /() .autoLabel;
fl.trace (isAutoLabel) ;

The following example sets the autoLabel property to true, telling Flash to automatically label objects on the Stage:

fl.getDocumentDOM () .autoLabel = true;

document.backgroundColor

Availability
Flash MX 2004.

Usage

document . backgroundColor

Description
Property; the color of the background, in one of the following formats:

+ A string in the format "#RRGGBB" or "#RRGGBBAA"
« A hexadecimal number in the format 0xRRGGBB

+ An integer that represents the decimal equivalent of a hexadecimal number

Example
The following example sets the background color to black:

f1.getDocumentDOM () .backgroundColor = '#000000';

document.breakApart()

Availability
Flash MX 2004.
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Usage
document .breakApart ()

Parameters

None.

Returns
Nothing.

Description
Method; performs a break-apart operation on the current selection.

Example
The following example breaks apart the current selection:

f1l.getDocumentDOM () .breakApart () ;

document.canEditSymbol()

Availability
Flash MX 2004.

Usage
document .canEditSymbol ()

Parameters
None.

Returns
A Boolean value: true if the Edit Symbols menu and functionality are available for use; false otherwise.

Description

Method; indicates whether the Edit Symbols menu and functionality are enabled. This is not related to whether the
selection can be edited. This method should not be used to test whether £1 .getDocumentDOM () .enterEditMode ()
is allowed.

Example
The following example displays in the Output panel the state of the Edit Symbols menu and functionality:

fl.trace("fl.getDocumentDOM () .canEditSymbol () returns: " +
f1l.getDocumentDOM () .canEditSymbol ()) ;

document.canRevert()

Availability
Flash MX 2004.
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Usage

document . canRevert ()

Parameters

None.

Returns
A Boolean value: true if you can use the document . revert () or £1.revertDocument () methods successfully;
false otherwise.

Description
Method; determines whether you can use the document . revert () or £1.revertDocument () method successfully.

Example
The following example checks whether the current document can revert to the previously saved version. If so,
£1.getDocumentDOM () . revert () restores the previously saved version.

if (f1.getDocumentDOM () .canRevert ()) {
f1l.getDocumentDOM () .revert () ;

document.canTestMovie()

Availability
Flash MX 2004.

Usage

document .canTestMovie ()

Parameters
None.

Returns

A Boolean value: true if you can use the document . testMovie () method successfully: false otherwise.

Description
Method; determines whether you can use the document . testMovie () method successfully.

Example
The following example tests whether £1.getDocumentDOM() . testMovie () can be used. If so, it calls the method.

if (f1.getDocumentDOM () .canTestMovie () ) {
f1l.getDocumentDOM () .testMovie () ;

See also

document .canTestScene (), document . testScene ()
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document.canTestScene()

Availability
Flash MX 2004.

Usage

document .canTestScene ()

Parameters
None.

Returns
A Boolean value: true if you can use the document . testScene () method successfully; false otherwise.

Description
Method; determines whether you can use the document . testScene () method successfully.

Example
The following example first tests whether fl.getDocumentDOMY().testScene() can be used successfully. If so, it calls the
method.

if (f1.getDocumentDOM () .canTestScene () ) {
f1l.getDocumentDOM () .testScene () ;

}

See also

document .canTestMovie (), document . testMovie ()

document.changeFilterOrder()

Availability
Flash 8.

Usage

document .changeFilterOrder (oldIndex, newlIndex)

Parameters
oldIndex An integer that represents the current zero-based index position of the filter you want to reposition in the
Filters list.

newIndex An integer that represents the new index position of the filter in the list.

Returns
Nothing.

Last updated 12/6/2013

95



EXTENDING FLASH PROFESSIONAL 96
Document object

Description

Method; changes the index of the filter in the Filters list. Any filters above or below newlIndex are shifted up or down
accordingly. For example, using the filters shown below, if you issue the command
fl.getDocumentDOM().changeFilterOrder (3, 0), the filters are rearranged as follows:

Before After

blurFilterdropShadowFilterglowFiltergradien |[gradientBevelFilterblurFilterdropShadowFilterglo
tBevelFilter wFilter

If you then issue the command fl.getDocumentDOM().changeFilterOrder (0, 2), the filters are rearranged as follows:

Before After

gradientBevelFilterblurFilterdropShadowFilt [blurFilterdropShadowFiltergradientBevelFilterglo
erglowFilter wFilter

Example

The following example moves the filter that is currently in the second position in the Filters list to the first position:

f1l.getDocumentDOM () .changeFilterOrder(1,0) ;

See also
document .addFilter (), document .disableFilter (), document.enableFilter (), document.getFilters(),

document . removeFilter (), Filter object

document.clipCopy()

Availability
Flash MX 2004.

Usage
document .clipCopy ()

Parameters
None.

Returns
Nothing.

Description
Method; copies the current selection from the document to the Clipboard.

To copy a string to the Clipboard, use £1.clipCopyString ().

Example
The following example copies the current selection from the document to the Clipboard:

f1l.getDocumentDOM () .clipCopy () ;
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See also

document .clipCut (), document .clipPaste ()

document.clipCut()

Availability
Flash MX 2004.

Usage

document .clipCut ()

Parameters
None.

Returns
Nothing.

Description
Method; cuts the current selection from the document and writes it to the Clipboard.

Example
The following example cuts the current selection from the document and writes it to the Clipboard:

f1l.getDocumentDOM () .clipCut () ;

See also
document .clipCopy (), document.clipPaste (), f1.clipCopyString()

document.clipPaste()

Availability
Flash MX 2004.

Usage

document .clipPaste ( [bInPlace])

Parameters

bInPlace A Boolean value that, when set to true, causes the method to perform a paste-in-place operation. The
default value is false, which causes the method to perform a paste operation to the center of the document. This
parameter is optional.

Returns
Nothing.
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Description
Method; pastes the contents of the Clipboard into the document.

Example
The following example pastes the Clipboard contents to the center of the document:

f1l.getDocumentDOM () .clipPaste () ;
The following example pastes the Clipboard contents in place in the current document:

fl.getDocumentDOM () .clipPaste (true) ;

See also
document .clipCopy (), document.clipCut (), £1.clipCopyString ()

document.close()

Availability
Flash MX 2004.

Usage

document .close ( [bPromptToSaveChanges] )

Parameters

bPromptToSaveChanges A Boolean value that, when set to true, causes the method to prompt the user with a dialog
box if there are unsaved changes in the document. If bPromptToSaveChanges is set to £alse, the user is not prompted
to save any changed documents. The default value is true. This parameter is optional.

Returns
Nothing.

Description
Method; closes the specified document.

Example
The following example closes the current document and prompts the user with a dialog box to save changes:

fl.getDocumentDOM () .close () ;
The following example closes the current document without saving changes:

f1l.getDocumentDOM () .close (false) ;

document.convertLinesToFills()

Availability
Flash MX 2004.
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Usage
document .convertLinesToFills ()

Parameters

None.

Returns
Nothing.

Description
Method; converts lines to fills on the selected objects.

Example
The following example converts the current selected lines to fills:

f1l.getDocumentDOM () .convertLinesToFills () ;

document.convertSelectionToBitmap()

Availability
Flash Professional CC.

Usage

document .convertSelectionToBitmap ()

Parameters
None

Returns
Boolean.

Description

Method; converts selected objects in the current frame to a bitmap and inserts the bitmap into the library.

Example
The following example illustrates use of this method:

f1l.getDocumentDOM () .convertSelectionToBitmap () ;

document.convertToSymbol()

Availability
Flash MX 2004.
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Usage

document . convertToSymbol (type, name, registrationPoint)

Parameters
type A string that specifies the type of symbol to create. Acceptable values are "movie clip", "button", and
"graphic".

name A string that specifies the name for the new symbol, which must be unique. You can submit an empty string to
have this method create a unique symbol name for you.

registration point Specifies the point that represents the 0,0 location for the symbol. Acceptable values are: "top
left", "top center", "top right", "center left", "center", "center right", "bottom left", "bottom

center", and "bottom right".

Returns

An object for the newly created symbol, or nul1 if it cannot create the symbol.

Description
Method; converts the selected Stage item(s) to a new symbol. For information on defining linkage and shared asset
properties for a symbol, see Item object.

Example
The following examples create a movie clip symbol with a specified name, a button symbol with a specified name, and
a movie clip symbol with a default name:

newMc = fl.getDocumentDOM () .convertToSymbol ("movie clip", "mcSymbolName", "top left");
newButton = fl.getDocumentDOM () .convertToSymbol ("button", "btnSymbolName", "bottom right") ;
newClipWithDefaultName = fl.getDocumentDOM () .convertToSymbol ("movie clip", "", "top left");

document.cropl)

Availability
Flash 8.

Usage

document .crop ()

Parameters
None.

Returns
None.

Description

Method; uses the top selected drawing object to crop all selected drawing objects underneath it. If no objects are
selected, calling this method results in an error and the script breaks at that point.
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Example
The following example crops the currently selected objects:

f1l.getDocumentDOM () .crop () ;

See also
document .deleteEnvelope (), document . intersect (), document . punch (), document .union (),

shape.isDrawingObject

document.currentPublishProfile

Availability
Flash MX 2004.

Usage

document .currentPublishProfile

Description
Property; a string that specifies the name of the active publish profile for the specified document.

Example
The following example adds a new publish profile with the default name and then displays the name of the profile in
the Output panel:

f1l.getDocumentDOM () .addNewPublishProfile() ;
fl.outputPanel.trace (fl.getDocumentDOM () .currentPublishProfile) ;

The following example changes the selected publish profile to "Default":

f1l.getDocumentDOM () .currentPublishProfile = "Default";

document.currentTimeline

Availability
Flash MX 2004.

Usage

document .currentTimeline

Description

Property; an integer that specifies the index of the active timeline. You can set the active timeline by changing the value
of this property; the effect is almost equivalent to calling document . editScene (). The only difference is that you
don’t get an error message if the index of the timeline is not valid; the property is simply not set, which causes silent
failure.

Example
The following example displays the index of the current timeline:
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var myCurrentTL = fl.getDocumentDOM () .currentTimeline;
fl.trace("The index of the current timeline is: "+ myCurrentTL) ;

The following example changes the active timeline from the main timeline to a scene named "myScene":

var i = 0;
var curTimelines = fl.getDocumentDOM() .timelines;
while (i < fl.getDocumentDOM() .timelines.length) {

if (curTimelines[i] .name == "myScene") {
f1l.getDocumentDOM () .currentTimeline = i;
++1;
See also

document .getTimeline ()

document.debugMovie()

Availability
Flash Professional CS5.

Usage

document .DebugMovie ( [Boolean abortIfErrorsExist])

Description

Method; Invokes the Debug Movie command on the document.

Parameters

abortIfErrorsExist Boolean; the default value is false. If set to true, the debug session will not start and the .swf

window will not open if there are compiler errors. Compiler warnings will not abort the command.

Example

The following example opens the current document in debug mode, but aborts the operation if compiler errors exist:

f1.getDocumentDOM () .debugMovie (1) ;

document.deleteEnvelope()

Availability
Flash 8.

Usage

document .deleteEnvelope ()

Parameters

None.
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Returns
None.

Description
Method; deletes the envelope (bounding box that contains one or more objects) from the selected objects. If no objects
are selected, calling this method results in an error and the script breaks at that point.

Example

The following example deletes the envelope from the selected objects:

fl.getDocumentDOM () .deleteEnvelope () ;

See also

document .crop (), document . intersect (), document . punch (), document .union (), shape.isDrawingObject

document.deletePublishProfile()

Availability
Flash MX 2004.

Usage
document .deletePublishProfile ()

Parameters
None.

Returns
An integer that is the index of the new current profile. If a new profile is not available, the method leaves the current
profile unchanged and returns its index.

Description
Method; deletes the currently active profile, if there is more than one. There must be at least one profile left.

Example
The following example deletes the currently active profile, if there is more than one, and displays the index of the new
currently active profile:

alert (f1.getDocumentDOM () .deletePublishProfile()) ;

See also
document .addNewPublishProfile ()
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document.deleteScene()

Availability
Flash MX 2004.

Usage

document .deleteScene ()

Parameters
None.

Returns

A Boolean value: true if the scene is successfully deleted; £alse otherwise.

Description

Method; deletes the current scene (Timeline object) and, if the deleted scene was not the last one, sets the next scene
as the current Timeline object. If the deleted scene was the last one, it sets the first object as the current Timeline object.
If only one Timeline object (scene) exists, it returns the value false.

Example
Assuming there are three scenes (Scene0, Scene1, and Scene2) in the current document, the following example
makes Scene2 the current scene and then deletes it:

f1l.getDocumentDOM () .editScene (2) ;
var success = fl.getDocumentDOM () .deleteScene() ;

document.deleteSelection()

Availability
Flash MX 2004.

Usage

document .deleteSelection ()

Parameters
None.

Returns
Nothing.

Description

Method; deletes the current selection on the Stage. Displays an error message if there is no selection.

Example
The following example deletes the current selection in the document:

f1l.getDocumentDOM () .deleteSelection() ;
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document.description

Availability
Flash MX 2004.

Usage

document .description

Description
Property; a string that is equivalent to the Description field in the Accessibility panel. The description is read by the
screen reader.

Example

The following example sets the description of the document:
fl.getDocumentDOM () .description= "This is the main movie";
The following example gets the description of the document and displays it in the Output panel:

fl.trace (fl.getDocumentDOM () .description) ;

document.disableAllFilters()

Availability
Flash 8.

Usage
document .disableAllFilters ()

Parameters
None.

Returns
Nothing.

Description
Method; disables all filters on the selected objects.

Example
The following example disables all filters on the selected objects:

fl.getDocumentDOM () .disableAllFilters() ;

See also
document .addFilter (), document .changeFilterOrder (), document.disableFilter(),
document .disableOtherFilters (), document .enableAllFilters (), document.getFilters (),

document . removeAllFilters (), Filter object

Last updated 12/6/2013



EXTENDING FLASH PROFESSIONAL 106
Document object

document.disableFilter()

Availability
Flash 8.

Usage

document .disableFilter (filterIndex)

Parameters
filterIndex An integer representing the zero-based index of the filter in the Filters list.

Returns
Nothing.

Description
Method; disables the specified filter in the Filters list.

Example
The following example disables the first and third filters (index values of 0 and 2) in the Filters list from the selected
objects:

f1l.getDocumentDOM () .disableFilter (0) ;
fl.getDocumentDOM () .disableFilter (2) ;

See also
document .addFilter (), document .changeFilterOrder (), document.disableAllFilters(),
document .disableOtherFilters (), document.enableFilter (), document.getFilters(),

document.removeFilter(),Iﬁherobﬁct

document.disableOtherFilters()

Availability
Flash 8.

Usage
document .disableOtherFilters (enabledFilterIndex)

Parameters
enabledFilterIndex An integer representing the zero-based index of the filter that should remain enabled after

other filters are disabled.

Returns
Nothing.

Description
Method; disables all filters except the one at the specified position in the Filters list.
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Example
The following example disables all filters except the second filter in the list (index value of 1):

fl.getDocumentDom() .disableOtherFilters (1) ;

See also
document .addFilter (), document .changeFilterOrder (), document.disableAllFilters(),
document .disableFilter (), document.enableFilter (), document.getFilters(),

document.removeFilter(),Fiher(ﬂject

document.distribute()

Availability
Flash MX 2004.

Usage

document .distribute (distributemode [, bUseDocumentBounds])

Parameters
distributemode A string that specifies where to distribute the selected objects. Acceptable values are "1eft edge",

"horizontal center", "right edge", "top edge", "vertical center", and "bottom edge".

bUseDocumentBounds A Boolean value that, when set to true, distributes the selected objects using the bounds of the
document. Otherwise, the method uses the bounds of the selected objects. The default is false.

Returns
Nothing.

Description
Method; distributes the selection.

Example
The following example distributes the selected objects by their top edges:

f1l.getDocumentDOM () .distribute ("top edge") ;

The following example distributes the selected objects by their top edges and expressly sets the bUseDcoumentBounds
parameter:

fl.getDocumentDOM () .distribute ("top edge", false);
The following example distributes the selected objects by their top edges, using the bounds of the document:

f1l.getDocumentDOM () .distribute ("top edge", true);

See also

document .getAlignToDocument (), document .setAlignToDocument ()

Last updated 12/6/2013



EXTENDING FLASH PROFESSIONAL 108
Document object

document.distributeToKeyframes()

Availability
Flash Professional CC.

Usage

document .distributeToKeyframes ()

Parameters
None.

Returns
Nothing.

Description

Method; performs a distribute-to-keyframes operation on the current selection—equivalent to selecting Distribute to
KeyFrames. A new keyframe is created for every object. New keyframes are created on the active layer immediately
after the active frame

Example
The following example distributes the current selection to keyframes:

if (£1.getDocumentDOM () .canDistributeToKeyframes())
fl.getDocumentDOM () .distributeToKeyframes () ;

document.distributeTolLayers()

Availability
Flash MX 2004.

Usage

document .distributeToLayers ()

Parameters
None.

Returns
Nothing.

Description
Method; performs a distribute-to-layers operation on the current selection—equivalent to selecting Distribute to
Layers. This method displays an error if there is no selection.

Example
The following example distributes the current selection to layers:

f1l.getDocumentDOM () .distributeToLayers () ;

Last updated 12/6/2013



EXTENDING FLASH PROFESSIONAL 109
Document object

document.docClass

Availability
Flash CS3 Professional.

Usage

document .docClass

Description
Property; a string that specifies the top-level ActionScript 3.0 class associated with the document. If the document isn’t
configured to use ActionScript 3.0, this property is ignored.

Example
The following example specifies that the ActionScript 3.0 class associated with the document is
com.mycompany.ManagerClass, which is defined in com/mycompany/ManagerClass.as:

var myDocument = fl.getDocumentDOM () ;
// set the property
myDocument .docClass = "com.mycompany.ManagerClass";

// get the property
fl.outputPanel.trace ("document.docClass has been set to " + myDocument.docClass) ;

See also

item.linkageBaseClass

document.documentHasData()

Availability
Flash MX 2004.

Usage

document . documentHasData (name)

Parameters
name A string that specifies the name of the data to check.

Returns

A Boolean value: true if the document has persistent data; false otherwise.

Description

Method; checks the document for persistent data with the specified name.

Example
The following example checks the document for persistent data with the name "myData":

var hasData = fl.getDocumentDOM () .documentHasData ("myData") ;
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See also
document .addDataToDocument (), document .getDataFromDocument (),

document . removeDataFromDocument ()

document.duplicatePublishProfile()

Availability
Flash MX 2004.

Usage

document .duplicatePublishProfile ( [profileName])

Parameters
profileName A string that specifies the unique name of the duplicated profile. If you do not specify a name, the
method uses the default name. This parameter is optional.

Returns
An integer that is the index of the new profile in the profile list. Returns -1 if the profile cannot be duplicated.

Description
Method; duplicates the currently active profile and gives the duplicate version focus.

Example
The following example duplicates the currently active profile and displays the index of the new profile in the Output
panel:

fl.trace (f1l.getDocumentDOM () .duplicatePublishProfile ("dup profile")) ;

document.duplicateScene()

Availability
Flash MX 2004.

Usage

document .duplicateScene ()

Parameters
None.

Returns
A Boolean value: true if the scene is duplicated successfully; false otherwise.

Description

Method; makes a copy of the currently selected scene, giving the new scene a unique name and making it the current
scene.
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Example
The following example duplicates the second scene in the current document:

f1l.getDocumentDOM () .editScene (1)

; //Set the middle scene to current scene.
var success = fl.getDocumentDOM () .duplicateScene() ;

document.duplicateSelection()

Availability
Flash MX 2004.

Usage

document .duplicateSelection ()

Parameters

None.

Returns
Nothing.

Description
Method; duplicates the selection on the Stage.

Example

The following example duplicates the current selection, which is similar to Alt-clicking and then dragging an item:

fl.getDocumentDOM () .duplicateSelection() ;

document.editScene()

Availability
Flash MX 2004.

Usage

document .editScene (index)

Parameters
index A zero-based integer that specifies which scene to edit.

Returns
Nothing.

Description

Method; makes the specified scene the currently selected scene for editing.
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Example
Assuming that there are three scenes (Scene0, Scenel, and scene2) in the current document, the following example
makes Scene2 the current scene and then deletes it:

f1l.getDocumentDOM () .editScene (2) ;
f1l.getDocumentDOM () .deleteScene () ;

document.enableAllFilters|()

Availability
Flash 8.

Usage

document .enableAllFilters ()

Parameters

None.

Returns
Nothing.

Description
Method; enables all the filters on the Filters list for the selected objects.

Example

The following example enables all the filters on the Filters list for the selected objects:

fl.getDocumentDOM () .enableAllFilters() ;
See also

document .addFilter (), document .changeFilterOrder (), document .disableAllFilters(),

document.enableFilter(),document.getFilters(),document.removeAllFilters(),Fﬂwrobﬁct

document.enableFilter()

Availability
Flash 8.

Usage

document .enableFilter (filterIndex)

Parameters
filterIndex An integer specifying the zero-based index of the filter in the Filters list to enable.

Returns
Nothing.
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Description
Method; enables the specified filter for the selected objects.

Example
The following example enables the second filter of the selected objects:

f1l.getDocumentDOM () .enableFilter (1) ;

See also
document .addFilter (), document .changeFilterOrder (), document.disableFilter(),

document . enableAllFilters (), document .getFilters (), document .removeFilter (), Filter object

document.enterEditMode()

Availability
Flash MX 2004.

Usage
document .enterEditMode ( [editModel])

Parameters
editMode A string that specifies the editing mode. Acceptable values are "inPlace" or "newWindow". If no
parameter is specified, the default is symbol-editing mode. This parameter is optional.

Returns
Nothing.

Description

Method; switches the authoring tool into the editing mode specified by the parameter. If no parameter is specified, the
method defaults to symbol-editing mode, which has the same result as right-clicking the symbol to invoke the context
menu and selecting Edit.

Example

The following example puts Flash in edit-in-place mode for the currently selected symbol:
fl.getDocumentDOM () .enterEditMode ('inPlace') ;
The following example puts Flash in edit-in-new-window mode for the currently selected symbol:

fl.getDocumentDOM () .enterEditMode ('newWindow') ;

See also

document .exitEditMode ()
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document.exitEditMode()

Availability
Flash MX 2004.

Usage
document .exitEditMode ()

Parameters
None.

Returns
Nothing.

Description

Method; exits from symbol-editing mode and returns focus to the next level up from the editing mode. For example,
if you are editing a symbol inside another symbol, this method takes you up a level from the symbol you are editing,
into the parent symbol.

Example
The following example exits symbol-editing mode:

f1l.getDocumentDOM () .exitEditMode () ;

See also

document .enterEditMode ()

document.exportinstanceToLibrary()

Availability
Flash CSé.

Usage

document .exportInstanceToLibrary (frameNumber, bitmapName)

Parameters
frameNumber Integer indicating the frame to be exported.

bitmapName A string representing the name of the bitmap to be added to the Library.

Returns
Nothing.

Description
Method; Exports a selected instance of a movie clip, graphic, or button symbol on the Stage to a bitmap in Library.
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Example
The following example exports the selected item on frame 1 to the library and assigns the new bitmap the name
“myTestBitmap”:

f1l.getDocumentDOM () .exportInstanceToLibrary (1, "myTestBitmap") ;

document.exportinstanceToPNGSequence()

Availability
Flash CS6.

Usage

document . export InstanceToPNGSequence (outputURI, startFrameNum, endFrameNum, matrix)

Parameters
outputURI String: The URI to export the PNG Sequence files to. This URI must reference a local file. Example:
file:///c|/tests/mytest.png.

startFrameNum Optional. An integer indicating the first frame to be exported. The default is 1.
endFrameNum Optional. An Integer indicating the last frame to be exported. The default is 99999.

matrix Optional. A matrix to be appended to the exported PNG sequence.

Returns
Nothing.

Description
Method; Exports a selected instance of a movie clip, graphic, or button symbol on the Stage to a series of PNG files on
disk. If no start FrameNum or endFrameNum is given, the output includes all frames in the Timeline.

Example
The following example exports the entire Timeline to a numbered PNG sequence starting with the file name
“myTest.png”:

fl.getDocumentDOM () .exportInstanceToPNGSequence ("file:///c|/tests/mytest.png") ;

document.exportPNG()

Availability
Flash 8.

Usage
document .exportPNG ( [£i1eURI [, bCurrentPNGSettings [, bCurrentFrame]ll])

Parameters

fileURI A string, expressed as a file:/// URI, that specifies the filename for the exported file. If fileURI is an empty
string or is not specified, Flash displays the Export Movie dialog box.
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bCurrentPNGSettings A Boolean value that specifies whether to use the current PNG publish settings (true) or to
display the Export PNG dialog box (false). This parameter is optional. The default value is false.

bCcurrentFrame A Boolean value that specifies whether to export only the current frame (true) or to export all
frames, with each frame as a separate PNG file (false). This parameter is optional. The default value is false.

Returns
A Boolean value of true if the file is successfully exported as a PNG file; £alse otherwise.

Description
Method; exports the document as one or more PNG files. If fileURI is specified and the file already exists, it is
overwritten without warning.

Note: If £i1eURT is empty and bCurrentFrame is true , the Export Movie dialog box does not display and Flash saves
the exported PNG file in the same location as the .fla file.

Note: If bcurrent PNGSettings is false and bCurrentFrame is true, the Export PNG dialog box does not display and
Flash uses the current PNG publish settings.

Example
The following example exports the current frame in the current document to myFile.png, using the current PNG
publish settings:

fl.getDocumentDOM () .exportPNG ("file:///C|/myProject/myFile.png", true, true);

document.exportPublishProfile()

Availability
Flash MX 2004.

Usage
document . exportPublishProfile (£ileURI)

Parameters
fileURI A string, expressed as a file:/// URI, that specifies the path of the XML file to which the profile is exported.

Returns
Nothing.

Description
Method; exports the currently active profile to an XML file.

Example
The following example exports the currently active profile to the file named profile.xml in the folder /Documents and
Settings/username/Desktop on the C drive:

fl.getDocumentDOM () .exportPublishProfile ('file:///C|/Documents and
Settings/username/Desktop/profile.xml') ;
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See also

document .exportPublishProfileString (), document . importPublishProfile ()

document.exportPublishProfileString()

Availability
Flash CS4 Professional.

Usage

document . exportPublishProfileString( [profileName] )

Parameters
profileName A string that specifies the name of the profile to export to an XML string. This parameter is optional.

Returns
An XML string.

Description
Method: returns a string that specifies, in XML format, the specified profile. If you don’t pass a value for profileName,
the current profile is exported.

Example
The following example stores an XML string that represents the current profile in a variable named profilexML and
then displays it in the Output panel:

var profileXML=fl.getDocumentDOM () .exportPublishProfileString() ;

fl.trace(profileXML) ;

See also

document . exportPublishProfile (), document.importPublishProfileString()

document.exportSWF()

Availability
Flash MX 2004.

Usage
document .exportSWF ( [£i1leURI [, bCurrentSettings]])

Parameters
£ileURI A string, expressed as a file:/// URI, that specifies the name of the exported file. If fileURI is empty or not
specified, Flash displays the Export Movie dialog box. This parameter is optional.

bCurrentSettings A Boolean value that, when set to true, causes Flash to use current SWF publish settings.
Otherwise, Flash displays the Export Flash Player dialog box. The default is £alse. This parameter is optional.
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Returns
Nothing.

Description
Method; exports the document in the Flash SWF format.

Example

The following example exports the document to the specified file location with the current publish settings:

£1.getDocumentDOM () .exportSWF ("file:///C|/Documents and
Settings/joe user/Desktop/qgwerty.swf", true);

The following example displays the Export Movie dialog box and the Export Flash Player dialog box and then exports
the document based on the specified settings:

fl.getDocumentDOM () .exportSWF ("", false) ;

The following example displays the Export Movie dialog box and the Export Flash Player dialog box and then exports
the document based on the specified settings:

fl.getDocumentDOM () .exportSWF () ;

document.exportVideo()

Availability

Flash Professional CC.

Usage

exportVideo( fileURI [, convertInAdobeMediaEncoder] [, transparent] [, stopAtFrame]
[, stopAtFrameOrTime] )

Parameters

fileURI A string, expressed as a file:/// URI, that specifies the fully qualified path to which the video is saved.

convertinAdobeMediaEncoder A boolen value that specifies whether or not to send the recorded video to Adobe

Media Encoder. The default value is t rue, which sends the video to Adobe Media Encoder. This parameter is optional.

transparent A boolean value that specifies whether or not the background should be included in the video. The
default value is false, which includes the movie background in the video. This parameter is optional.

stopAtFrame A boolean value that specifies whether the video should be recorded until it reaches a certain frame or
a specific time. The default value is true, stop when a certain frame is reached. This parameter is optional.

stopAtFrameOrTime If stopAtFrame is true, this is an int specifying the number of frames to record. If
stopAtFrame is false, this is the number of milliseconds to record. The default value is 0 which, if stopAtFrame is
true, will record all the frames in the main timeline. This parameter is optional.

Returns
Nothing.

Description
Method; exports a video from the document and optionally sends it to Adobe Media Encoder to convert the video.
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Example
The following example illustrates the use of this method:

f1l.getDocumentDOM () .exportVideo ("file:///C|/myProject/myVideo.mov") ;

document.externalLibraryPath

Availability
Flash CS4 Professional.

Usage

document .externalLibraryPath

Description

Property; a string that contains a list of items in the document’s ActionScript 3.0 External library path, which specifies
the location of SWC files used as runtime shared libraries. Items in the string are delimited by semi-colons. In the
authoring tool, the items are specified by choosing File > Publish Settings and then choosing ActionScript 3.0 Script
Settings on the Flash tab.

Example
The following example sets the document’s External library path to "." and "../mySWCLibrary":
var myDocument = fl.getDocumentDOM () ;

myDocument .externallLibraryPath = ".;../mySWCLibrary";
fl.trace (myDocument .externalLibraryPath) ;

See also

document .libraryPath, document .sourcePath, fl.externallLibraryPath

document.forceSimple

Availability
Flash MX 2004.

Usage

document . forceSimple

Description

Property; a Boolean value that specifies whether the children of the specified object are accessible. This is equivalent

to the inverse logic of the Make Child Objects Accessible setting in the Accessibility panel. That is, if forcesimple is
true, it is the same as the Make Child Object Accessible option being unchecked. If forcesimple is false, it is the

same as the Make Child Object Accessible option being checked.

Example

The following example sets the areChildrenAccessible variable to the value of the forcesimple property. A value
of false means the children are accessible.
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var areChildrenAccessible = fl.getDocumentDOM () .forceSimple;
The following example sets the forceSimple property to allow the children of the document to be accessible:

fl.getDocumentDOM () . forceSimple = false;

document.frameRate

Availability
Flash MX 2004.

Usage

document . frameRate

Description

Property; a float value that specifies the number of frames displayed per second when the SWF file plays; the default is
12. Setting this property is the same as setting the default frame rate in the Document Properties dialog box (Modify
> Document) in the FLA file.

Example
The following example sets the frame rate to 25.5 frames per second:

fl.getDocumentDOM () .frameRate = 25.5;

document.getAlignToDocument()

Availability
Flash MX 2004.

Usage

document .getAlignToDocument ()

Parameters

None.

Returns
A Boolean value: true if the preference is set to align the objects to the Stage; false otherwise.

Description

Method; identical to retrieving the value of the To Stage button in the Align panel. Gets the preference that can be used
1brdocument.align(),document.distribute(),document.match(),anddocument.space()nuﬁhodsonthe
document.

Example

The following example retrieves the value of the To Stage button in the Align panel. If the return value is t rue, the To
Stage button is active; otherwise, it is not.
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var isAlignToDoc = fl.getDocumentDOM () .getAlignToDocument () ;
fl.getDocumentDOM () .align("left", isAlignToDoc) ;

See also

document . setAlignToDocument ()

document.getBlendMode()

Availability
Flash 8.

Usage
document .getBlendMode ()

Parameters
None.

Returns

A string that specifies the blending mode for the selected objects. If more than one object is selected and they have

different blending modes, the string reflects the blending mode of the object with the highest depth.

Note: The return value is unpredictable if the selection contains objects that don’t support blending modes, or that have

a blending mode value of "normal”.

Description
Method; returns a string that specifies the blending mode for the selected objects.

Example
The following example displays the name of the blending mode in the Output panel:

fl.trace(fl.getDocumentDom() .getBlendMode ()) ;

document.getCustomFill()

Availability
Flash MX 2004.

Usage
document .getCustomFill ( [objectToFill])

Parameters
objectToFill A string that specifies the location of the fill object. The following values are valid:

+ n"toolbar" returns the fill object of the Tools panel and Property inspector.

+ v"selection" returns the fill object of the selection.
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If you omit this parameter, the default value is "selection". If there is no selection, the method returns
undefined. This parameter is optional.

Returns

The Fill object specified by the object ToFill parameter, if successful; otherwise, it returns undefined.

Description
Method; retrieves the fill object of the selected shape or, if specified, of the Tools panel and Property inspector.

Example

The following example gets the fill object of the selection and then changes the selection’s color to white:
var fill = fl.getDocumentDOM () .getCustomFill () ;

fill.color = '#FFFFFF';

fill.style = "solid";
fl.getDocumentDOM () .setCustomFill (£i11) ;

The following example returns the fill object of the Tools panel and Property inspector and then changes the color
swatch to a linear gradient:

var fill = fl.getDocumentDOM () .getCustomFill ("toolbar") ;

fill.style = "linearGradient";
fill.colorArray [ 0x00f££00, 0xff0000, Ox0000ff ];
fill.posArray = 100, 200];

[o,
fl.getDocumentDOM () .setCustomFill ( £i11 );

See also

document .setCustomFill ()

document.getCustomStroke()

Availability
Flash MX 2004.

Usage

document .getCustomStroke ( [locationOfStroke])

Parameters
locationOfStroke A string that specifies the location of the stroke object. The following values are valid:

« n"toolbar", if set, returns the stroke object of the Tools panel and Property inspector.
+ n"selectionn, if set, returns the stroke object of the selection.

If you omit this parameter, it defaults to "selection". If there is no selection, it returns undefined. This
parameter is optional.

Returns

The Stroke object specified by the locationOfStroke parameter, if successful; otherwise, it returns undefined.
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Description
Returns the stroke object of the selected shape or, if specified, of the Tools panel and Property inspector.

Example
The following example returns the current stroke settings of the selection and changes the stroke thickness to 2:
var stroke = fl.getDocumentDOM () .getCustomStroke ("selection") ;

stroke.thickness = 2;
fl.getDocumentDOM () .setCustomStroke (stroke) ;

The following example returns the current stroke settings of the Tools panel and Property inspector and sets the stroke
color to red:

var stroke = fl.getDocumentDOM () .getCustomStroke ("toolbar") ;
stroke.color = "#FF000OQO";
f1l.getDocumentDOM () .setCustomStroke (stroke) ;

See also

document . setCustomStroke ()

document.getDataFromDocument()

Availability
Flash MX 2004.

Usage

document .getDataFromDocument (name)

Parameters
name A string that specifies the name of the data to return.

Returns
The specified data.

Description
Method; retrieves the value of the specified data. The type returned depends on the type of data that was stored.

Example
The following example adds an integer value of 12 to the current document and uses this method to display the value
in the Output panel:

fl.getDocumentDOM () .addDataToDocument ("myData", "integer", 12);
fl.trace (fl.getDocumentDOM () .getDataFromDocument ("myData")) ;

See also

document .addDataToDocument (), document .documentHasData (), document . removeDataFromDocument ()

Last updated 12/6/2013



EXTENDING FLASH PROFESSIONAL 124
Document object

document.getElementProperty()

Availability
Flash MX 2004.

Usage
document .getElementProperty (propertyName)

Parameters
propertyName A string that specifies the name of the Element property for which to retrieve the value.

Returns
The value of the specified property. Returns nu11 if the property is an indeterminate state, as when multiple elements
are selected with different property values. Returns undefined if the property is not a valid property of the selected
element.

Description
Method; gets the specified Element property for the current selection. For a list of acceptable values, see the Property
summary table for the Element object.

Example
The following example gets the name of the Element property for the current selection:
// elementName = the instance name of the selected object.

var elementName = fl.getDocumentDOM () .getElementProperty ("name") ;

See also

document . setElementProperty ()

document.getElementTextAttr()

Availability
Flash MX 2004.

Usage
document .getElementTextAttr (attrName [, startIndex [, endIndex]])

Parameters
attrName A string that specifies the name of the TextAttrs property to be returned. For a list of property names and
expected values, see the Property summary table for the TextAttrs object.

startIndex An integer that specifies the index of first character, with 0 (zero) specifying the first position. This
parameter is optional.

endIndex An integer that specifies the index of last character. This parameter is optional.
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Returns

If one text field is selected, the property is returned if there is only one value used within the text. Returns undefined
if there are several values used inside the text field. If several text fields are selected, and all the text alignment values
are equal, the method returns this value. If several text fields are selected, but all the text alignment values are not equal,
the method returns undefined. If the optional arguments are not passed, these rules apply to the range of text
currently selected or the whole text field if the text is not currently being edited. If only startIndex is passed, the
property of the character to the right of the index is returned, if all the selected Text objects match values. If startIndex
and endIndex are passed, the value returned reflects the entire range of characters from startIndex up to, but not
including, endIndex.

Description

Method; gets a specific Textattrs property of the selected Text objects. Selected objects that are not text fields are
ignored. For alist of property names and expected values, see the Property summary table for the TextAttrs object. See
also document . setElementTextAttr ().

Example
The following example gets the size of the selected text fields:

f1l.getDocumentDOM () .getElementTextAttr ("size") ;
The following example gets the color of the character at index 3 in the selected text fields:
fl.getDocumentDOM () .getElementTextAttr ("fillColor", 3);

The following example gets the font name of the text from index 2 up to, but not including, index 10 of the selected
text fields:

fl.getDocumentDOM () .getElementTextAttr ("face", 2, 10);

document.getFilters()

Availability
Flash 8.

Usage

document .getFilters()

Parameters

None.

Returns
An array that contains a list of filters applied to the currently selected objects.

Description
Method; returns an array that contains the list of filters applied to the currently selected objects. If multiple objects are

selected and they don’t have identical filters, this method returns the list of filters applied to the first selected object.

Example

See document . setFilters ().
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See also

document .addFilter (), document .changeFilterOrder (), document .setFilters (), Filter Object

document.getMetadata()

Availability
Flash 8.

Usage
document .getMetadata ()

Parameters
None.

Returns
A string containing the XML metadata associated with the document or an empty string if there is no metadata.

Description
Method; returns a string containing the XML metadata associated with the document, or an empty string if there is no

metadata.

Example
The following example displays XML metadata from the current document in the Output panel:

fl.trace("XML Metadata is :" + fl.getDocumentDOM () .getMetadata()) ;

See also

document . setMetadata ()

document.getMobileSettings()

Availability
Flash CS3 Professional.

Usage
document .getMobileSettings ()

Parameters
None.

Returns
A string that represents the XML settings for the document. If no value has been set, returns an empty string.

Description
Method; returns the mobile XML settings for the document.
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Example

The following example displays the XML settings string for the current document:

fl.trace (f1l.getDocumentDOM () .getMobileSettings()) ;

//traces a string like the following"<? xml version="1.0" encoding="UTF-16" standalone="no"
?><mobileSettings> <contentType id="standalonePlayer" name="Standalone Player"/>
<testDevices> <testDevice i1d="1170" name="Generic Phone" selected="yes"/> </testDevices>

<outputMsgFiltering info="no" trace="yes" warning="yes"/> <testWindowState height="496"
splitterClosed="No" splitterXPos="400" width="907"/> </mobileSettings>"

See also

document .setMobileSettings ()

document.getPlayerVersion()

Availability
Flash CS3 Professional.

Usage

document .getPlayerVersion ()

Parameters

None.

Returns
A string that represents the Flash Player version specified by using document . setPlayerversion (). If no value has
been set, returns the value specified in the Publish Settings dialog box.

Description
Method; returns a string that represents the targeted player version for the specified document. For a list of values that
ﬂﬂsnkﬁhodcanrehnILSeedocument.setPlayerVersion(L

To determine which version of ActionScript is being targeted in the specified file, use document . asversion.

Example
The following example illustrates targeting specified player versions for the current document and then retrieving
those values:

fl.getDocumentDOM () .setPlayerVersion("6") ;

var version = fl.getDocumentDOM () .getPlayerVersion() ;
fl.trace(version) // displays "6"
f1l.getDocumentDOM () .setPlayerVersion ("FlashPlayerlO") ;
var version = fl.getDocumentDOM () .getPlayerVersion() ;
fl.trace(version) // displays ""FlashPlayerlO""

See also

document .setPlayerVersion ()
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document.getPublishDocumentData()

Availability
Flash Professional CC.

Usage

document .getPublishDocumentData (format)

Parameters
format A string that specifies the publishing format.

Note: _EMBED_SWEF_is a special built-in publishing format for persistent data. If set, the persistent data will be
embedded in the SWF file every time a document is published. The persistent data can then be accessed via ActionScript
with the .metaData property. This requires SWF version 19 (Flash Player 11.6) and above and is only for symbol instances
onstage. Other custom publishing formats may be specified for custom JSFL scripts if this method is called with the same
format.

Returns
Boolean; True if publishing of the specified persistent data is enabled for the specified format in this document.
Otherwise False.

Description
Method; Indicates whether publishing of the specified persistent data is enabled for the specified format in this
document.

Example

The following example illustrates the use of this method:

var doc = fl.getDocumentDOM () ;
// set the data
if (doc) {
// get the first selected element
var elem = fl.getDocumentDOM () .getTimeline () .layers[0].frames[0].elements[0];
if (elem) {
// add persistent data "myAlign" of "left"

elem.setPersistentData( "myAlign", "string", "left" );

// enable publishing of persistent data to SWF for the element
elem.setPublishPersistentData ("myAlign", " EMBED_ SWF_", true);
// enable publishing to SWF for entire document
doc.setPublishDocumentData (" _EMBED SWF ", true);

// example getting data
if (doc && doc.getPublishDocumentData (" EMBED SWF ")) {
// get the first selected element

var elem = fl.getDocumentDOM () .getTimeline () .layers[0].frames[0] .elements[0];
if (elem && elem.hasPersistentData ("myAlign") && elem.getPublishPersistentData ("myAlign",
"_EMBED_SWF_")) {
alert ("elem.metaData.myAlign = '" + elem.getPersistentData("myAlign") + "' will be

embedded in SWF when published.");

}
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See also

document . setPublishDocumentData ()

document.getSelectionRect()

Availability
Flash MX 2004.

Usage

document .getSelectionRect ()

Parameters
None.

Returns
The bounding rectangle of the current selection, or 0 if nothing is selected. For information on the format of the return
Vahw,Seedocument.addNewRectangle(L

Description

Method; gets the bounding rectangle of the current selection. If a selection is non-rectangular, the smallest rectangle
encompassing the entire selection is returned. The rectangle is based on the document space or, when in edit mode,
the registration point (also origin point or zero point) of the symbol being edited.

Example
The following example gets the bounding rectangle for the current selection and then displays its properties:

var newRect = fl.getDocumentDOM () .getSelectionRect () ;
var outputStr = "left: " + newRect.left + " top: " + newRect.top + " right: " + newRect.right
+ " bottom: " + newRect.bottom;

alert (outputStr) ;

See also

document .selection, document .setSelectionRect ()

document.getSWFPathFromProfile()

Availability
Flash Professional CS6.

Usage
document .getSWFPathFromProfile ()

Parameters

None.
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Returns
The full path to the SWF file that is set in the current Publish profile.

Description
Method; gets the path to the SWF file that is set in the current Publish profile.

Example
The following example displays the full path to the SWF file as defined in the Publish profile:

fl.trace("the current Publish Setting's SWF file path is: " +
f1l.getDocumentDOM () .getSWFPathFromProfile()) ;

document.getTelemetryForSwf()

Availability
Flash Professional CC.

Usage

document .getTelemetryForSwf ( )

Parameters
None.

Returns

Returns boolean. Returns true if the “Enable detailed telemetry” checkbox is selected; otherwise false.

Description

Method; Indicates whether if the “Enable detailed telemetry” checkbox is selected in the Publish Settings dialog.

Example
The following example calls get TelemetryFromSwe ():

fl.trace("is detailed telemetry enabled for this doc: " +
f1l.getDocumentDOM () .getTelemetryForSwt ()) ;

document.getTextString()

Availability
Flash MX 2004.

Usage
document .getTextString ([startIndex [, endIndex]])

Parameters
startIndex An integer that is an index of first character to get. This parameter is optional.
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endIndex An integer that is an index of last character to get. This parameter is optional.

Returns

A string that contains the selected text.

Description

Method; gets the currently selected text. If the optional parameters are not passed, the current text selection is used. If
text is not currently opened for editing, the whole text string is returned. If only startIndex is passed, the string starting
at that index and ending at the end of the field is returned. If startIndex and endIndex are passed, the string starting
from startIndex up to, but not including, endIndex is returned.

If there are several text fields selected, the concatenation of all the strings is returned.

Example
The following example gets the string in the selected text fields:

fl.getDocumentDOM () .getTextString() ;

The following example gets the string at character index 5 in the selected text fields:

fl.getDocumentDOM () .getTextString (5) ;

The following example gets the string from character index 2 up to, but not including, character index 10:

f1l.getDocumentDOM () .getTextString (2, 10);

See also

document .setTextString ()

document.getTimeline()

Availability
Flash MX 2004.

Usage

document .getTimeline ()

Parameters

None.

Returns
The current Timeline object.

Description
Method; retrieves the current Timeline object in the document. The current timeline can be the current scene, the

current symbol being edited, or the current screen.

Example

The following example gets the Timeline object and returns the number of frames in the longest layer:
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var longestLayer = fl.getDocumentDOM () .getTimeline () .frameCount;
fl.trace("The longest layer has" + longestLayer + "frames");

The following example enters edit-in-place mode for the selected symbol on the Stage and inserts a frame on the
symbol’s timeline.

fl.getDocumentDOM () .enterEditMode ("inPlace") ;
fl.getDocumentDOM () .getTimeline () .insertFrames () ;

The following example gets the Timeline object and displays its name:

var timeline = fl.getDocumentDOM() .getTimeline () ;
alert (timeline.name) ;

See also

document .currentTimeline, document.timelines, symbolItem.timeline

document.getTransformationPoint()

Availability
Flash MX 2004.

Usage

document .getTransformationPoint ()

Parameters

None.

Returns
A point (for example, {x:10, y:20}, where x and y are floating-point numbers) that specifies the position of the
transformation point (also origin point or zero point) within the selected element’s coordinate system.

Description
Method; gets the location of the transformation point of the current selection. You can use the transformation point
for commutations such as rotate and skew.

Note: Transformation points are relative to different locations, depending on the type of item selected. For more
hﬂbﬂﬂaﬁon,seedocument.setTransformationPoint(L

Example

The following example gets the transformation point for the current selection. The t ranspPoint . x property gives the
x coordinate of the transformation point. The transPoint.y property gives the y coordinate of the transformation
point.

var transPoint = fl.getDocumentDOM () .getTransformationPoint () ;

See also

document .setTransformationPoint (), element .getTransformationbPoint ()
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document.group()

Availability
Flash MX 2004.

Usage

document .group ()

Parameters
None.

Returns
Nothing.

Description
Method; converts the current selection to a group.

Example

The following example converts the objects in the current selection to a group:

f1l.getDocumentDOM () .group () ;

See also

document .unGroup ()

document.height

Availability
Flash MX 2004.

Usage
document .height

Description

Property; an integer that specifies the height of the document (Stage) in pixels.

Example
The following example sets the height of the Stage to 400 pixels:

fl.getDocumentDOM () .height = 400;

See also

document .width
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document.id

Availability
Flash CS3 Professional.

Usage

document . id

Description
Read-only property; a unique integer (assigned automatically) that identifies a document during a Flash session. Use
this property in conjunction with £1. findDocumentDOM () to specify a particular document for an action.

Example

The following example displays the document ID for the current document:

fl.trace("Current doc's internal ID is: " + fl.getDocumentDOM() .id) ;

See also

f1l.findDocumentDOM ()

document.importFile()

Availability

Flash 8. The showDialog and showImporterUI parameters are new in Flash Professional CC.

Usage
document .importFile (£1i1eURI [, importToLibrary [, showDialog [, showImporterUI ]]1])

Parameters
fileURI A string, expressed as a file:/// URI, that specifies the path of the file to import.

importToLibrary A Boolean value that specifies whether to import the file only into the document’s library (true)
or to also place a copy on the Stage (false). The default value is false.

showDialog A Boolean value that specifies whether to display the Import dialog box. Specifying true displays the
import dialog. If you specify false, the function imports the file using specifications set in the Preferences dialog. The
default is true.

showImporterUI A Boolean value that specifies whether to display errors visually (for example, using the Library
Contflict dialog box). The default is false.

Returns
Nothing.

Description

Method; imports a file into a document. This method performs the same operation as the Import To Library or Import
To Stage menu command. To import a publish profile, use document . importPublishProfile ().
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Example

The following example lets the user browse for a file to import onto the Stage:

var dom = fl.getDocumentDOM /() ;
var URI = fl.browseForFileURL("select", "Import File");
dom. importFile (URI) ;

See also
fl.browseForFileURL ()

document.importPublishProfile()

Availability
Flash MX 2004.

Usage
document . importPublishProfile( £ileURI )

Parameters

fileURI A string, expressed as a file:/// URI, that specifies the path of the XML file defining the profile to import.

Returns

An integer that is the index of the imported profile in the profiles list. Returns -1 if the profile cannot be imported.

Description
Method; imports a profile from a file.

Example

The following example imports the profile contained in the profile.xml file and displays its index in the profiles list:

alert (f1l.getDocumentDOM () .importPublishProfile('file:///C|/Documents and

Settings/janeUser/Desktop/profile.xml')) ;

document.importPublishProfileString()

Availability
Flash CS4 Professional.

Usage

document . importPublishProfileString (xmlString)

Parameters

xmlString A string that contains the XML data to be imported as the current profile.

Returns

A Boolean value of true if the string was successfully imported; £alse otherwise.
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Description
Method: imports an XML string that represents a publish profile and sets it as the current profile. To generate an XML
string to import, use document . exportPublishProfileString () before using this method.

Example

In the following example, the default profile is exported as an XML string. The standard JavaScript replace command
is used to modify the XML string. The string is then imported, and the default ActionScript 3 output setting is set to
ActionScript 1.

var profileXML=fl.getDocumentDOM () .exportPublishProfileString('Default');
fl.trace(profileXML) ;

var newProfileXML = profileXML.replace ("<ActionScriptVersion>3</ActionScriptVersions>",
"<ActionScriptVersion>l</ActionScriptVersions>") ;
fl.getDocumentDOM () .importPublishProfileString (newProfileXML) ;

document.importSWF() - dropped

Availability
Flash MX 2004. Dropped in Flash Professional CC.

Usage
document . importSWF (£11eURI)

Parameters
£ileURI A string, expressed as a file:/// URI, that specifies the file for the SWF file to import.

Returns
Nothing.

Description
Dropped in Flash Professional CC.

Example
The following example imports the "myswet . swe " file from the Flash Configuration folder:

f1.getDocumentDOM () . importSWF (f1.configURI+"mySwE.swf") ;

See also

document . importFile ()

document.intersect|()

Availability
Flash 8.
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Usage

document . intersect ()

Parameters

None.

Returns
None.

Description

Method; creates an intersection drawing object from all selected drawing objects. If no objects are selected, calling this

method results in an error and the script breaks at that point.

Example

The following example creates an intersection drawing object from all selected drawing objects:

fl.getDocumentDOM () .intersect () ;

See also
document .crop (), document .deleteEnvelope (), document .punch (), document .union(),

shape.isDrawingObject

document.library

Availability
Flash MX 2004.

Usage

document .library

Description
Read-only property; the library object for a document.

Example

The following example gets the library for the currently focused document:

var myCurrentLib = fl.getDocumentDOM() .library;

Assuming the currently focused document is not £1.documents [1], the following example gets the library for a

nonfocused library or for a library you opened using File > Open as external library:

var externallLib = fl.documents[1l].library;

document.libraryPath

Availability
Flash CS4 Professional.
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Usage

document . libraryPath

Description

Property; a string that contains a list of items in the document’s ActionScript 3.0 Library path, which specifies the
location of SWC files or folders containing SWC files. Items in the string are delimited by semi-colons. In the
authoring tool, the items are specified by choosing File > Publish Settings and then choosing ActionScript 3.0 Script
Settings on the Flash tab.

Example
The following adds the ../Files folder to the document’s Library path and then displays the path Library path in the
Output panel:

var myDoc = fl.getDocumentDOM ()

fl.trace (myDoc.libraryPath) ;

myDoc.libraryPath = "../Files;" + myDoc.libraryPath;
fl.trace (myDoc.libraryPath) ;

See also

document .externallLibraryPath,document . sourcebPath, f1.1libraryPath

document.livePreview

Availability
Flash MX 2004.

Usage

document .livePreview

Description

Property; a Boolean value that specifies whether Live Preview is enabled. If set to true, components appear on the
Stage as they will appear in the published Flash content, including their approximate size. If set to false, components
appear only as outlines. The default value is true.

Example
The following example sets Live Preview to false:

fl.getDocumentDOM () .1livePreview = false;

document.loadCuepointXML() - dropped

Availability
Flash Professional CS5. Dropped in Flash Professional CC.

Usage
document . loadCuepointXML (String URI)
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Parameters
URI String; the absolute path to the cue point XML file.

Description
Dropped in Flash Professional CC.

Method; loads a cue point XML file. The format and DTD of the XML file is the same as the one imported and exported
by the Cue Points Property inspector. The return value is the same as the string serialized in the Cue Point property of
the object containing the instance of an FLVPlayback Component.

Example
The following example the cue points XML file located at C:\\testCuePoints.xml:

var cuePoints = fl.getDocumentDOM () .LoadCuepointXML ("c:\\testCuePoints.xml") ;

document.match()

Availability
Flash MX 2004.

Usage
document .match (bWidth, bHeight [, bUseDocumentBounds])

Parameters
bwidth A Boolean value that, when set to true, causes the method to make the widths of the selected items the same.

bHeight A Boolean value that, when set to t rue, causes the method to make the heights of the selected items the same.

bUseDocumentBounds A Boolean value that, when set to true, causes the method to match the size of the objects to
the bounds of the document. Otherwise, the method uses the bounds of the largest object. The default is £alse. This
parameter is optional.

Returns
Nothing.

Description
Method; makes the size of the selected objects the same.

Example
The following example matches the width of the selected objects only:

fl.getDocumentDOM () .match (true, false) ;
The following example matches the height only:
fl.getDocumentDOM () .match (false, true) ;
The following example matches the width only to the bounds of the document:

fl.getDocumentDOM () .match (true, false, true) ;
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See also

document .getAlignToDocument (), document . setAlignToDocument ()

document.mouseClick()

Availability
Flash MX 2004.

Usage
document .mouseClick (position, bToggleSel, bsShiftSel)

Parameters
position A pair of floating-point values that specify the x and y coordinates of the click in pixels.

bTogglesel A Boolean value that specifies the state of the Shift key: true for pressed; £alse for not pressed.

bshiftSel A Boolean value that specifies the state of the application preference Shift select: t rue for on; false for off.

Returns
Nothing.

Description
Method; performs a mouse click from the Selection tool.

Example
The following example performs a mouse click at the specified location:

f1.getDocumentDOM () .mouseClick ({x:300, y:200}, false, false);

See also
document .mouseDb1Clk ()

document.mouseDbIClk()

Availability
Flash MX 2004.

Usage
document .mouseDblClk (position, bAltDown, bShiftDown, bShiftSelect)

Parameters
position A pair of floating-point values that specify the x and y coordinates of the click in pixels.

baltdown A Boolean value that records whether the Alt key is down at the time of the event: true for pressed; false
for not pressed.
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bshiftDown A Boolean value that records whether the Shift key was down when the event occurred: t rue for pressed;
false for not pressed.

bshiftSelect A Boolean value that indicates the state of the application preference Shift select: true for on; false

for off.

Returns
Nothing.

Description
Method; performs a double mouse click from the Selection tool.

Example

The following example performs a double mouse click at the specified location:

f1l.getDocumentDOM () .mouseDblClk ({x:392.9, y:73}, false, false, true);

See also

document .mouseClick ()

document.moveSelectedBezierPointsBy()

Availability
Flash MX 2004.

Usage

document .moveSelectedBezierPointsBy (delta)

Parameters

delta A pair of floating-point values that specify the x and y coordinates in pixels by which the selected Bézier points
are moved. For example, passing ({x:1,y:2}) specifies a location that is to the right by one pixel and down by two
pixels from the current location.

Returns
Nothing.

Description
Method; if the selection contains at least one path with at least one Bézier point selected, moves all selected Bézier
points on all selected paths by the specified amount.

Example
The following example moves the selected Bézier points 10 pixels to the right and 5 pixels down:

f1l.getDocumentDOM () .moveSelectedBezierPointsBy ({x:10, y:5});
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document.moveSelectionBy()

Availability
Flash MX 2004.

Usage

document .moveSelectionBy (distanceToMove)

Parameters

distanceToMove A pair of floating-point values that specify the x and y coordinate values by which the method
moves the selection. For example, passing ({x:1,y:2}) specifies a location one pixel to the right and two pixels down
from the current location.

Returns
Nothing.

Description

Method; moves selected objects by a specified distance.

Note: When the user uses the arrow keys to move the item, the History panel combines all presses of the arrow key as one
move step. When the user presses the arrow keys repeatedly, rather than taking multiple steps in the History panel, the
method performs one step, and the arguments are updated to reflect the repeated arrow keys.

For information on making a selection, see document . setSelectionRect (), document .mouseClick (),
document .mouseDb1Clk (), and the Element object.

Example
The following example moves the selected item 62 pixels to the right and 84 pixels down:

f1.getDocumentDOM () .moveSelectionBy ({x:62, y:84});

document.name

Availability
Flash MX 2004.

Usage

document . name

Description
Read-only property; a string that represents the name of a document (FLA file).

Example
The following example sets the variable £ileName to the filename of the first document in the documents array:

var fileName = flash.documents[0] .name;

The following example displays the names of all the open documents in the Output panel:
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var openDocs = fl.documents;
for(var i=0;1 < openDocs.length; i++){
fl.trace(i + " " + openDocs[i] .name +"\n");

}

document.optimizeCurves|()

Availability
Flash MX 2004.

Usage

document .optimizeCurves (smoothing, bUseMultiplePasses)

Parameters
smoothing An integer in the range from 0 to 100, with 0 specifying no smoothing and 100 specifying maximum
smoothing.

bUseMultiplePasses A Boolean value that, when set to true, indicates that the method should use multiple passes,
which is slower but produces a better result. This parameter has the same effect as clicking the Use Multiple Passes
button in the Optimize Curves dialog box.

Returns
Nothing.

Description
Method; optimizes smoothing for the current selection, allowing multiple passes, if specified, for optimal smoothing.
This method is equivalent to selecting Modify > Shape > Optimize.

Example
The following example optimizes the curve of the current selection to 50° of smoothing with multiple passes:

fl.getDocumentDOM () .optimizeCurves (50, true);

document.path

Availability
Flash MX 2004.

Usage

document .path
Description

Read-only property; a string that represents the path of the document in a platform-specific format. If the document
has never been saved, this property is undefined.
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Example

The following example displays the path of the first document in the documents array in the Output panel. You must
save the document before running this script. In the example, the file is named test.fla and is saved in the My
Documents folder on a Windows computer.

var filePath = flash.documents[0] .path;

fl.trace(filePath) ;
// displays C:\Documents and Settings\<user name>\My Documents\test.fla

See also
document .pathURI

document.pathURI

Availability
Flash CS4 Professional.

Usage
document .pathURI

Description
Read-only property; a string that represents the path of the document, expressed as a file:/// URL. If the document has
never been saved, this property is undefined.

Example

The following example displays the path of the first document in the documents array as a file:/// URI string in the
Output panel. You must save the document before running this script. In the example, the file is named test.fla and is
saved in the My Documents folder on a Windows computer.

var filePathURI = flash.documents[0] .pathURI;
fl.trace(filePathURI) ;
// displays file:///C|/Documents%20and%20Settings/<userName>/My%20Documents/test.fla

See also

document .path

document.publish()

Availability
Flash MX 2004.

Usage
document .publish ()

Parameters
None.
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Returns
Nothing.

Description

Method; publishes the document according to the active publish settings (File > Publish Settings). This method is

equivalent to selecting File > Publish.

Example

The following example publishes the current document:

fl.getDocumentDOM () .publish() ;

document.publishProfiles

Availability
Flash MX 2004.

Usage

document .publishProfiles

Description
Read-only property; an array of the publish profile names for the document.

Example

The following example displays the names of the publish profiles for the document:

var myPubProfiles = fl.getDocumentDOM () .publishProfiles;
for (var i1=0; i < myPubProfiles.length; i++){
fl.trace (myPubProfiles[i]);

}

document.punch()

Availability
Flash 8.

Usage

document . punch ()

Parameters

None.

Returns
None.
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Description

Method; uses the top selected drawing object to punch through all selected drawing objects underneath it. If no objects

are selected, calling this method results in an error and the script breaks at that point.

Example
The following example punches through drawing objects underneath the selected drawing object:

f1.getDocumentDOM () .punch () ;
See also

document .crop (), document .deleteEnvelope (), document . intersect (), document .union (),

shape.isDrawingObject

document.removeAllFilters()

Availability
Flash 8.

Usage

document .removeAllFilters ()

Parameters
None.

Returns
Nothing.

Description

Method; removes all filters from the selected objects.

Example
The following example removes all filters from the selected objects:

f1l.getDocumentDOM () .removeAllFilters() ;
See also

document .addFilter (), document .changeFilterOrder (), document.disableAllFilters(),

document.getFilters(),document.removeFilter(),fﬁher(ﬂject

document.removeDataFromDocument()

Availability
Flash MX 2004.
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Usage
document . removeDataFromDocument (name)

Parameters
name A string that specifies the name of the data to remove.

Returns
Nothing.

Description
Method; removes persistent data with the specified name that has been attached to the document.

Example
The following example removes from the document the persistent data named "myData":

f1l.getDocumentDOM () . removeDataFromDocument ("myData") ;

See also

document . addDataToDocument (), document . documentHasData (), document .getDataFromDocument ()

document.removeDataFromSelection()

Availability
Flash MX 2004.

Usage

document . removeDataFromSelection (name)

Parameters
name A string that specifies the name of the persistent data to remove.

Returns
Nothing.

Description
Method; removes persistent data with the specified name that has been attached to the selection.

Example
The following example removes from the selection the persistent data named "myData" :

fl.getDocumentDOM () .removeDataFromSelection ("myData") ;

See also

document .addDataToSelection ()
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document.removefFilter()

Availability
Flash 8.

Usage

document .removeFilter (filterIndex)

Parameters
filterIndex An integer specifying the zero-based index of the filter to remove from the selected objects.

Returns
Nothing.

Description
Method; removes the specified filter from the Filters list of the selected objects.

Example
The following example removes the first filter (index value 0) from the Filters list of the selected objects:

f1l.getDocumentDOM () .removeFilter (0) ;
See also

document .addFilter (), document .changeFilterOrder (), document.disableFilter(),

document .getFilters (), document .removeAllFilters (), Filter object

document.renamePublishProfile()

Availability
Flash MX 2004.

Usage

document . renamePublishProfile ( [profileNewName] )
Parameters
profileNewName An optional parameter that specifies the new name for the profile. The new name must be unique.

If the name is not specified, a default name is provided.

Returns
A Boolean value: true if the name is changed successfully; false otherwise.

Description
Method; renames the current profile.

Example

The following example renames the current profile to a default name and displays it:
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alert (f1l.getDocumentDOM () .renamePublishProfile()) ;

document.renameScene()

Availability
Flash MX 2004.

Usage

document . renameScene (name)

Parameters
name A string that specifies the new name of the scene.

Returns
A Boolean value: true if the name is changed successfully; false otherwise. If the new name is not unique, for

example, the method returns false.

Description

Method; renames the currently selected scene in the Scenes panel. The new name for the selected scene must be unique.

Example
The following example renames the current scene to "new name":

var success = fl.getDocumentDOM () .renameScene ("new name") ;

document.reorderScene()

Availability
Flash MX 2004.

Usage

document . reorderScene (sceneToMove, sceneToPutItBefore)

Parameters
sceneToMove An integer that specifies which scene to move, with 0 (zero) being the first scene.

sceneToPutItBefore An integer that specifies the scene before which you want to move the scene specified by
sceneToMove. Specify 0 (zero) for the first scene. For example, if you specify 1 for sceneToMove and 0 for
sceneToPutltBefore, the second scene is placed before the first scene. Specify -1 to move the scene to the end.

Returns
Nothing.

Description
Method; moves the specified scene before another specified scene.
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Example

The following example moves the second scene to before the first scene:

f1l.getDocumentDOM () .reorderScene (1, 0);

document.resetOvalObject()

Availability
Flash CS3 Professional.

Usage

document .resetOvalObject ()

Parameters

None.

Returns
Nothing.

Description

Method; sets all values in the Property inspector to default Oval object settings. If any Oval objects are selected, their

properties are reset to default values as well.

Example

The following example resets Oval object properties in the current document to default values:

f1l.getDocumentDOM () .resetOvalObject () ;

See also

document . resetRectangleObject ()

document.resetRectangleObject()

Availability
Flash CS3 Professional.

Usage

document . resetRectangleObject ()

Parameters
None.

Returns
Nothing.
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Description
Method; sets all values in the Property inspector to default Rectangle object settings. If any Rectangle objects are
selected, their properties are reset to default values as well.

Example
The following example resets Rectangle object properties in the current document to default values:

f1l.getDocumentDOM () .resetRectangleObject () ;

See also

document .resetOvalObject ()

document.resetTransformation()

Availability
Flash MX 2004.

Usage

document .resetTransformation ()

Parameters
None.

Returns
Nothing.

Description
Method; resets the transformation matrix. This method is equivalent to selecting Modify > Transform > Remove

Transform.

Example
The following example resets the transformation matrix for the current selection:

f1l.getDocumentDOM () .resetTransformation () ;

document.revert()

Availability
Flash MX 2004.

Usage

document .revert ()

Parameters

None.
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Returns
Nothing.

Description
Method; reverts the specified document to its previously saved version. This method is equivalent to selecting File >
Revert.

Example
The following example reverts the current document to the previously saved version:

f1l.getDocumentDOM () .revert () ;

See also

document .canRevert (), f1.revertDocument ()

document.rotate3DSelection()

Availability
Flash CS4 Professional.

Usage

document .rotate3DSelection (xyzCoordinate, bGlobalTransform)

Parameters
xyzCoordinate An XYZ coordinate point that specifies the axes for 3D rotation.

bGlobalTransform A Boolean value that specifies whether the transformation mode should be global (true) or local
(false).

Returns
Nothing.

Description
Method: applies a 3D rotation to the selection. This method is available only for movie clips.

Example
In the following example, the selection is first rotated relative to the stage (globally) and then relative to itself (locally).

var myDocument = fl.getDocumentDOM() ;
myDocument . rotate3DSelection({x:52.0, y:0, z:0}, true);
myDocument . rotate3DSelection ({x:52.0, y:0, z:—55.2}, false) ;

document.rotateSelection()

Availability
Flash MX 2004.
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Usage

document .rotateSelection(angle [, rotationPoint])

Parameters
angle A floating-point value that specifies the angle of the rotation.

rotationPoint A string that specifies which side of the bounding box to rotate. Acceptable values are "top rightn,
"top left", "bottom right", "bottom left", "top center", "right center", "bottom center",and "left
center". If unspecified, the method uses the transformation point. This parameter is optional.

Returns
Nothing.

Description
Method; rotates the selection by a specified number of degrees. The effect is the same as using the Free Transform tool
to rotate the object.

Example
The following example rotates the selection by 45° around the transformation point:

f1l.getDocumentDOM () .rotateSelection (45) ;
The following example rotates the selection by 45° around the lower-left corner:

fl.getDocumentDOM () .rotateSelection (45, "bottom left");

document.save()

Availability
Flash MX 2004.

Usage

document . save ( [bOkToSaveAs])

Parameters
bokToSaveAs An optional parameter that, if true or omitted, and the file was never saved, opens the Save As dialog
box. If false and the file was never saved, the file is not saved.

Returns
A Boolean value: true if the save operation completes successfully; false otherwise.

Description
Method; saves the document in its default location. This method is equivalent to selecting File > Save.

To specify a name for the file (instead of saving it with the same name), use £1.saveDocument ().

Note: If the file is new and has not been modified or saved, or if the file has not been modified since the last time it was
saved, this method has no effect and false is returned. To allow an unsaved or unmodified file to be saved, use

f1.saveDocumentAs ().
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Example
The following example saves the current document in its default location:

f1l.getDocumentDOM () .save () ;

See also

fl.saveAll (), £f1.saveDocument (), £1.saveDocumentAs ()

document.saveAndCompact() - dropped

Availability
Flash MX 2004. Dropped in Flash Professional CS6.

Usage
document . saveAndCompact ( [bOkToSaveAs])

Parameters
bokToSaveAs An optional parameter that, if true or omitted and the file was never saved, opens the Save As dialog
box. If false and the file was never saved, the file is not saved. The default value is true.

Returns
A Boolean value: true if the save-and-compact operation completes successfully; false otherwise.

Description
Dropped in Flash Professional CS6.

Example
The following example saves and compacts the current document:

f1l.getDocumentDOM () .saveAndCompact () ;

See also

document .save (), f1.saveDocumentAs (), £1.saveDocument (), £1.saveAll ()

document.saveAsCopy()

Availability
Flash CS6.

Usage
document . saveAsCopy (URI [, selectionOnlyl])

Parameters

urRI String: The URI to export the new FLA file to. This URI must reference a local file. Example:
file:///c|/tests/myTest.fla.
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selectiononly Optional. A boolean indicating whether only the current Stage selection should be saved to the new
FLA file.

Returns
Boolean.

Description
Method; Saves a new FLA file based on the existing document object, with an option to save only the current selection
on Stage.

Example
The following example exports the current selection to a new FLA file at the URI specified by the user:

var uri = fl.browseForFileURL ("save") ;
var selectionOnly = true;
f1l.getDocumentDOM () .saveAsCopy (uri, selectionOnly) ;

document.scaleSelection()

Availability
Flash MX 2004.

Usage

document .scaleSelection (xScale, yScale [, whichCornerl])

Parameters
xScale A floating-point value that specifies the amount of x by which to scale.

yScale A floating-point value that specifies the amount of y by which to scale.

whichCorner A string value that specifies the edge about which the transformation occurs. If omitted, scaling occurs
about the transformation point. Acceptable values are: "bottom left", "bottom right", "top right", "top
left", "top center", "right center", "bottom center",and "left center".TTﬁsparanuierisopﬁonaL

Returns
Nothing.

Description
Method; scales the selection by a specified amount. This method is equivalent to using the Free Transform tool to scale
the object.

Example

The following example expands the width of the current selection to double the original width and shrinks the height
to half:

fl.getDocumentDOM () .scaleSelection (2.0, 0.5);
The following example flips the selection vertically:

fl.getDocumentDOM () .scaleSelection(1l, -1);
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The following example flips the selection horizontally:
f1l.getDocumentDOM () .scaleSelection (-1, 1);
The following example scales the selection vertically by 1.9 from the top center:

fl.getDocumentDOM () .scaleSelection(l, 1.90, 'top center');

document.screenOutline - dropped

Availability
Flash MX 2004. Dropped in Flash Professional CC.

Usage

document . screenOutline

Description
Dropped in Flash Professional CC.

Example
The following example displays the array of values in the screenoutline property:
var myArray = new Array () ;

for(var i in fl.getDocumentDOM () .screenOutline) {
myArray.push (" "+i+" : "+fl.getDocumentDOM () .screenOutline[i]) ;

}

fl.trace("Here is the property dump for screenOutline: "+myArray) ;

See also

document.allowScreens () - dropped

document.selectAll()

Availability
Flash MX 2004.

Usage

document .selectAll ()

Parameters

None.

Returns
Nothing.
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Description

Method; selects all items on the Stage. This method is equivalent to pressing Control+A (Windows) or Command+A
(Macintosh) or selecting Edit > Select All

Example
The following example selects everything that is currently visible to the user:

f1l.getDocumentDOM () .selectAll () ;

See also

document .selection, document.selectNone ()

document.selection

Availability
Flash MX 2004.

Usage

document .selection

Description

Property; an array of the selected objects in the document. If nothing is selected, returns an array of length zero. If no
document is open, returns null.

To add objects to the array, you must first select them in one of the following ways:

« Manually select objects on the Stage.

« Use one of the selection methods, such as document . setSelectionRect (), document . setSelectionBounds (),

document .mouseClick (), document .mouseDblClk (), Or document .selectAll ().
+ Manually select a frame or frames.

+ Use one of the methods of the Timeline object to select a frame or frames, such as

timeline.getSelectedFrames (), timeline.setSelectedFrames (), Or timeline.selectAllFrames ().
« Specify all the elements in a particular frame (see Element object). See the first example below.

+ Create an array of one or more elements and then assign that array to the document . selection array. See the third
example below.

Example
The following example assigns all elements on Frame 11 to the current selection (remember that index values are
different from frame number values):

fl.getDocumentDOM () .getTimeline () .currentFrame = 10;
f1l.getDocumentDOM () .selection =
f1l.getDocumentDOM () .getTimeline () .layers[0] .frames [10] .elements;

The following example creates a rectangle in the upper left corner of the Stage and a text string underneath the
rectangle. Then it selects both objects using document . setSelectionRect () and adds them to the
document . selection array. Finally, it displays the contents of document . selection in the Output panel.
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addNewRectangle ({left:0, top:0, right:99, bottom:99}, 0)

f1l.getDocumentDOM () . ;
) .addNewText ({left:-1, top:117.3, right:9.2, bottom:134.6});
).
) .

f1l.getDocumentDOM
f1l.getDocumentDOM
f1l.getDocumentDOM

(
(
() .setTextString('Hello World') ;

() .setSelectionRect ({left:-28, top:-22, right:156.0, bottom:163});

var theSelectionArray = fl.getDocumentDOM() .selection;

for (var i=0;i<theSe1ectionArray.1ength;i++){
fl.trace("fl.getDocumentDOM () .selection["+i+"] = " + theSelectionArrayl[il) ;

}

The following example is an advanced example. It shows how to loop through the layer array and elements array to
locate instances of a particular symbol and select them. You could extend this example to include loops for multiple
frames or scenes. This example assigns all instances of the movie clip myMoviecClip in the first frame to the current
selection:

// Assigns the layers array to the variable "theLayers".
var theLayers = fl.getDocumentDOM () .getTimeline () .layers;
// Creates an array to hold all the elements
// that are instances of "myMovieClip".
var myArray = new Array();
// Counter variable
var X = 0;
// Begin loop through all the layers.
for (var i = 0; i < thelayers.length; i++) {
// Gets the array of elements in Frame 1
// and assigns it to the array "theElems".
var theElems = thelayers[i] .frames[0] .elements;
// Begin loop through the elements on a layer.
for (var ¢ = 0; ¢ < theElems.length; c++) {
// Checks to see if the element is of type "instance".
if (theElems[c].elementType == "instance")
// If the element is an instance, it checks
// if it is an instance of "myMovieClip".
if (theElems[c].libraryItem.name == "myMovieClip") ({
// Assigns elements that are instances of "myMovieClip" to "myArray".
myArray [x] = theElems[c];
// Increments counter variable.

Xt+;

// Now that you have assigned all the instances of "myMovieClip"
// to "myArray", you then set the document.selection array

// equal to myArray. This selects the objects on the Stage.
fl.getDocumentDOM () .selection = myArray;

document.selectNone()

Availability
Flash MX 2004.
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Usage

document . selectNone ()

Parameters

None.

Returns
Nothing.

Description
Method; deselects any selected items.

Example

The following example deselects any items that are selected:

f1l.getDocumentDOM () .selectNone () ;

See also

document .selectAll (), document .selection

document.setAlignToDocument()

Availability
Flash MX 2004.

Usage

document . setAlignToDocument (bToStage)

Parameters
bTostage A Boolean value that, if set to true, aligns objects to the Stage. If set to false, it does not.

Returns
Nothing.

Description

Method; sets the preferences for document .align (), document.distribute (), document .match (), and
document . space () to act on the document. This method is equivalent to enabling the To Stage button in the Align
panel.

Example
The following example enables the To Stage button in the Align panel to align objects with the Stage:

f1l.getDocumentDOM () . setAlignToDocument (true) ;

See also

document .getAlignToDocument ()
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document.setBlendMode()

Availability
Flash 8.

Usage

document . setBlendMode (mode)

Parameters
mode A string that represents the desired blending mode for the selected objects. Acceptable values are "normalr,
"layer", "multiply", 'screen", "overlay", "hardlight", "lighten", "darken", "difference", "add",

"subtract™", "invert", "alpha", and "erase".

Returns
Nothing.

Description
Method; sets the blending mode for the selected objects.

Example
The following example sets the blending mode for the selected object to "add.

f1l.getDocumentDOM () .setBlendMode ("add") ;

See also

document .addFilter (), document.setFilterProperty (), symbolInstance.blendMode

document.setCustomFill()

Availability
Flash MX 2004.

Usage
document .setCustomFill (£i11)

Parameters
£111 A Fill object that specifies the fill settings to be used. See Fill object.

Returns
Nothing.

Description

Method; sets the fill settings for the Tools panel, Property inspector, and any selected shapes. This allows a script to set
the fill settings before drawing the object, rather than drawing the object, selecting it, and changing the fill settings. It

also lets a script change the Tools panel and Property inspector fill settings.
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Example

The following example changes the color of the fill color swatch in the Tools panel, Property inspector, and any
selected shapes to white:

var fill = fl.getDocumentDOM () .getCustomFill () ;

fill.color = '#FFFFFF';

fill.style = "solid";
fl.getDocumentDOM () .setCustomFill (£i11) ;

See also

document .getCustomFill ()

document.setCustomStroke()

Availability
Flash MX 2004.

Usage

document . setCustomStroke (stroke)

Parameters
stroke A Stroke object.

Returns
Nothing.

Description

Method; sets the stroke settings for the Tools panel, Property inspector, and any selected shapes. This allows a script
to set the stroke settings before drawing the object, rather than drawing the object, selecting it, and changing the stroke
settings. It also lets a script change the Tools panel and Property inspector stroke settings.

Example
The following example changes the stroke thickness setting in the Tools panel, Property inspector, and any selected
shapes:

var stroke = fl.getDocumentDOM () .getCustomStroke () ;
stroke.thickness += 2;
f1l.getDocumentDOM () .setCustomStroke (stroke) ;

See also

document .getCustomStroke ()

document.setElementProperty()

Availability
Flash MX 2004.
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Usage

document . setElementProperty (property, value)

Parameters
property A string that specifies the name of the Element property to set. For a complete list of properties and values,
see the Property summary table for the Element object.

You can’t use this method to set values for read-only properties, such as element . elementType, element . top, Or

element.left.

value An integer that specifies the value to set in the specified Element property.

Returns
Nothing.

Description
Method; sets the specified Element property on selected objects in the document. This method does nothing if there
is no selection.

Example
The following example sets the width of all selected objects to 100 and the height to 50:

fl.getDocumentDOM () .setElementProperty ("width", 100) ;
f1l.getDocumentDOM () .setElementProperty ("height", 50);

document.setElementTextAttr()

Availability
Flash MX 2004.

Usage

document .setElementTextAttr (attrName, attrValue [, startIndex [, endIndex]])

Parameters
attrName A string that specifies the name of the TextAttrs property to change.

attrvalue The value to which to set the TextAttrs property. For a list of property names and expected values, see
the Property summary table for the TextAttrs object.

startIndex An integer value that specifies the index of the first character that is affected. This parameter is optional.

endIndex An integer value that specifies the index of the last character that is affected. This parameter is optional.

Returns

A Boolean value: true if at least one text attribute property is changed; false otherwise.
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Description

Method; sets the specified textattrs property of the selected text items to the specified value. For a list of property
names and allowable values, see the Property summary table for the TextAttrs object. If the optional parameters are
not passed, the method sets the style of the currently selected text range, or the whole text field if no text is selected. If
only startIndex is passed, the method sets that character’s attributes. If startIndex and endIndex are passed, the method
sets the attributes on the characters starting from startIndex up to, but not including, endIndex. If paragraph styles are
specified, all the paragraphs that fall within the range are affected.

Example
The following examples set the fillcolor, italic, and bold text attributes for the selected text items:

var success = fl.getDocumentDOM () .setElementTextAttr ("fillColor", "#00ff00");
var pass = fl.getDocumentDOM() .setElementTextAttr("italic", true, 10);
var ok = fl.getDocumentDOM() .setElementTextAttr ("bold", true, 5, 15);

document.setFillColor()

Availability
Flash MX 2004.

Usage

document .setFillColor (color)

Parameters
color The color of the fill, in one of the following formats:

+ A string in the format "#RRGGBB" or "#RRGGBBAA"
+ A hexadecimal number in the format 0xRRGGBB
+ An integer that represents the decimal equivalent of a hexadecimal number

If set to null, no fill color is set, which is the same as setting the Fill color swatch in the user interface to no fill.

Returns
Nothing.

Description
Method; changes the selection and the tools panel to the specified fill color. For additional information on changing
the fill color in the Tools panel and Property inspector, see document . setCustomFill ().

Example

The first three statements in the following example set the fill color using each of the different formats for specifying
color. The fourth statement sets the fill to no fill.

f1l.getDocumentDOM () .setFillColor ("#cc00cc") ;
f1l.getDocumentDOM () .setFillColor (0xcc00cc) ;
f1l.getDocumentDOM () .setFillColor (120000) ;

() (

f1l.getDocumentDOM () .setFillColor (null) ;
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document.setFilterProperty()

Availability
Flash 8.

Usage

document .setFilterProperty (property, filterIndex, value)

Parameters

property A string specifying the property to be set. Acceptable values are "blurx", "blury", "quality", angle",
"distance","strength","knockout","inner","bevelType","color","shadowColor",and
"highlightColor™".

filterIndex An integer specifying the zero-based index of the filter in the Filters list.

value A number or string specifying the value to be set for the specified filter property. Acceptable values depend on
the property and the filter being set.

Returns
Nothing.

Description
Method; sets a specified filter property for the currently selected objects (assuming that the object supports the
specified filter).

Example
The following example sets the quality property to 2 for the second filter (index value of 1) in the Filters list of the
selected objects and then sets the shadowColor property of the first filter in the Filters list on the selected objects:

fl.getDocumentDOM () .setFilterProperty ("quality", 1, 2);
f1l.getDocumentDOM () .setFilterProperty ("shadowColor", 0, "#FFOOFF") ;

See also

document.addFilter(),document.getFilters(),document.setBlendMode(),document.setFilters()Jﬁher
object

document.setFilters()

Availability
Flash 8.

Usage

document .setFilters (filterArray)

Parameters
filterArray The array of filters currently specified.
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Returns
Nothing.

Description
Method; applies filters to the selected objects. Use this method after calling document . getFilters () and making any
desired changes to the filters.

Example
The following example gets the filters on the selected object and sets the blurx property for all Blur filters to 50:
var myFilters = fl.getDocumentDOM() .getFilters() ;
for (i=0; i < myFilters.length; i++) {

if (myFilters[i] .name == "blurFilter")

myFilters[i] .blurX = 50;

}

}

fl.getDocumentDOM () .setFilters (myFilters) ;

See also
document.addFilter(),document.getFilters(),document.setFilterProperty(),Fﬂwrobﬁct

document.setinstanceAlpha()

Availability
Flash MX 2004.

Usage

document . setInstanceAlpha (opacity)

Parameters
opacity An integer between 0 (transparent) and 100 (completely saturated) that adjusts the transparency of the
instance.

Returns
Nothing.

Description
Methods; sets the opacity of the instance.

Example
The following example sets the opacity of the tint to a value of 50:

f1l.getDocumentDOM () .setInstanceAlpha (50) ;
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document.setinstanceBrightness()

Availability
Flash MX 2004.

Usage

document . setInstanceBrightness (brightness)

Parameters
brightness An integer that specifies brightness as a value from -100 (black) to 100 (white).

Returns
Nothing.

Description
Method; sets the brightness for the instance.

Example
The following example sets the brightness for the instance to a value of 50:

fl.getDocumentDOM () .setInstanceBrightness (50) ;

document.setinstanceTint()

Availability
Flash MX 2004.

Usage

document .setInstanceTint ( color, strength )

Parameters
color The color of the tint, in one of the following formats:

+ A string in the format "#RRGGBB" or "#RRGGBBAA"
+ A hexadecimal number in the format 0xRRGGBB
+ An integer that represents the decimal equivalent of a hexadecimal number

strength An integer between 0 and 100 that specifies the opacity of the tint.

Returns
Nothing.

Description
Method; sets the tint for the instance.
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Example
The following example sets the tint for the selected instance to red with an opacity value of 50:

f1l.getDocumentDOM () .setInstanceTint (0x££0000, 50);

document.setMetadata()

Availability
Flash 8.

Usage

document . setMetadata (strMetadata)

Parameters
strMetadata A string containing the XML metadata to be associated with the document. For more information, see
the following description.

Returns

A Boolean value: true if successful; false otherwise.

Description

Method; sets the XML metadata for the specified document, overwriting any existing metadata. The XML passed as
strMetadata is validated and may be rewritten before being stored. If it cannot be validated as legal XML or violates
specific rules, then the XML metadata is not set and false is returned. (If £alse is returned, there is no way to get
more detailed error information.)

Note: Even if true is returned, the XML that is set may not be exactly the same string that you passed in. To get the exact
value to which the XML was set, use document . getMetadata ().

The format of the metadata is RDF that is compliant with the XMP specification. For more information about RDF
and XMP, see the following sources:

+ The RDF Primer at www.w3.org/TR/rdf-primer/
+ The RDF specification at www.w3.0rg/TR/1999/REC-rdf-syntax-19990222/
« The XMP home page at www.adobe.com/products/xmp/

Example
The following examples show several different legal ways to represent the same data. In all of these cases but the second
one, if the data were sent to Document . setMetadata (), it would not be rewritten (aside from removing line breaks).

In the first example, metadata is in tags, with different schemas placed in separate rdf : Description tags:
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<rdf:RDF xmlns:rdf='http://www.w3.0rg/1999/02/22-rdf-syntax-ns#'>
<rdf:Description rdf:about='' xmlns:dc='http://purl.org/dc/1.1/'>
<dc:title>Simple title</dc:title>

<dc:description>Simple description</dc:descriptions>

</rdf :Description>

<rdf:Description rdf:about='"' xmlns:xmp='http://ns.adobe.com/xap/1.0/"'>
<xmp:CreateDate>2004-10-12T10:29-07:00</xmp:CreateDate>
<xmp:CreatorTool>Flash Authoring WIN 8,0,0,215</xmp:CreatorTool>

</rdf :Descriptions>

</rdf :RDF>

In the second example, metadata is in tags, but with different schemas all in one rdf : Description tag. This example
also includes comments, which will be ignored and discarded by the bocument . setMetadata ():

<rdf :RDF xmlns:rdf='http://www.w3.0rg/1999/02/22-rdf-syntax-ns#'>
<!-- This is before the first rdf:Description tag --»>
<rdf :Description rdf:about='"' xmlns:dc='http://purl.org/dc/1.1/'>
<dc:title>Simple title</dc:titles>
<dc:description>Simple description</dc:descriptions>
</rdf :Descriptions>
<!-- This is between the two rdf:Description tags -->
<rdf:Description rdf:about='"' xmlns:xmp='http://ns.adobe.com/xap/1.0/"'>
<xmp:CreateDate>2004-10-12T10:29-07:00</xmp:CreateDate>
<xmp:CreatorTool>Flash Authoring WIN 8,0,0,215</xmp:CreatorTool>
</rdf :Descriptions>
<!-- This is after the second rdf:Description tag -->
</rdf :RDF>

In the third example, metadata is in attributes, and different schemas are all in one rdf :Description tag:

<rdf :RDF xmlns:rdf='http://www.w3.0rg/1999/02/22-rdf-syntax-ns#'>

<rdf :Description rdf:about='' xmlns:dc='http://purl.org/dc/1.1/' dc:title='Simple title'
dc:description='Simple description' />

<rdf:Description rdf:about='"' xmlns:xmp='http://ns.adobe.com/xap/1.0/"'

xmp : CreateDate="'2004-10-12T10:29-07:00"' xmp:CreatorTool='Flash Authoring WIN 8,0,0,215' />
</rdf :RDF>

See also

document .getMetadata ()

document.setMobileSettings()

Availability
Flash CS3 Professional.

Usage

document . setMobileSettings (xmlString)

Parameters
xmlString A string that describes the XML settings in a mobile FLA file.

Returns
A value of true if the settings were successfully set; false otherwise.
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Description
Method; sets the value of an XML settings string in a mobile FLA file. (Most mobile FLA files have an XML string that
describes the settings within the document.)

Example
The following example sets the XML settings string for a mobile FLA file. Note that the example below represents a
single line of code.

f1l.getDocumentDOM () .setMobileSettings ("<? xml version="1.0" encoding="UTF-16" standalone="no"
?> <mobileSettings> <contentType id="standalonePlayer" name="Standalone Player"/>
<testDevices> <testDevice i1d="1170" name="Generic Phone" selected="yes"/> </testDevices>
<outputMsgFiltering info="no" trace="yes" warning="yes"/> <testWindowState height="496"
splitterClosed="No" splitterXPos="400" width="907"/> </mobileSettings>") ;

See also

document .getMobileSettings ()

document.setOvalObjectProperty()

Availability
Flash CS3 Professional.

Usage

document . setOvalObjectProperty (propertyName, value)

Parameters
propertyName A string that specifies the property to be set. For acceptable values, see the Property summary table for
the Oval object.

value The value to be assigned to the property. Acceptable values vary depending on the property you specify in
propertyName.

Returns
Nothing.

Description

Method; specifies a value for a specified property of primitive Oval objects.

Example
See individual properties in Oval object for examples.

See also
Oval object, shape.isOvalObject

Last updated 12/6/2013



EXTENDING FLASH PROFESSIONAL 170
Document object

document.setPlayerVersion()

Availability
Flash CS3 Professional.

Usage

document . setPlayerVersion (version)

Parameters

version A string that represents the version of Flash Player targeted by the specified document. Acceptable values are
"FlashLite", "FlashLitell", "FlashLite20", "FlashLite30", "1", "2", 3", ngn ngn ngu ngn ngu ngu,
"FlashPlayer10", "FlashPlayer10.3", "FlashPlayerll.1l", "FlashPlayerll.2",

"FlashPlayerll.3", "FlashPlayerll.4", "FlashPlayerll.5", "FlashPlayerll.é", "FlashPlayerll.7",
"AdobeAIR1 1", "AdobeAIR1 1", "AdobeAIR2 5", "AdobeAIR3 6", "android3 6", and "PF13 6"
Returns

A value of true if the player version was successfully set; false otherwise.

Description
Method; sets the version of the Flash Player targeted by the specified document. This is the same value as that set in
the Publish Settings dialog box.

Example

The following example targets Flash Player 6 as the player version for the current document:

fl.getDocumentDOM () .setPlayerVersion("6") ;

See also

document .getPlayerVersion ()

document.setPublishDocumentData()

Availability
Flash Professional CC.

Usage

document . setPublishDocumentData (format, publish)

Parameters
format A string that specifies the publishing format.

Note: _EMBED_SWF_is a special built-in publishing format for persistent data. If set, the persistent data will be
embedded in the SWF file every time a document is published. The persistent data can then be accessed via ActionScript
with the .metaData property. This requires SWF version 19 (Flash Player 11.6) and above and is only for symbol instances
onstage. Other custom publishing formats may be specified for custom JSFL scripts if this method is called with the same
format.
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publish A boolean that indicates whether to enable or disable publishing of persistent data for the specified format.

None.

Returns
None.

Description
Method; Enables or disables publishing of persistent data for an entire document.

Example
The following example illustrates the use of this method:

var doc = fl.getDocumentDOM() ;
// set the data
if (doc) |
// get the first selected element
var elem = fl.getDocumentDOM () .getTimeline () .layers[0].frames[0].elements[0];
if (elem) {
// add persistent data "myAlign" of "left"

elem.setPersistentData( "myAlign", "string", "left" );

// enable publishing of persistent data to SWF for the element
elem.setPublishPersistentData ("myAlign", " EMBED_SWF_", true);
// enable publishing to SWF for entire document
doc.setPublishDocumentData ("_EMBED SWF ", true);

// example getting data
if (doc && doc.getPublishDocumentData (" EMBED SWF "))

// get the first selected element

var elem = fl.getDocumentDOM () .getTimeline () .layers[0].frames[0] .elements[0];

if (elem && elem.hasPersistentData ("myAlign") && elem.getPublishPersistentData ("myAlign",
" EMBED SWF ")) {

alert ("elem.metaData.myAlign = '" + elem.getPersistentData ("myAlign") + "' will be

embedded in SWF when published.");

}

See also

document .getPublishDocumentData ()

document.setRectangleObjectProperty()

Availability
Flash CS3 Professional.

Usage

document . setRectangleObjectProperty (propertyName, value)
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Parameters
propertyName A string that specifies the property to be set. For acceptable values, see the Property summary table for
the Rectangle object.

value The value to be assigned to the property. Acceptable values vary depending on the property you specify in
propertyName.

Returns
Nothing.

Description
Method; specifies a value for a specified property of primitive Rectangle objects.

Example
See individual properties in Rectangle object for examples.

See also
Rectangle object, shape.isRectangleObject

document.setSelectionBounds()

Availability
Flash MX 2004; bContactSensitiveSelection parameter added in Flash 8.

Usage

document . setSelectionBounds (boundingRectangle [, bContactSensitiveSelection])

Parameters
boundingRectangle A rectangle that specifies the new location and size of the selection. For information on the
format of boundingRectangle, see document . addNewRectangle ().

bContactSensitiveSelection A Boolean value that specifies whether the Contact Sensitive selection mode is
enabled (true) or disabled (false) during object selection. The default value is false.

Returns
Nothing.

Description
Method; moves and resizes the selection in a single operation.

If you pass a value for bContactSensitiveSelection, it is valid only for this method and doesn’t affect the Contact
Sensitive selection mode for the document (see £1.contactSensitiveSelection).

Example
The following example moves the current selection to 10, 20 and resizes it to 100, 200:

var 1 = 10;
var t = 20;
fl.getDocumentDOM().setSelectionBounds({left:l, top:t, right: (100+1), bottom:(200+t)});
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See also

document .selection, document .setSelectionRect ()

document.setSelectionRect()

Availability
Flash MX 2004; bContactSensitiveSelection parameter added in Flash 8.

Usage

document .setSelectionRect (rect [, bReplaceCurrentSelection [, bContactSensitiveSelection]])

Parameters
rect A rectangle object to set as selected. For information on the format of rect, see document.addNewRectangle().

bReplaceCurrentSelection A Boolean value that specifies whether the method replaces the current selection
(true) or adds to the current selection (false). The default value is true.

bContactSensitiveSelection A Boolean value that specifies whether the Contact Sensitive selection mode is
enabled (true) or disabled (false) during object selection. The default value is false.

Returns
Nothing.

Description
Method; draws a rectangular selection marquee relative to the Stage, using the specified coordinates. This is unlike
document .getSelectionRect (), in which the rectangle is relative to the object being edited.

This method is equivalent to dragging a rectangle with the Selection tool. An instance must be fully enclosed by the
rectangle to be selected.

If you pass a value for bContactSensitiveSelection, it is valid only for this method and doesn’t affect the Contact
Sensitive selection mode for the document (see £1.contactSensitiveSelection

Note: Repeating setSelectionRect () using the History panel or menu item repeats the step previous to the
setSelectionRect () operation.

Example
In the following example, the second selection replaces the first one:
f1l.getDocumentDOM () .setSelectionRect ({left:1, top:1, right:200, bottom:200}) ;

fl.getDocumentDOM () .setSelectionRect ({left:364.0, top:203.0, right:508.0, bottom:434.0},
true) ;

In the following example, the second selection is added to the first selection. This is the same as the manual operation
of holding down Shift and selecting a second object.

fl.getDocumentDOM () .setSelectionRect ({left:1, top:1, right:200, bottom:200}) ;
f1l.getDocumentDOM () .setSelectionRect ({left:364.0, top:203.0, right:508.0, bottom:434.0},
false) ;

See also

document .getSelectionRect (), document .selection, document .setSelectionBounds ()
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document.setStageVanishingPoint()

Availability
Flash CS4 Professional.

Usage

document . setStageVanishingPoint (point)

Parameters
point A point that specifies the x and y coordinates of the location at which to set the vanishing point for viewing 3D
objects.

Returns
Nothing.

Description

Specifies the vanishing point for viewing 3D objects.

Example
The following example sets the Stage vanishing point:

f1l.getDocumentDOM () . setStageVanishingPoint ({x:45, y:45});

document.setStageViewAngle()

Availability
Flash CS4 Professional.

Usage

document . setStageViewAngle (angle)

Parameters
angle A floating point value between 0.0 and 179.0.

Returns
Nothing.

Description
Specifies the perspective angle for viewing 3D objects.

Example
The following example sets the Stage perspective angle to 70 degrees:

f1l.getDocumentDOM () .setStageViewAngle (70) ;
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document.setStroke()

Availability
Flash MX 2004.

Usage

document . setStroke (color, size, strokeType)

Parameters
color The color of the stroke, in one of the following formats:

+ A string in the format "#RRGGBB" Or "#RRGGBBAA"

+ A hexadecimal number in the format 0xRRGGBB

« An integer that represents the decimal equivalent of a hexadecimal number
size A floating-point value that specifies the new stroke size for the selection.

strokeType A string that specifies the new type of stroke for the selection. Acceptable values are "hairline",
"solid", "dashed", "dotted", "ragged", "stipple", and "hatched".

Returns
Nothing.

Description

Method; sets the color, width, and style of the selected stroke. For information on changing the stroke in the Tools
panel and Property inspector, see document . setCustomStroke ().

Example
The following example sets the color of the stroke to red, the size to 3.25, and the type to dashed:

fl.getDocumentDOM () .setStroke ("#££0000", 3.25, "dashed");

document.setStrokeColor()

Availability
Flash MX 2004.

Usage

document . setStrokeColor (color)

Parameters
color The color of the stroke, in one of the following formats:

+ A string in the format "#RRGGBB" Or "#RRGGBBAA"
« A hexadecimal number in the format 0xRRGGBB

« An integer that represents the decimal equivalent of a hexadecimal number
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Returns
Nothing.

Description
Method; changes the stroke color of the selection to the specified color. For information on changing the stroke in the
Tools panel and Property inspector, see document . setCustomStroke ().

Example
The three statements in the following example set the stroke color using each of the different formats for specifying
color:

fl.getDocumentDOM () .setStrokeColor ("#cc00cc") ;
f1l.getDocumentDOM () .setStrokeColor (0xcc00cc) ;
fl.getDocumentDOM () .setStrokeColor (120000) ;

document.setStrokeSize()

Availability
Flash MX 2004.

Usage

document . setStrokeSize (size)

Parameters
size A floating-point value from 0.25 to 250that specifies the stroke size. The method ignores precision greater than
two decimal places.

Returns
Nothing.

Description
Method; changes the stroke size of the selection to the specified size. For information on changing the stroke in the

Tools panel and Property inspector, see document . setCustomStroke ().

Example
The following example changes the stroke size for the selection to 5:

f1l.getDocumentDOM () .setStrokeSize (5) ;

document.setStrokeStyle()

Availability
Flash MX 2004.

Usage
document .setStrokeStyle (strokeType)
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Parameters
strokeType A string that specifies the stroke style for the current selection. Acceptable values are "hairline",
"solid","dashed","dotted","ragged","stipple",and"hatchedﬁ

Returns
Nothing.

Description
Method; changes the stroke style of the selection to the specified style. For information on changing the stroke in the
Tools panel and Property inspector, see document . setCustomStroke ().

Example

The following example changes the stroke style for the selection to "dashed":

fl.getDocumentDOM () .setStrokeStyle ("dashed") ;

document.setTextRectangle()

Availability
Flash MX 2004.

Usage

document . setTextRectangle (boundingRectangle)

Parameters
boundingRectangle A rectangle that specifies the new size within which the text item should flow. For information
on the format of boundingRectangle, see document.addNewRectangle().

Returns

A Boolean value: true if the size of at least one text field is changed; false otherwise.

Description

Method; changes the bounding rectangle for the selected text item to the specified size. This method causes the text to
reflow inside the new rectangle; the text item is not scaled or transformed. The values passed in boundingRectangle are
used as follows:

« Ifthe textis horizontal and static, the method takes into account only the width value passed in boundingRectangle;
the height is automatically computed to fit all the text.

« If the text is vertical (and therefore static), the method takes into account only the height value passed in
boundingRectangle; the width is automatically computed to fit all the text.

« If the text is dynamic or input, the method takes into account both the width and height values passed in
boundingRectangle, and the resulting rectangle might be larger than needed to fit all the text. However, if the
parameters specify a rectangle size that is too small to fit all the text, the method takes into account only the width
value passed in boundingRectangle (the height is automatically computed to fit all the text).

Example

The following example changes the size of the bounding text rectangle to the specified dimensions:
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f1l.getDocumentDOM () .setTextRectangle ({left:0, top:0, right:50, bottom:200})

document.setTextSelection()

Availability
Flash MX 2004.

Usage

document .setTextSelection (startIndex, endIndex)

Parameters
startIndex An integer that specifies the position of the first character to select. The first character position is 0
(zero).

endIndex An integer that specifies the end position of the selection up to, but not including, endIndex. The first
character position is 0 (zero).

Returns

A Boolean value: true if the method can successfully set the text selection; false otherwise.

Description
Method; sets the text selection of the currently selected text field to the values specified by the startIndex and endIndex
values. Text editing is activated, if it isn’t already.

Example
The following example selects the text from the 6th character through the 25th character:

f1l.document.setTextSelection (5, 25);

document.setTextString()

Availability
Flash MX 2004.

Usage

document .setTextString (text [, startIndex [, endIndex]])

Parameters
text A string of the characters to insert in the text field.

startIndex An integer that specifies the first character to replace. The first character position is 0 (zero). This
parameter is optional.

endIndex An integer that specifies the last character to replace. This parameter is optional.

Returns
A Boolean value: true if the text of at least one text string is set; false otherwise.
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Description

Method; inserts a string of text. If the optional parameters are not passed, the existing text selection is replaced; if the
Text object isn’t currently being edited, the whole text string is replaced. If only startIndex is passed, the string passed
is inserted at this position. If startIndex and endIndex are passed, the string passed replaces the segment of text starting
from startIndex up to, but not including, endIndex.

Example
The following example replaces the current text selection with “Hello World™:

var success = fl.getDocumentDOM() .setTextString("Hello World!") ;
The following example inserts “hello” at position 6 of the current text selection:
var pass = fl.getDocumentDOM () .setTextString("hello", 6);

The following example inserts “Howdy” starting at position 2 and up to, but not including, position 7 of the current
text selection:

var ok = fl.getDocumentDOM () .setTextString ("Howdy", 2, 7);

See also

document .getTextString ()

document.setTransformationPoint()

Availability
Flash MX 2004.

Usage

document .setTransformationPoint ( transformationbPoint )

Parameters
transformationPoint A point (for example, {x:10, y:20}, where x and y are floating-point numbers) that
specifies values for the transformation point of each of the following elements:

« Shapes: transformationPoint is set relative to the document (0,0 is the upper left corner of the Stage).

+ Symbols: transformationPoint is set relative to the symbol’s registration point (0,0 is located at the registration
point).

+ Text: transformationPoint is set relative to the text field (0,0 is the upper left corner of the text field).

+ Bitmaps/videos: transformationPoint is set relative to the bitmap/video (0,0 is the upper left corner of the bitmap
or video).

+ Drawing objects, primitive ovals and rectangles, and groups: transformationPoint is set relative to the document
(0,0 is the upper left corner of the Stage). To set transformationPoint relative to the center point of the object,
primitive, or group, use element . setTransformationPoint ().

Returns
Nothing.
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Description
Method; sets the position of the current selection’s transformation point.

Example
The following example sets the transformation point of the current selection to 100, 200:

f1l.getDocumentDOM () .setTransformationPoint ({x:100, y:200});

See also

document .getTransformationPoint (), element.setTransformationbPoint ()

document.silent

Availability
Flash MX 2004.

Usage

document .silent

Description

Property; a Boolean value that specifies whether the object is accessible. This is equivalent to the inverse logic of the
Make Movie Accessible setting in the Accessibility panel. That is, if document.silent is true, it is the same as the
Make Movie Accessible option being unchecked. If it is false, it is the same as the Make Movie Accessible option
being checked.

Example
The following example sets the isSilent variable to the value of the silent property:

var isSilent = fl.getDocumentDOM() .silent;
The following example sets the silent property to £alse, indicating that the document is accessible:

fl.getDocumentDOM () .silent = false;

document.skewSelection()

Availability
Flash MX 2004.

Usage
document . skewSelection (xSkew, ySkew [, whichEdge])

Parameters
xSkew A floating-point number that specifies the amount of x by which to skew, measured in degrees.

ySkew A floating-point number that specifies the amount of y by which to skew, measured in degrees.
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whichEdge A string that specifies the edge where the transformation occurs; if omitted, skew occurs at the
transformation point. Acceptable values are "top center", "right center", "bottom center",and "left
center". This parameter is optional.

Returns
Nothing.

Description
Method; skews the selection by a specified amount. The effect is the same as using the Free Transform tool to skew the
object.

Example
The following examples skew the selected object by 2.0 vertically and 1.5 horizontally. The second example transforms
the object at the top center edge:

fl.getDocumentDOM () .skewSelection (2.0, 1.5);
f1l.getDocumentDOM () .skewSelection (2.0, 1.5, "top center");

document.smoothSelection()

Availability
Flash MX 2004.

Usage

document . smoothSelection ()

Parameters
None.

Returns
Nothing.

Description
Method; smooths the curve of each selected fill outline or curved line. This method performs the same action as the

Smooth button in the Tools panel.

Example
The following example smooths the curve of the current selection:

f1l.getDocumentDOM () .smoothSelection() ;

document.sourcePath

Availability
Flash CS4 Professional.
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Usage

document . sourcePath

Description

Property; a string that contains a list of items in the document’s ActionScript 3.0 Source path, which specifies the
location of ActionScript class files. Items in the string are delimited by semi-colons. In the authoring tool, the items
are specified by choosing File > Publish Settings and then choosing ActionScript 3.0 Script Settings on the Flash tab.

Example
The following example adds the ./Class files folder to the document’s Source path:

var myDoc = fl.getDocumentDOM /() ;

fl.trace (myDoc.sourcePath) ;

myDoc.sourcePath = "./Class files;" + myDoc.sourcePath;
fl.trace (myDoc.sourcePath) ;

See also

document .externallLibraryPath, document.libraryPath, f1.sourcePath

document.space()

Availability
Flash MX 2004.

Usage

document . space (direction [, bUseDocumentBounds])

Parameters
direction A string that specifies the direction in which to space the objects in the selection. Acceptable values are

"horizontal" or "vertical".

bUseDocumentBounds A Boolean value that, when set to true, spaces the objects to the document bounds. Otherwise,
the method uses the bounds of the selected objects. The default is false. This parameter is optional.

Returns
Nothing.

Description
Method; spaces the objects in the selection evenly.

Example
The following example spaces the objects horizontally, relative to the Stage:

f1l.getDocumentDOM () .space ("horizontal", true) ;
The following example spaces the objects horizontally, relative to each other:

fl.getDocumentDOM () .space ("horizontal") ;
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The following example spaces the objects horizontally, relative to each other, with bUseDcoumentBounds expressly set
to false:

fl.getDocumentDOM () .space ("horizontal", false) ;

See also

document .getAlignToDocument (), document . setAlignToDocument ()

document.straightenSelection()

Availability
Flash MX 2004.

Usage

document .straightenSelection()

Parameters
None.

Returns
Nothing.

Description
Method; straightens the currently selected strokes. This method is equivalent to using the Straighten button in the

Tools panel.

Example
The following example straightens the curve of the current selection:

fl.getDocumentDOM () .straightenSelection() ;

document.swapElement()

Availability
Flash MX 2004.

Usage

document . swapElement (name)

Parameters
name A string that specifies the name of the library item to use.

Returns
Nothing.
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Description
Method; swaps the current selection with the specified one. The selection must contain a graphic, button, movie clip,
video, or bitmap. This method displays an error message if no object is selected or the given object could not be found.

Example
The following example swaps the current selection with symbol 1 from the library:

f1l.getDocumentDOM () .swapElement ('Symbol 1');

document.swapStrokeAndFill()

Availability
Flash 8.

Usage
document . swapStrokeAndFill ()

Parameters

None.

Returns
Nothing.

Description
Method; swaps the Stroke and Fill colors.

Example
The following example swaps the Stroke and Fill colors in the current document:

f1l.getDocumentDOM () . swapStrokeAndFill () ;

document.swfJPEGQuality

Availability
Flash Professional CS6.

Usage
document . swEJPEGQuality

Description
Property; an integer, returns the JPEG Quality setting from the current Publish Profile in the document.

Example
The following example display the current SWF JPEG quality:

fl.trace("current profile's JPEG Quality is: " + fl.getDocumentDOM /() .swfJPEGQuality) ;
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document.testMovie()

Availability
Flash MX 2004.

Usage

document .testMovie ( [Boolean abortIfErrorsExist])

Parameters

abortIfErrorsExist Boolean;the default value is false. If set to true, the test movie session will not start and the .swf
window will not open if there are compiler errors. Compiler warnings will not abort the command. This parameter
was added in Flash Professional CS5.

Returns
Nothing.

Description

Method; executes a Test Movie operation on the document.

Example
The following example tests the movie for the current document, but aborts the test movie if compiler errors exist:

fl.getDocumentDOM () .testMovie (1) ;

See also

document .canTestMovie (), document .testScene ()

document.testScene()

Availability
Flash MX 2004.

Usage

document .testScene ()

Parameters
None.

Returns
Nothing.

Description
Method; executes a Test Scene operation on the current scene of the document.

Example
The following example tests the current scene in the document:
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f1l.getDocumentDOM () .testScene () ;

See also

document .canTestScene (), document . testMovie ()

document.timelines

Availability
Flash MX 2004.

Usage

document.timelines

Description
Read-only property; an array of Timeline objects (see Timeline object).

Example

The following example gets the array of current timelines in the active document and displays their names in the
Output panel:

var i = 0;

var curTimelines = fl.getDocumentDOM() .timelines;

while (i < fl.getDocumentDOM() .timelines.length) {

alert (curTimelines[i] .name) ;

++1;

See also

document .currentTimeline, document .getTimeline ()

document.traceBitmap()

Availability
Flash MX 2004.

Usage

document .traceBitmap (threshold, minimumArea, curveFit, cornerThreshold)

Parameters
threshold An integer that controls the number of colors in your traced bitmap. Acceptable values are integers
between 0 and 500.

minimumArea An integer that specifies the radius measured in pixels. Acceptable values are integers between 1 and
1000.

curveFit A string that specifies how smoothly outlines are drawn. Acceptable values are "pixels", "very tight",

"tight","normal","smooth",and"very smooth".
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cornerThreshold A string that is similar to curveFit, but it pertains to the corners of the bitmap image. Acceptable

values are "many corners", "normal", and "few corners".

Returns
Nothing.

Description
Method; performs a trace bitmap on the current selection. This method is equivalent to selecting Modify > Bitmap >
Trace Bitmap.

Example
The following example traces the selected bitmap, using the specified parameters:

f1l.getDocumentDOM () .traceBitmap (0, 500, 'normal', 'normal');

document.translate3DCenter()

Availability
Flash CS4 Professional.

Usage

document . translate3DCenter (xyzCoordinate)

Parameters
xyzCoordinate An XYZ coordinate that specifies the center point for 3D rotation or translation.

Returns
Nothing.

Description
Method: sets the XYZ position around which the selection is translated or rotated. This method is available only for

movie clips.

Example
The following example specifies the XYZ axes for 3D translation:

f1l.getDocumentDOM () .translate3DCenter ({x:180, y:18,z:-30});

document.translate3DSelection()

Availability
Flash CS4 Professional.

Usage

document .translate3DSelection (xyzCoordinate, bGlobalTransform)
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Parameters
xyzCoordinate An XYZ coordinate that specifies the axes for 3D translation.

bGlobalTransform A Boolean value that specifies whether the transformation mode should be global (true) orlocal
(false)

Returns
Nothing.

Description
Method: applies a 3D translation to the selection. This method is available only for movie clips.

Example
In the following example, the selection is first translated relative to the stage (globally) and then relative to itself
(locally).

var myDocument = fl.getDocumentDOM () ;
myDocument . translate3DSelection ({x:52.0, y:0, z:0}, true);
myDocument . translate3DSelection ({x:52.0, y:0, z:-55.2}, false);

See also

document.translate3DCenter()

document.transformSelection()

Availability
Flash MX 2004.

Usage

document . transformSelection(a, b, ¢, d)

Parameters
a A floating-point number that specifies the (0,0) element of the transformation matrix.

)
b A floating-point number that specifies the (0,1) element of the transformation matrix.
c A floating-point number that specifies the (1,0) element of the transformation matrix.
)

d A floating-point number that specifies the (1,1) element of the transformation matrix.

Returns
Nothing.

Description
Method; performs a general transformation on the current selection by applying the matrix specified in the arguments.

For more information, see the element .matrix property.

Example
The following example stretches the selection by a factor of 2 in the x direction:
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fl.getDocumentDOM () .transformSelection(2.0, 0.0, 0.0, 1.0);

document.unGroup()

Availability
Flash MX 2004.

Usage

document .unGroup ()

Parameters
None.

Returns
Nothing.

Description

Method; ungroups the current selection.

Example
The following example ungroups the elements in the current selection:

f1l.getDocumentDOM () .unGroup () ;

See also

document .group ()

document.union()

Availability
Flash 8.

Usage

document .union ()

Parameters

None.

Returns
None.

Description

Method; combines all selected shapes into a drawing object. If no objects are selected, calling this method results in an
error and the script breaks at that point.
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Example
The following example combines all selected shapes into a drawing object:

f1l.getDocumentDOM () .union () ;
See also

document .crop (), document .deleteEnvelope (), document . intersect (), document .punch (),

shape.isDrawingObject

document.unlockAllElements()

Availability
Flash MX 2004.

Usage

document .unlockAllElements ()

Parameters

None.

Returns
Nothing.

Description
Method; unlocks all locked elements on the currently selected frame.

Example
The following example unlocks all locked objects on the current frame:

fl.getDocumentDOM () .unlockAllElements () ;

See also

element.locked

document.viewMatrix

Availability
Flash MX 2004.

Usage

document .viewMatrix
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Description

Read-only property; a Matrix object. The viewMatrix is used to transform from object space to document space when
the document is in edit mode. The mouse location, as a tool receives it, is relative to the object that is currently being
edited. See Matrix object.

For example, if you create a symbol, double-click to edit it, and draw with the PolyStar tool, the point (0,0) will be at
the registration point of the symbol. However, the drawingLayer object expects values in document space, so if you
draw a line from (0,0) using the drawingLayer, it will start at the upper left corner of the Stage. The viewMatrix
property provides a way to transform from the space of the object being edited to document space.

Example
The following example gets the value of the viewMatrix property:

var mat = fl.getDocumentDOM () .viewMatrix;

document.width

Availability
Flash MX 2004.

Usage

document .width

Description
Property; an integer that specifies the width of the document (Stage) in pixels.

Example
The following example sets the width of the Stage to 400 pixels.

fl.getDocumentDOM () .width= 400;

See also

document . height

document.xmlPanel()

Availability
Flash MX 2004.

Usage

document .xmlPanel (£i1eURI)
Parameters

fileURI A string, expressed as a file:/// URI, that specifies the path to the XML file defining the controls in the panel.
The full path is required.

Last updated 12/6/2013



EXTENDING FLASH PROFESSIONAL 192
Document object

Returns
An object that has properties defined for all controls defined in the XML file. All properties are returned as strings. The
returned object will have one predefined property named "dismiss" that will have the string value "accept" or

"cancel".

Description
Method; posts an XMLUI dialog box. See £1.xmlui.

Example
The following example loads the Test.xml file and displays each property contained within it:

var obj = fl.getDocumentDOM () .xmlPanel (fl.configURI + "Commands/Test.xml") ;
for (var prop in obj) {

fl.trace("property " + prop + " = " + obj[prop]);
}
document.zoomFactor
Availability
Flash 8.
Usage

document . zoomFactor

Description
Property; specifies the zoom percent of the Stage at authoring time. A value of 1 equals 100 percent zoom, 8 equals 800
percent, .5 equals 50 percent, and so on.

Example
The following example sets the zoom factor of the Stage to 200 percent.

fl.getDocumentDOM () .zoomFactor = 2;
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Chapter 12: drawingLayer object

drawinglLayersummary

Availability
Flash MX 2004.

Description
The drawingLayer object is accessible from JavaScript as a child of the flash object. The drawingLayer object is used
for extensible tools when the user wants to temporarily draw while dragging—for example, when creating a selection

marquee. You should call drawingLayer.beginFrame () before you call any other drawingLayer methods.

Method summary

The following methods are available for the drawingLayer object:

Method Description

drawingLayer.beginDraw () Puts Flash in drawing mode.

drawingLayer.beginFrame () Erases what was previously drawn using the drawingLayer and prepares for more drawing
commands.

drawingLayer.cubicCurveTo () Draws a cubic curve from the current pen location using the parameters as the coordinates
of the cubic segment.

drawingLayer.curveTo () Draws a quadratic curve segment starting at the current drawing position and ending at a
specified point.

drawingLayer.drawPath () Draws the specified path.

drawingLayer.endDraw () Exits drawing mode.

drawingLayer.endFrame () Signals the end of a group of drawing commands.

drawingLayer.lineTo () Draws a line from the current drawing position to the point (x,y).

drawingLayer.moveTo () Sets the current drawing position.

drawingLayer.newPath () Returns a new Path object.

drawingLayer.setColor () Sets the color of subsequently drawn data.

drawingLayer.setFill () This method is not available.

drawingLayer.setStroke () This method is not available.

drawinglLayer.beginDraw()

Availability

Flash MX 2004.

Usage

drawingLayer.beginDraw ( [persistentDraw] )
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Parameters

persistentDraw A Boolean value (optional). If set to true, it indicates that the drawing in the last frame remains on
the Stage until a new beginDraw () or beginFrame () call is made. (In this context, frame refers to where you start and
end drawing; it does not refer to timeline frames.) For example, when users draw a rectangle, they can preview the
outline of the shape while dragging the mouse. If you want that preview shape to remain after the user releases the
mouse button, set persistentDraw to true.

Returns
Nothing.

Description
Method; puts Flash in drawing mode. Drawing mode is used for temporary drawing while the mouse button is pressed.
You typically use this method only when creating extensible tools.

Example

The following example puts Flash in drawing mode:

fl.drawinglLayer.beginDraw () ;

drawinglLayer.beginFrame()

Availability
Flash MX 2004.

Usage

drawingLayer.beginFrame ()

Parameters
None.

Returns
Nothing.

Description

Method; erases what was previously drawn using the drawingLayer and prepares for more drawing commands. Should
be called after drawingLayer .beginDraw (). Everything drawn between drawingLayer.beginFrame () and an
drawingLayer.endFrame () remains on the Stage until you call the next beginFrame () and endFrame (). (In this
context, frame refers to where you start and end drawing; it does not refer to timeline frames.) You typically use this
method only when creating extensible tools. See drawingLayer.beginDraw ().

drawinglLayer.cubicCurveTo()

Availability
Flash MX 2004.
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Usage
drawingLayer.cubicCurveTo (x1Ctrl, ylCtrl, x2Ctl, y2Ctl, xEnd, yEnd)

Parameters
x1Ctl A floating-point value that is the x location of the first control point.

y1Ctl A floating-point value that is the y location of the first control point.
x2Ctl A floating-point value that is the x position of the middle control point.
y2Ctl A floating-point value that is the y position of the middle control point.
xEnd A floating-point value that is the x position of the end control point.

yEnd A floating-point value that is the y position of the end control point.

Returns
Nothing.

Description
Method; draws a cubic curve from the current pen location using the parameters as the coordinates of the cubic
segment. You typically use this method only when creating extensible tools.

Example

The following example draws a cubic curve using the specified control points:

fl.drawinglLayer.cubicCurveTo(0, 0, 1, 1, 2, 0);

drawinglLayer.curveTo()

Availability
Flash MX 2004.

Usage
drawingLayer.curveTo (xCtl, yCtl, xEnd, yEnd)

Parameters
xCtl A floating-point value that is the x position of the control point.

yCtl A floating-point value that is the y position of the control point.
xEnd A floating-point value that is the x position of the end control point.

yEnd A floating-point value that is the y position of the end control point.

Returns
Nothing.

Description

Method; draws a quadratic curve segment starting at the current drawing position and ending at a specified point. You
typically use this method only when creating extensible tools.
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Example
The following example draws a quadratic curve using the specified control points:

fl.drawingLayer.curveTo (0, 0, 2, 0);

drawinglLayer.drawPath()

Availability
Flash MX 2004.

Usage
drawingLayer.drawPath (path)

Parameters
path A Path object to draw.

Returns
Nothing.

Description
Method; draws the path specified by the path parameter. You typically use this method only when creating extensible
tools.

Example
The following example draws a path specified by the Path object named gamePath:

fl.drawinglLayer.drawPath (gamePath) ;

drawinglLayer.endDraw()

Availability
Flash MX 2004.

Usage

drawingLayer.endDraw ()

Parameters

None.

Returns
Nothing.

Description

Method; exits drawing mode. Drawing mode is used when you want to temporarily draw while the mouse button is
pressed. You typically use this method only when creating extensible tools.
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Example
The following example exits drawing mode:

fl.drawingLayer.endDraw () ;
